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Overview

This is the LARSA 4D User's Guide, which covers how to use the LARSA 4D user interface. This is also the starting
point for any new LARSA 4D user.

About the Manual

Topics covered in this manual include:

• Files and reports, including importing/exporting

• Graphics, selection, spreadsheets, and explorers

• Modeling tools, including drawing, transformations, generation, and grids

• Running an analysis

• Getting results, both visually and numerically, and

• Steel design

Other manuals for LARSA 4D cover more specialized or in-depth topics:

Samples and Tutorials
This manual includes the Quickstart Guide, which all new LARSA users should go through to get a basic
understanding of how LARSA 4D works. The manual also includes a number of samples and tutorials.

Reference Manual
The reference manual covers LARSA's element library and other input data, explains how analyses are
performed, and defines how analysis output is reported.

Staged Construction Analysis Guide
An in-depth guide to using LARSA 4D in staged or segmental construction, including a reference for
LARSA's time-dependent staged construction analysis.

Developer's Guide
A reference for extending LARSA 4D through user-written plugins and VBA macros.

Section Composer Reference
A guide to the LARSA Section Composer.

These manuals are available in several formats on our website at http://www.Larsa4D.com in the Support section.

Getting Help

For technical support,

• Please call us using one of the following telephone numbers:

• U.S. & Canada, Toll Free: 1-800-LARSA-01

• International: 212-736-4326 (our New York office)

• Email us at support@larsa4d.com, or
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• Visit our website www.larsa4d.com and see the Support section.

We are open 9am to 5pm U.S. Eastern Time, Monday through Friday.

You may also reach us by postal mail at:

LARSA, Inc.
68 South Service Road
Suite 100
Melville, New York 11747

About LARSA 4D 19

Overview of Using LARSA 4D 21
The LARSA 4D Look and Feel 21
Defining Properties 22
Creating Geometry 24
Applying Loads 25
Analyzing the Model 26
Viewing the Results 27

About the Manual 17
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About LARSA 4D

LARSA 4D is the most advanced multipurpose structural analysis package available today. LARSA 4D for Microsoft
Windows features a powerful user interface and an engine with unmatched analytical features.

LARSA 4D's new fourth-dimension features make the software uniquely able to handle the demands of modeling
bridges, including influence line and surface based moving load analysis, staged construction analysis, time dependent
segmental analysis, hysteretic and seismic elements, and progressive collapse.

And LARSA 4D's user interface is just as astounding as its analytical engine. The interface features clear and powerful
graphics windows, easy-to-use numerical spreadsheets for both input data and results, Explorers for navigating project
data, and a long list of modeling tools.

The LARSA structural analysis engine has been in commercial use for over 25 years. It was originally developed
to perform nonlinear static analysis of structures that have large displacements, such as suspension and cable stayed
bridges and guyed towers. The engine became popular for analyses of these types of structures because of its
unprecedented accuracy at a reasonable price. The engine has been powerful since day one, using both tangent stiffness
and the full Newton-Raphson method with iterations. LARSA has come a long way since it was first available on the
VAX super-mini computers decades ago.

In 1986, LARSA expanded its engine to meet the needs of any structural analysis that a practicing engineer might
find at that time, including seismic analysis and design. At the same time, a graphical user interface was released for
DOS. LARSA was the first to offer an individual PC-based DOS structural analysis package with geometric nonlinear
analysis capabilities.

LARSA again led the industry in 1994 by taking the next step to Microsoft Windows. That year LARSA introduced
its 16-bit Windows 3.x version of the software with a point and click graphical user interface. In 1996, LARSA was
the first to offer elastic/perfectly plastic pushover analysis.

In 2001, LARSA 2000 was released, with an all-new user interface and many enhancements to the analytical engine.
LARSA 2000 became LARSA 4D with its release in 2006, featuring new seismic and inelastic elements, and many
new features for bridge design and analysis.
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Overview of Using LARSA 4D

This section provides an overview of the features needed to get started using LARSA 4D.

The LARSA 4D Look and Feel

The LARSA 4D screen looks like the window in the figure below.

The Layout of LARSA 4D

In addition to the usual components of a Windows application, like the menu bar and tool bar, LARSA 4D has a window
bar at the bottom of the screen to switch between open windows -- such as graphics windows and spreadsheets, and
Explorers on the right side of the screen.
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Defining Properties

The term "properties" in LARSA 4D refers to the project input that defines the behavior of the geometry of the model,
including material properties, sectional properties, nonlinear spring properties, and time-dependent material properties.

Materials and sections can be added using the materials and sections spreadsheets. All material and section properties
can be viewed/edited directly on the spreadsheet. For more information, refer to Using the Model Spreadsheets (page

53).

This tool can be found on the “Input Data” menu under “Properties” .

Materials Spreadsheet

Standard materials can be loaded using the Standard Materials dialog box. For more information, refer to Loading
Standard Materials (page 151).

This tool can be found on the “Input Data” menu under “Materials” .

The Sections window can be used to import sections from a standard section database. For more information, refer
to Loading Standard Sections (page 153).

This tool can be found on the “Input Data” menu under “Sections” .
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Loading a Standard Section

The Sections window can also be used to add sections by specifying the shape type and the dimensions. For more
information, refer to Creating Custom Sections (page 155).

Creating a Custom Section

Parametric sections can be added by attaching a user-created parametric section database to the project. Parametric
section databases can be created using the Section Composer. For more information, refer to LARSA Section Composer
[in LARSA Section Composer Manual].
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Creating Geometry

The term "geometry" in LARSA 4D refers to the joints, members, shells, other physical elements and geometric
constraints that make up a structure.

A structure can be created using the four methods listed below.

The spreadsheets can be used to add new geometry elements. Properties, such as materials and sections, can be
assigned to the structure using the spreadsheets if they have already been loaded into the project (see above). For more
information, refer to Using the Model Spreadsheets (page 53).

This tool can be found on the “Input Data” menu under “Geometry” .

Input Spreadsheets

Structure geometry can also be drawn on the graphics view windows. For more information, refer to Drawing Geometry
and Loads (page 103).

This tool can be found on the “Draw” menu under “Geometry” .
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Drawing Members

Structure geometry can also be created using the Model Data Explorer. Properties can be assigned while creating the
geometry. The Model Data Explorer can also be used to edit the structure geometry data. For more information, refer
to Model Data Explorer (page 89).

Various generation tools can be used to create the geometry. For more information, refer to Generation Tools (page 123).

This tool can be found on the “Draw” menu under “Generation” .

Applying Loads

Load Cases: All loads must be contained in a "load case." Therefore, before applying loads to the structure geometry,
one needs to create the load cases. For help creating and editing load cases, see Load Cases Explorer (page 91).

Loads: Once there are load cases, loads can be created using one of the methods listed below. For more information
on loads, refer to Loads [in LARSA 4D Reference Manual].

Spreadsheets can be used to create loads. The loads spreadsheet can be accessed by using one of the two methods
listed below.

1. Open the load cases input spreadsheet from the Input Data  menu. Right click on the load case row that you
want to see the contained loads and click Edit Loads .

2. Double-click on the load case in the Load Cases Explorer.
25
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Loads Spreadsheets

Loads can be created graphically using the graphics view. For more information, refer to Drawing Geometry and Loads
(page 103). Please note that not all load types can be drawn graphically, including time-history excitations and initial
conditions. For those load types, use the spreadsheets.

This tool can be found on the “Draw” menu under “Loads” .

Analyzing the Model

Before analyzing your model, please use Integrity Check to ensure the validity of the project. For more information,
refer to Integrity Check (page 147).

This tool can be found on the “Input Data” menu under “Integrity Check” .

Run an analysis by selecting the proper analysis type under the Analysis  menu. For more information, refer to Running
an Analysis (page 167).
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Analysis Window

Viewing the Results

Once the model has been analyzed, all of the result cases will be available in the Analysis Results Explorer. For more
information, refer to Analysis Results Explorer (page 99).

Result data can be viewed in spreadsheet format using the results spreadsheets. First select the result case from the
Analysis Result Explorer and select the appropriate results spreadsheet under the Results > Spreadsheets  menu. For
more information, refer to Results Spreadsheets (page 179).

This tool can be found on the “Results” menu under “Spreadsheets” .
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Results Spreadsheet View

Result data can also be viewed graphically using the graphics view window. For more information, refer to Viewing
Results Graphically (page 173).

This tool can be found on the “Results” menu under “Graphical” .

Graphical Results

Results can also be graphed. For more information, refer to Graphing Results (page 189).

This tool can be found on the “Results” menu under “Graphs” .
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Graphics & Selection

The sections below describe the various ways of using LARSA's graphics windows and how to select and unselect
objects.

An Overview of Graphics & Selection 31
Selection 31
The Graphics Tools 31
Keyboard Commands 36

Select Special 37

Select by Plane 39

Select by Polygon 41

Graphics Display Options 43
Show 43
Shrink 46
Orthographic/Perspective Projection 46
Rendering 47

Graphics Window Grid 49

Hide Unselected 51
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An Overview of Graphics & Selection

The graphics views are the primary means of viewing and modeling structures in LARSA 4D. In order to use the
graphics views effectively, one must understand the six graphics tools and the concept of selection.

Selection

Every structural object in LARSA is either selected or unselected. LARSA provides various tools to modify the
selection state of objects, including the Selection/Unselection graphics tools (below), Select Special (page 37), Select
by Plane (page 39), Select by Polygon (page 41) and Select/Unselect All. Selected objects are generally displayed solid,
while unselected objects are generally displayed dashed.

The selection state of objects is important because most modeling operations, such as modifying the properties of
objects, applying transformations, and meshing, operate only on the selected objects. Therefore, the objects to which
you want to apply an operation must be selected before applying the operation.

The Graphics Tools

There are six graphics "tools" that define the behavior of the mouse in the graphics windows. The tools are displayed
together on the graphics toolbar, shown below. Exactly one tool is active at all times, and the active tool is shown
highlighted. In the picture below, the Pointer Tool is active.

The Graphics Tools

The Pointer tool is the primary tool of the graphics windows. It is used to examine objects quickly (by clicking them)
and to quickly manipulate objects (by right-clicking them). The Select and Unselect tools select and unselect objects.
Click or click-and-drag windows around objects to select/unselect them.

With these three tools, right-clicking empty space in the graphics window will open up the graphics shortcut menu,
which provides quick access to graphics window commands.
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Graphics Right-Click Menu

Use the Zoom tool to zoom in by click-and-dragging a window around objects you wish to zoom in on. Right-click
to zoom out. The Rotate and Pan tools are used to rotate the structure and pan the structure left/right/up/down on
the screen.

The Zoom Tool.

Zoom Window
Click-and-drag a window around a portion of the structure to zoom in onto that portion of the structure.

One-Click
Click an empty area of the graphics window to zoom in by 2.5x. (Or right-click to zoom out.) Or, click a
structural object to zoom in by 2.5x and center the display on that object. (Or right-click to zoom out.)

Mouse Wheel
Click on an area of the Graphics window and use the mouse wheel to zoom in and out.
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Zoom-In to View Details

The Pan Tool.

Click-and-Drag
Move the structure on the screen to pan left, right, up, and down.

The Rotate Tool.

Click-and-Drag
Move the mouse in the graphics window to rotate the structure. Drag horizontally to rotate the structure
left to right. Drag vertically to rotate the structure top to bottom.

Hold SHIFT
And drag horizontally to rotate the structure about the screen axis.
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Rotating for a Variety Views

The Pointer Tool.

Quick Info
Click structural objects to get more information about the objects. Right-click a structural object to access
the shortcut menu for the object.

Quick Select
Hold SHIFT  while clicking on an object to select only that object. All other objects will be deselected.

Clicking for Quick Info
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The Selection and Unselection Tools.

Select Window
Click-and-drag a window around structural objects to select/unselect the objects. (Other objects will
remain as they were.) Dragging from right to left will include all objects that are at least partially within
the window. Dragging from left to right will include only the objects that are entirely within the window.

One-Click
Click objects to select just one object at a time. If more than one object is under the mouse cursor, you will
be prompted to choose which one to select.

Reverse
Hold SHIFT  to do the opposite. If the selection tool is active, object will be unselected, and if the
unselection tool is active, objects will be selected.

Quick Group
Hold CTRL  and drag objects into the Structure Groups Explorer (page 93) or Construction Stages Explorer
(page 97) to create a new group from the currently selected objects.

Click-and-Drag to Select a Larger Area

Scrolling the mouse wheel will zoom in and out. Dragging the mouse scroll wheel button will pan the structure. Holding
CTRL  while dragging the mouse scroll wheel button will rotate the structure.
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Keyboard Commands

In addition to clicking on their icons, there are two ways to quickly switch between the tools: shortcut keys and using
the middle mouse button.

The shortcut keys are as follows:

Zoom
F5

Pan
F6

Rotate
F7

Select
F8

Unselect
SHIFT+F8

In addition, these other graphics window shortcut keys are provided for similar tasks:

Select All
S

Unselect All
U

Show Options
O

Switch Between Orthographic and Perspective Projection
P

Toggle Numbering
N

Additionally, when the CTRL  key is pressed, whatever is in the program status bar at the bottom of the screen will be
displayed next to the mouse cursor to make the information easier to read.
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Select Special

The Select Special tool selects or deselects objects that have certain properties. For instance, unlike Select All Joints,
Select Special can select "all joints whose x-coordinate is less than 10."

This tool can be found on the “Selection” menu under “Select Special” .

Select Special

Before you begin, instruct Select Special which type of objects to select/deselect. Choose Geometry or Loads from
the first drop-down choice, and then a geometry type (joints, members, shells, springs, isolators) or a load type (joint
loads, member loads, shell loads). To select/deselect loads, you must first activate the appropriate load case in the
Load Cases Explorer (page 91).

To use Select Special, you must specify criteria. Select Special will select (or deselect) only those objects that match
the criteria.

Initially, you are given the option to provide one criterion, as shown in the figure below. In the figure, the user has
already chosen to select/deselect members. The criterion is that a member's type is not a truss. If the user were to hit
the Select Objects or Unselect Objects button now, only the members whose type was not a truss would be selected/
deselected. The selection state of members which did meet the criterion would not be changed.

A Select Special Criterion

To specify more complex criteria, click the more... button. A second criterion can be specified. In the figure below, the
user has specified two criteria: 1) the member's type is beam and 2) the member's length is greater than 10 ft (with a
tolerance of .05 ft). Only the members that match both criteria 1 and 2 will be selected/deselected.
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Complex Criteria

By clicking on the and button, the filter mode can be changed to or, as in the figure below. In this mode, the members
that match either criterion 1 or criterion 2 (or both) will be selected/deselected. In this example, a truss member with
length greater than 10 would be selected, but in the previous example it would not.

AND versus OR

As a reminder of what Select Special is about to do, a description of which objects are about to be selected/deselected
is written at the bottom of the dialog.
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Select by Plane

The Select by Plane tool selects joints and elements that lay on a particular 2D-plane.

This tool can be found on the “Selection” menu under “Select by Plane” .

Select by Plane

Tolerance
Objects which are not exactly on the plane are selected if they fall within the given tolerance.

The plane to select can be chosen three ways.

Using 3 Joints
Click three joints one-by-one to select the plane that those three joints lay on. The coordinates of the
joints must determine a plane. As you click the joints, their coordinates will appear in the Select by Plane
window.

Using 2 Elements
Click two members, shells, or springs one-by-one to select the plane that the two elements lay on. The
elements must lay on one plane. As you click the elements, their end-joint coordinates will appear in the
Select by Plane window.

Using 1 Shell
A single shell defines a plane. Click a shell to select all objects that lay on the same plane.
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Select by Polygon

The Select by Polygon tool selects joints and elements that fall within a 2D polygon.

This tool can be found on the “Selection” menu under “Select by Polygon” .

Select by Polygon

Tolerance
Objects which are not exactly on the plane are selected if they fall within the given tolerance.

Click the joints one-by-one that define the boundary of the polygon. Click the first joint, again, when done to finish
the polygon. As you click the joints, their coordinates will appear in the Select by Polygon window.
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Graphics Display Options

The graphics display options control how structures are displayed in the graphics window. These options are located
in various parts of LARSA 4D.

Show

This tool can be found on the “Graphics” menu under “Show” or with the shortkey key O, for options.

The Show window has options for what to show in the graphics windows. Different geometry types in the structure
can be turned on and off, including joints, members, shells, tendons, coordinate systems, and loads. Check or uncheck
options in this window to show or hide the graphics elements.

The Show Window

When Coordinate Systems is checked, user coordinate systems are shown in the graphics windows. The local z-axis
is shown by a thick 3D arrowhead. The x- and y- axes are shown as thin arrowheads.

When the Input Loads option is checked, loads entered into load cases are only displayed if there is an active load case.
Activate a load case by clicking it in the Load Cases Explorer (page 91).

When the Analyzed Loads option is checked, member and shell loads as analyzed by the engine are shown graphically.
This is particularly useful when investigating generated loads, such as in self-weight result cases and result cases
generated by the moving load analysis. Analyzed loads are only displayed when graphical results (page 173) are being
viewed.

Other display icons that can be shown include the global coordinate system origin, element local axes, and member
orientation icons, rigid zone icons, and member releases icons.
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Display Icons

Member and shell local axes are shown as in the image below. The x-axis is drawn thicker and along the element. To
distinguish the y- and z-axis, the y-axis is drawn thin and the z-axis is drawn with a thick arrowhead.

Element Local Axes

When the Member Orientation, Rigid Zones, Releases option is checked, I-shape orientation icons are shown on all
members. The icon is an I shape regardless of the section properties and only indicates the orientation of the member's
local y- and z-axes. When the I shape is shown vertically, as in the image below, the member's local y-axis is up and
the z-axis is side to side, which is usually what is needed for beams whose strong axis is the z-axis. The strong axis of
standard sections is the z-axis, but this may not be the case for custom sections.
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Member Icons

When this option is checked, if a member has a rigid zone, the rigid portion of the member is shown thicker. In addition,
a release icon is shown for members that have any end releases.

Certain objects are displayed as icons, such as supports and loads. The size of these icons may need to be adjusted
when working on very large structures, as the icons may overcrowd the display. The Icon Size may be adjusted from
the Show window. The Icon Size may be Small or Large. Large is the default and is suitable under most circumstances.

Element labels, such as joint numbers, shell thicknesses, and spring types, can be displayed beside each element. Each
element type (joint, member, shell, spring, isolator) may only have at most one label type turned on at a time. To
activate labels, change to the Labels  tab.

Element Labels

The labels are arranged into columns for each type of object: joints, members, shells, springs, and isolators. In each
column are the types of labels that can be shown for the objects, such as ID, material, and thickness. Click a label
name to turn on that label.
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Shrink

This tool can be found on the “Graphics” menu under “Shrink” .

Shrink

When Shrink is turned on, members, springs, isolators, and shells are displayed at a fraction of their true size. Shrink
is useful to clearly see the end points of members, springs, and isolators and the boundaries of bordering shells. When
Rendering is turned on, Shrink is especially useful for preventing member sections from overlapping at joints. The
Shrink default is to display elements at 75% of their true size when Shrink is turned on. The percentage can be changed
from the Tools > Options  dialog. To turn Shrink on and off, click the Shrink tool from the Graphics  menu or the
graphics toolbar.

Orthographic/Perspective Projection

This tool can be found on the “Graphics” menu under “Projection” or with the shortkey key P.
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Orthographic and Perspective Projection

The graphic window may present the structure in one of two projections: orthographic or perspective.

Under orthographic mode, structural elements do not become smaller as they become farther away (there is no
perspective). Orthographic mode is most useful while modeling the structure, as it does not have any distortions.

On the other hand, perspective mode is closer to a realistic display of the structure and generally makes the structure
easier to view. Because of the distortions inherent in a perspective view, it is sometimes confusing when modeling.
Perspective view can also be highly distored when looking at certain structures from certain directions.

Rendering

This tool can be found on the “Graphics” menu.
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Simple and Complete Rendering

Members, shells, and other elements may be displayed "rendered," where they are drawn with their actual dimensions,
instead of as simple lines and polygons. There are two rendering modes: simple and complete.
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Graphics Window Grid

When using the graphical windows, LARSA can provide a two-dimensional grid. The grid is toggled on and off using
the Grid button at the bottom of each graphics window.

The Graphics Window Grid

The grid defaults to the X-Z plane (where y = 0), with grid extents and spacing dependent on the size of the structure
and the current zoom factor.

The grid may be shifted in and out of the X-Z plane (or whatever plane is currently active) by using the grid level
input, which is marked by the label "at Y =."

Grid line spacing can be entered manually or selected from the drop-down list, or it can be set to automatic. On
automatic mode, the spacing is chosen based on the current zoom factor. Automatic spacing is useful when the exact
grid spacing is not important, but it should be turned off (by entering or selecting a number for the spacing) when
modeling the structure.

Values for grid line spacing that result in too many grid points being displayed will result in no grid being
displayed, and a "grid size too small" error shown in the grid panel. In this case, decrease the extents of the
grid or increase the line spacing.
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Grid extents are also chosen automatically by default. Before modeling the structure, entering values for the extents
manually will prevent the extents from changing automatically. To set the extents manually, click the up arrow, which
is directly below the Grid button. In the Grid Extents box which will appear at the lower-left of the graphics display,
the grid extents may be entered. Additionally, separate grid spacing values can be entered for each of the three axes.
Automatic extents may be turned on and off by clicking the "Auto" checkbox in the Grid Extents box. To close the
Grid Extents box, click the up arrow again.

The grid is drawn in the active user coordinate system, which might not be a rectangular system. In the cases of
cylindrical or spherical systems, the grid planes are R-Theta, Theta-Z, and R-Z and R-Phi, Phi-Theta, and R-Theta,
respectively. Setting grid extents (which will control R, Z, Theta, and Phi instead of X, Y and Z) and separate grid
spacing for each axis is usually necessary for these coordinate systems.

A Cylindrical Grid

In addition, in non-rectangular coordinate systems there are "degenerate" grids, such as the Phi-Theta plane at R=0,
which result in a grid being drawn at a single point or along a single line. In the case of this example, there is only one
point at R=0, so there is no grid to be drawn. The grids displayed in these cases may be misleading.

Also misleading are grids displayed perpendicular to the viewing plane when orthogonal projection is being used. In
this case, the grid is drawn "in to" the computer screen, resulting in a single line being displayed, or nothing at all. In
this case, perspective display should be turned on. See Graphics Display Options (page 43).
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Hide Unselected

When modeling a structure or investigating results in a particular region of the structure, it is often useful to hide part
of the structure so that the remaining elements are unobscured. The Hide Unselected feature does just that.

This tool can be found on the “Graphics” menu under “Hide Unselected” .

Hide Unselected

Hide Unselected takes all of the unselected objects and makes them invisible. They will come back when Hide
Unselected is turned off.

To hide part of the structure...

• Select the part of the structure that you want to remain visible (or unselect the part of the structure that you
wish to hide.)

• Activate Hide Unselected from the Graphics menu or the graphics toolbar. The unselected structural
elements will be hidden.

• The Hide Unselected icon in the menu and toolbar will be highlighted to indicate that Hide Unselected has
been turned on.

To restore the hidden part of the structure, click the Hide Unselected button again.

Invisible items that later become selected will be turned visible again so that selected items are always shown.
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Using the Model Spreadsheets

Model data spreadsheets provide direct, numerical access to all of the data used to model a structure. The spreadsheets
are found in the Input Data  menu.

The spreadsheets are divided into three categories. Choose one of the categories to view that category's spreadsheets.

• Properties: Materials, sections, coordinate systems, and other element properties. See Properties [in LARSA
4D Reference Manual].

• Geometry: Joints, members, shells, and other geometry elements. See Geometry [in LARSA 4D Reference
Manual].

• Loads: Load cases, load combinations, and stages. See Loads [in LARSA 4D Reference Manual].

• Load spreadsheets can also be accessed from the Load Cases Explorer (page 91)

• Construction stages can also be accessed from the Construction Stages Explorer (page 97)

LARSA's Spreadsheets

At the top of the spreadsheet window, there is a list of tabs for each type of data in the category chosen. For the geometry
category, shown above, the tabs list joints, members, shells, springs, mass elements, constraints, tendons, and lanes.
Click a tab to see that particular type of data.

53

LARSA4D_ReferenceManual.pdf#input/properties__Properties
LARSA4D_ReferenceManual.pdf#input/properties__Properties
LARSA4D_ReferenceManual.pdf#input/geometry__Geometry
LARSA4D_ReferenceManual.pdf#input/geometry__Geometry
LARSA4D_ReferenceManual.pdf#input/loads__Loads


LARSA 4D User’s Manual

For information on what each column means in each of the spreadsheets, see Model Data Reference [in LARSA 4D
Reference Manual].

Using the Spreadsheet

Each row in the spreadsheet represents one "object" that exists in the project. For the materials spreadsheet, this means
that each row represents one available material. For members, each row represents one member in the project. Creating
a member graphically will add a row to the spreadsheet. Conversely, deleting a row in the spreadsheet will erase that
object from the project. (But, don't fret, there is always Undo/Redo (page 111).) This differs from other spreadsheet
applications, such as Microsoft Excel, that have a seemingly endless number of rows from the start. To add a row,
which adds a new object into the project, see the section on adding rows, below.

One cell is active in a spreadsheet at any given time. The active cell, which is indicated by a black box around the
cell, will receive user input. Typing into the spreadsheet will affect the active cell. Clicking a cell makes it active. The
active cell can be moved using the arrow keys and TAB .

When a spreadsheet is active, typing will replace the contents of the active cell. To edit the active cell's contents,
double-click the cell, press ENTER , or press F2  like in Microsoft Excel.

Many cells can be selected at once. To select a block of cells, click-and-drag the mouse from the upper-left cell to be
selected to the lower-right cell to be selected. Alternatively, hold the SHIFT  key as you reposition the active cell. To
select all cells in the spreadsheet, choose Select All from the Edit  menu, or press CTRL+A . Selecting many cells is
useful for cut/copy/paste (see below) and editing multiple cells at once.

User may also get the summation of the selected cells by right clicking the spreadsheet.

Editing Multiple Cells at Once

Spreadsheet Edit Bar

Normally you can only change one cell at a time, but it is possible to change many cells in one go. To do so, select
the cells you want to edit together. The cells must form a contiguous block, and they must all be the same type (all
numeric, for instance). Then enter the new value for the cells in the Edit Bar in the LARSA toolbar. Finally, click the
checkmark to update the cells.

Adding Rows

To add a new row of data to the end of a spreadsheet, choose Add Row, which can be found in several locations:

• In the Edit  menu, choose Add Row.

• Click the Add Row tool on the toolbar. (Use this method to add many rows at once.)
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• Press the key combination SHIFT+INS .

Adding Many Rows

A new row may be added to a spreadsheet by typing directly into the blank row at the end of every spreadsheet or by
double-clicking a cell in that row. The blank row will then become promoted to a real row of data.

Inserting Rows

Rows of data can be inserted into the middle of a spreadsheet. Position the active cell below where you want the new
row to be inserted. Then do one of the following:

• In the Edit  menu, choose Insert Row.

• Click the Insert Row tool on the toolbar. (Use this method to insert many rows at once.)

• Press the key combination CTRL+INS .

• Right-click the spreadsheet and choose Insert Rows.

To insert multiple rows into a spreadsheet, use the toolbar tool, or select a block of cells so that the number of rows
selected is equal to the number of new rows you want to insert. Choosing Insert Rows will insert that number of rows
above the selection block.
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Deleting Rows

Deleting Rows

To delete rows, select the rows you want to delete, or position the active cell in the row you want to delete. Then do
one of the following:

• In the Edit  menu, choose Delete Rows.

• Click the Delete Rows tool on the toolbar.

• Press the key combination SHIFT+DEL .

• Right-click the spreadsheet and choose Delete Rows.

Cut and Copy

To copy cells to the Windows clipboard (from which you can paste the data elsewhere in LARSA or in other Windows
applications), select the block of cells to be copied, or position the active cell in the one cell to be copied. Then do
one of the following:

• In the Edit  menu, choose Copy.

• Click the Copy tool on the toolbar.

• Press the key combination CTRL+C .

• Right-click the spreadsheet and choose Copy.
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Although individual cells can be copied, only entire rows may be "cut" from the spreadsheet and placed into the
clipboard. To cut a row or block of rows from the spreadsheet, position the active cell in the one row to be cut, or select
the block of rows to be cut. Then do one of the following:

• In the Edit  menu, choose Cut.

• Click the Cut tool on the toolbar.

• Press the key combination CTRL+X .

• Right-click the spreadsheet and choose Cut.

Selecting an entire row is not necessary to cut cells. If a block of cells is selected, all rows that the block intersects
will be cut.

Paste

Cut, Copy or Paste Data

There are two modes in which LARSA will paste data from the Windows clipboard into a spreadsheet: Overwrite
mode and Insert mode.

In Overwrite mode, the contents of the clipboard will replace the contents of the cells which are selected. If only one
cell of data is in the clipboard, LARSA will always overwrite the contents of the active cell with the contents of the
clipboard. Otherwise, to paste in overwrite mode, select the block of cells to receive the data from the clipboard.

In Insert mode, the contents of the clipboard will be inserted into new rows in the spreadsheet. Multiple cells of data
must be in the clipboard. To paste in insert mode, do not select a block of cells. The contents of the clipboard will
be inserted above the active cell.

After positioning the active cell and selecting a block of cells, if necessary, do one of the following:
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• In the Edit  menu, choose Paste.

• Click the Paste tool on the toolbar.

• Press the key combination CTRL+V .

• Right-click the spreadsheet and choose Paste.

Apply Formulas

Simple formulas can be entered into spreadsheet cells, similar to using Microsoft Excel. Unlike in Excel, the formulas
are evaluated immediately, and the result of the formula is stored in the spreadsheet, not the formula itself. These
formulas are useful for performing quick computations and conversions. To enter a formula, precede it with an equal
sign. Formulas cannot reference other cells. Some example formulas are:

=5/2.54 (converts 5 centimeters to inches)
=10*sin(.1) (sin expects an angle in radians)

To enter more complex formulas or apply formulas to many cells at once, see Spreadsheet Formulas (page 161).

Graphing Data

Any data presented on spreadsheets in LARSA 4D can be graphed using custom graph tool.

For more information, see Custom Graphs (page 193).

For More Information, please refer to the following documentation.

• Spreadsheet Formulas on page 161.

• Model Data Reference in LARSA 4D Reference Manual.
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Files & Reports

The following sections describe using files and reports in LARSA, through the loading, saving, import/export and
report/printing features.

Project Properties 61

Import Project (Merge) 65

Import DXF (AutoCAD) File 67
How the Import is Performed 67
Import Options 67

Export Zip Package 69

Export DXF (AutoCAD) File 71

Export ADINA File 73
Before using the tool 73
Supported project data 73

Export BMP/AVI (Images and Animations) 79

Print a Report 81
Report Options 81
Model Data 82
Analysis Results 83
Graphics Views 83
Generate Report 84

File Types 85
Project Files (*.lar) 85
Database Files (*.drs,*.dth, *.dml, *.lpsx) 85
Analysis Results Files 85
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Project Properties

The Project Properties dialog box is used to edit the title, author, and comments fields of the open project, to edit the
user's company information, and to display project statistics.

This tool can be found on the “File” menu under “Properties” .

The first page of the Project Properties dialog box has the title, author, and comments fields.

The first page of the dialog box has three edit fields where the title, author, and comments fields of the open project
can be set. This information is used for generating reports and other exports.
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The second page of the Project Properties dialog box has the company information fields.

The second page of the dialog box has several fields to edit the company information associated with the license of
LARSA running on the computer. The company profile is used for generating reports and other exports. Because each
installation of LARSA is expected to be used in one company, the company profile is stored as a global setting of
LARSA and not in individual projects.
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The third page of the Project Properties dialog box shows project statistics.

The third page of the dialog box shows statistics for the currently open project. For Input Statistics, the total number of
each type of properties, geometry elements, and loads are listed. For Output Statistics, each result type is listed along
with whether that result has been computed by an analysis and is available for viewing.
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Import Project (Merge)

The Import Project tool is used to merge the contents of a second LARSA project into the open project. This is useful
if different parts of a structure are stored in separate files and need to be merged into one project.

This tool can be found on the “File” menu under “Import > LARSA Project” .

Import Project

To merge the contents of a project into the currently open project, start the Import Project command. You will be
prompted to choose a file to import.

Uncheck types of data that you do not want merged. If Members is unchecked, for instance, the members in the selected
file will not be imported.

To add all of the imported geometry into a new structure group (page 93), check the Import geometry as new structure
group option and then enter the name of the new group.

If items in the imported project have the same ID numbers as items in the current project, the IDs of the imported items
must be changed. LARSA will automatically renumber conflicting items by default.

To override the default renumbering, check Generate New ID Numbers and specify the starting ID number for the
joints, members, and shells imported.

Click Import to begin importing the contents of the selected file.
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Import DXF (AutoCAD) File

The Import DXF tool is used to import the contents of a DXF file into the open project. DXF files are usually generated
by drafting tools such as AutoCAD.

This tool can be found on the “File” menu under “Import > DXF File” .

Import DXF File

To import the contents of a DXF file into the currently open project, first click the Browse button and select the file
to import. Then choose the appropriate options, described below.

How the Import is Performed

LARSA 4D imports following DXF objects from the selected layers.

• LINE, LWPOLYLINE, POLYLINE and MLINE objects are imported as members.

• 3DFACE and SOLID objects are imported as shells.

Import Options

Select Layers
Often the contents of DXF files are organized into layers, each layer containing a different set of drawing
elements. LARSA will only import the contents of layers marked with a check in the selection list.

Import in UCS
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The contents of the DXF file can be imported relative to a user coordinate system [see “User Coordinate
Systems” in LARSA 4D Reference Manual]. If a coordinate system other than the global coordinate system
is chosen, then the coordinates of the DXF entities are transformed as if they were specified in coordinates
relative to the selected system.

DXF Units
Coordinates in DXF files are specified without units. By default, the coordinates in the DXF file are assumed to
be in whatever coordinate units are being used in the open project. To override what units the coordinates in the
DXF file are in, modify this option.

Generate ID Numbers Automatically
Items imported from a DXF file must be given IDs not already used by objects in the open project. LARSA will
automatically number items by default. To override the starting ID numbers of the imported joints, members,
and shells, uncheck this option and specify the starting IDs.

Import Members, Import Shells
Unpush these buttons if you do not want the members or shells imported from the DXF file.

Imported Types, Sections, Materials
Choose what member/shell types, sections, and materials to assign to the imported entities, if any.

Merge Duplicate Joints
If checked, an extra scan of the imported coordinates will be performed to ensure no imported joints result in
having two different joints at the same location in the project. If the DXF file takes a long time to import and
if you are sure no coordinates in the DXF file overlap with coordinates of joints in the open project, this option
may be unchecked.
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Export Zip Package

The Export Zip tool compresses all of the files needed by the open project into a Zip archive which can be more easily
and quickly sent by email than uncompressed project and output files.

This tool can be found on the “File” menu under “Export > ZIP Package” .

Export ZIP Package

Zip archives store multiple files in compressed form. Because analyzed LARSA projects involve many files on disk
(the project file, analysis results, and linked databases), it is useful to compress a project into a single Zip archive file
before sending the project by email or disk to others.

LARSA will automatically compress all of the files needed by a project into a Zip archive with the Export Zip Package
command. The user may select what parts of a project are to be exported into the Zip file.

Project File
Check this option to include the main project file (the LAR file) in the Zip archive.

Linked Databases
Check this option to include the databases linked to the project in the Zip archive. Linked databases generally
are the moving load databases, response spectra databases, and time history databases used by the project. (See
Connecting Databases (page 137).)

Analysis Results

Check this option to include the analysis results in the Zip archive. Because analysis results for large projects
often are very large on disk, leaving this option checked may result in the exported Zip file being too large to
send by email or disk.

Normally email attachments should be under 5 megabytes in size. If analysis results are shown as larger than 5
MB, it is recommended that the analysis results not be included in a package sent by email.
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The contents of a Zip archive can be accessed in several ways.

• LARSA will automatically open a LARSA project in a Zip archive from the regular File > Open  menu
command.

• Users of Windows XP can extract the contents of a Zip archive from Windows Explorer.

• Other third-party tools, such as WinZip (from http://www.winzip.com), are available for creating and extracting
Zip files.
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Export DXF (AutoCAD) File

The Export DXF File tool exports the geometry in the open project to a DXF file, which is readable by AutoCAD
and other drafting software.

This tool can be found on the “File” menu under “Export > DXF File” .

Exporting DXF Files

This tool has the following options.

Select DXF Version
Select what DXF format to use for export: AUTOCAD 13, 14, or 2000 format.

Export Members/Shells
Choose whether members and/or shells are exported to the DXF file.

Export Only Selected Objects
If this option is checked, only the selected geometry elements are exported to the DXF file.

LARSA 4D exports joints, joint numbers, members and shells to DXF format.

Joints are exported as POINT objects. All joints are placed in a layer called "Joints." Joint numbers are exported as
MTEXT and placed in a 'JointNumbers' layer.

Members are exported as LINE objects. All members are placed in a "Members" layer.

Shells are exported as 3DFACE objects. All shells are placed in a "Plates" layer.
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Export ADINA File

The Export ADINA File tool exports the LARSA 4D project to an ADINA input file.

This tool can be found on the “File” menu under “Export > ADINA File” .

Before using the tool

Before using the Export ADINA File command, the units in the project must be the same in all unit categories. Use
Model Units (page 133) to apply a unit conversion if necessary.

Supported project data

Project data which is exported is listed below and indicated with a checkmark (✓).

Materials

Elastic isotropic materials only.

Sections

All sections can be exported to ADINA.

Built-in section shapes in the Section Dimensions spreadsheet [see “Sections” in LARSA 4D Reference Manual] are
exported as ADINA cross-sections according to the following table:

LARSA 4D ADINA

Rectangle Rectangle

Hollow Circle Pipe

Solid Circle Pipe

Tube Box

C-Shape U-Beam

I Shape I-Beam

T Shape I-Beam

Angle L-Beam

All other sections General

The built-in section shapes that have a corresponding ADINA section type (those other than General) are exported with
their section dimensions. For these types, section properties are not exported as ADINA will calculate the properties.
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Other section shapes, custom sections, and sections created in LARSA Section Composer are exported as ADINA
General sections by exporting section properties (area, inertia, etc.).

Nonprismatic sections and members with assigned sections at start and end are exported as a single prismatic section
with averaged properties.

User coordinate systems (UCS)

• Cartesian

• Cylindrical

• Spherical

• Bridge Path

Isolator Definitions

Dashpot properties

Joints

Supported properties

Universal restraints ✓

Restraints ✓

Displacement UCS ✓

DOF Constraints ✓

Rigid Links ✓

Members

LARSA 4D ADINA

Beam 2-node Hermitian beam

Truss Truss (2-node)

Cable Truss (2-node) + nonlinear elastic material (can resist
tension only)

Tension-Only Truss Truss (2-node) + nonlinear elastic material

Compression-Only Truss Truss (2-node) + nonlinear elastic material

Inactive ✓ (not exported)

Supported properties

Member End Offsets -
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Supported properties

Member End Releases ✓

Spans ✓ (for section nonprismatic variation)

Member End Nonlinear Springs -

Prestress Force ✓

Rigid Zones -

Casting Day -

Springs

Two-node and grounded linear and nonlinear springs are supported, as well as a simple bilinear hysteretic spring.

LARSA 4D ADINA

Linear spring acting in global direction Linear spring

Linear spring acting in local direction Linear connector

Nonlinear spring in any direction Nonlinear spring

Bilinear hysteretic spring without degradation acting in
the local axial direction

Truss element + plastic-bilinear material

Supported properties

Maximum Tension and Compression -

Hook -

Gap -

Shells

Supported properties

Membrane/plate behavior All types are exported as MITC4 shells.

Shell Offsets ✓

Casting Day -

Material Angle -

Solids

Supported.
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Mass Elements

Supported.

Isolators

LARSA 4D ADINA

Linear dashpot Nonlinear "spring" with zero stiffness, prescribed
Damping Coefficient and Velocity Power n = 1

Nonlinear dashpot Nonlinear "spring" with zero stiffness, prescribed
Damping Coefficient and Velocity Power

Structure groups

Structure groups are exported as one or more ADINA Element Groups.

In ADINA, an Element Group contains elements with the same properties (material, section, etc). More than one
Element Group with the same name may be created for each LARSA 4D structure group since elements within the
same structure group may have different properties (element type, material, section, etc) and, therefore, have to be
assigned to different Element Groups.

If an element belongs to more than one structure group in LARSA 4D, it will be assigned to just one ADINA Element
Group.

Load Cases, Load Combinations, and Loads

Only load cases with their status set to Active  are exported. ADINA supports multiple load cases in linear static
analysis only. For other analysis types, a single load case should be set to Active .

Load combinations are not supported.

The following load types are exported:

Joint Loads ✓

Joint Displacement Loads ✓

Member Loads Point Force exported as equivalent nodal loads

Uniform Force over the full length of the member

Trapezoidal Force over the full length of the member

Point Moment -

Uniform Moment -

Trapezoidal Moment -

Pre-Tension -
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Post-Tension -

Jacking Elongation -

Member Thermal Loads Uniform ✓

Linear Variation -

Nonlinear Variation -

Shell Loads Uniform Force ✓

Uniform Temperature Change ✓

Temperature Gradient ✓

Point Force -

Strain -

Point Moment -

Solid Loads Body -

Strain -

Uniform Thermal ✓

Moving loads -

Time History Excitations time/acceleration ✓

time/velocity -

time/displacement -

time/force ✓

time/moment -

time/damping -

time/factor -

Time History Initial Conditions -

Response Spectrum Analysis parameters are not exported.

Construction Stages, Steps, and Activities

Not supported.
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Analysis types

The exported project can be analyzed using any analysis type available in ADINA. The parameters of the following
analysis types are directly exported to ADINA at this time:

• Static

• Eigenvalue analysis

• Time History Analysis (Linear and Nonlinear)

For all the other analysis types, the analysis type and parameters can be easily set in ADINA using applicable user
interface tools.
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Export BMP/AVI (Images and Animations)

The Export BMP Image/AVI Animation tools exports an image or animation of the open project to a BMP- or AVI-
format file, which can be viewed on all Microsoft Windows computers.

This tool can be found on the “File” menu under “Export > AVI Animation” .

These tools are found on the File  under Export .

Export AVI Animation

Image Size
The width and height in pixels of the image or animation. Larger image sizes will take longer to generate and
will take up more disk space. 640x480 is generally a good size.

The remaining options are for animation export only.

Frame Rate
The rate at which frames in the animation will be presented when the exported animation is played. The lower
the frame rate, the smoother and faster the animation. The choice of frame rate does not affect the size of the
AVI file.

Animation Type
Choose what type of animation to export.

Rotation on Z: Rotates the structure about the z-axis through 360 degrees.

Graphical Results: This option is available if results are currently being displayed graphically. The results
being displayed graphically will be animated for the export. If mode shapes are being displayed, an animation
of the current mode shape will be exported. For other results, each result case in the current result group will
be exported as a frame in the animation. This is useful for staged construction, moving load and time history
analysis results. See Viewing Results Graphically (page 173).
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Construction Stages: Each step in the construction of the structure will be exported as a frame in the
animation. See Staged Construction Analysis [in LARSA 4D Reference Manual].

Drive Through: An animation of a drive-through of the structure will be exported. The drive-through will
follow a lane [see “Lanes” in LARSA 4D Reference Manual] already defined in the project, and the position of
the vantage point will move at the specified increment (in coordinate units) per frame.
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Print a Report

The Report tool prints out a hard copy of the model data or results in the open project, or saves a report to a file in
various formats.

This tool can be found on the “File” menu under “Report” .

The Report Wizard takes you through the steps to print out a report of the model and/or results. Step forward and back
through the wizard using the Back and Next buttons at the bottom of the dialog.

Report Options

Create a Printed Report

Load Report Profile
At the very end of the Report Wizard, you have the option of saving the choices you made so that you do not
need to go through the wizard again to generate the same report. To load in previously saved settings, choose
the profile to load at this step.

Report Title
Give a title for the report. The title will be printed on the cover page.

What Pages to Include
You may optionally include each of the following pages:

• Cover Page - A cover page will be printed.

• Table of Contents - A table of contents of the report will be printed.

• File Summary - A summary of the project's contents will be printed.
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• Graphics Windows - All open graphics windows will be printed.

Company Logo
To print your company's logo on your report, click the Browse button and select an image file on your computer
with your company's logo. Standard image format files are supported, including BMP and GIF.

Model Data

Input Model Data

The Model Data tab is divided into three sections: Properties & Geometry, Groups & Stages, and Load Cases &
Combinations.

Each section contains a list of the different parts of your project that you can print. Sections are printed as spreadsheets,
with the same rows and columns you normally see on screen.

Check each spreadsheet to include in the report.
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Analysis Results

Analysis Results Report

In this section, you can choose which analysis results to print in the report. Analysis results are only available if they
have previously been solved in an analysis.

To print a result spreadsheet, follow these steps.

1. In the Result field, choose the type of result to print.

2. Select which result cases to print the results for. Select the result case on the left and then click Add Result
Case to add it to the list of cases on the right.

3. If you want the results enveloped, select the aspect of the result to envelope on. For instance, if you are printing
member end forces, you might want to report the maximum starting x-force for each member. In that case,
choose Start Force in X to envelope on. The envelope will be taken over the result cases chosen in the previous
step.

4. When all of these choices are finalized, choose Add Report Item. Your choices will be listed in the box at the
bottom.

5. Repeat this process for each result type to print.

Graphics Views

If you have saved Named Graphics Views, you may print a graphics page for each of the views. Select which named
views to print from the list.
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Generate Report

Generating Report

This is the final step before printing the report.

At this point, you may save the choices you made as a report profile so that you can recall the choices the next time you
want to print the same report again. To save your choices, enter a name that describes your choices and then click Save.

Output Format
Choose which type of output format you would like.

• Printer - The report will be printed.

• PDF Format - The report will be saved to a PDF file, which is readable by the free Adobe Acrobat Reader
provided by Adobe.

• HTML Document - The report will be saved in an HTML-format file, which is readable by any web browser.

• Microsoft Excel - The report will be saved as a Microsoft Excel spreadsheet. Because Excel spreadsheets are
limited to 65,535 rows, large projects may not export successfully.

• Text-Only - The report will be saved as a plain text file, readable on any computer with any text editor.

Click Finish to print the report. You will first be presented with a preview of the report.

84



LARSA 4D User’s Manual

File Types

The various files used by LARSA 4D are explained in this section.

Project Files (*.lar)

All of the input information that makes up a model is stored in a *.lar file. This file includes all units, properties,
geometry, loads etc.

Moving load patterns, parametric section definitions, time history curves, and response spectra curves are stored in
external databases, however. See below.

Database Files (*.drs,*.dth, *.dml, *.lpsx)

These files are database files that can be used by attaching them to a project.

• *.drs:  Stores response spectra curve data. Use the Database Editor to edit, create or view the database.

• *.dth:  Stores time history curve data. Use the Database Editor to edit, create or view the database.

• *.dml:  Stores moving load pattern data. Use the Database Editor to edit, create or view the database.

• *.lpsx:  Stores parametric section data. Use the Section Composer to edit, create or view the database.

For information on how to connect databases to a project, see Connecting Databases (page 137). For information on
how to create and edit databases, see The Database Editor (page 159). For information on how to create and edit section
databases, see LARSA Section Composer [in LARSA Section Composer Manual].

Analysis Results Files

The LARSA 4D analysis engine writes result data into separate output files. Output files are normally put into a separate
folder than the project file because a single analysis can generate several dozen output files. Normally, these files are
put into a subfolder next to your project (LAR) file called LarsaResults\[project file name]. The output location can
be changed in Analysis > Result Options .

It is not uncommon for an analysis to generate dozens of results files.

85

LARSA4D_SectionComposerManual.pdf%23sectioncomposer__LARSA%20Section%20Composer


LARSA 4D User’s Manual

86



LARSA 4D User’s Manual

Explorers

Navigating through a large project can be difficult, no matter what software package is used. While invaluable,
spreadsheets often present too much data at once. Introducing the solution to this problem, LARSA 4D uses Explorers
to summarize large quantities of data into manageable units which can be quickly edited. The Explorers are explained
in these sections.

Using LARSA 4D's Explorers

LARSA 4D's Explorers are shown at the right side of the screen. There are five explorers: Model Data, Load Cases,
Structure Groups, Construction Stages, and Analysis Results. One or two Explorers can be shown at a time, either
side-by-side, as in the image, or one on top of the other.

LARSA 4D Explorers

Above the active Explorer are five small buttons, one for each Explorer: Model, Load, Group, Stage, Results. Click
one of these buttons to activate that Explorer.

Below the first row of buttons is a second row for choosing whether to view one or two Explorers at once. The left-
most button turns on single-Explorer mode. The next button turns on vertical-split mode, in which two Explorers are

87



LARSA 4D User’s Manual

shown with one above the other. The third button turns on horizontal-split mode, in which two Explorers are shown
side-by-side. When two Explorers are show, the last button is enabled and when clicked will reverse the positions of
the two Explorers.

A third row of buttons appears when two Explorers are shown. This row controls which Explorer is displayed in the
second (right or bottom) panel.

LARSA 4D Explorers

To resize explorers, bring the mouse over the left border of the explorer. When the mouse becomes a horizontal arrow,
drag the border sideways.

If screen space is limited, the explorers can be hidden. To hide the explorers, choose the View  menu and uncheck the
command Show Explorers. To show the explorers again, choose the same command again.

Model Data Explorer 89

Load Cases Explorer 91
Using the Load Cases Explorer 91
Load Case Properties 92

Structure Groups Explorer 93

Construction Stages Explorer 97

Analysis Results Explorer 99
Using the Analysis Results Explorer 100
Use with Special Result Cases 100
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Model Data Explorer

The Model Data Explorer is used for quickly adding new elements to the structure and modifying the properties of
existing elements. This Explorer is similar to the Properties window of AutoCAD and other applications.

The Model Data Explorer

The explorer, displayed on the right-hand side of the screen when LARSA starts, can display properties of geometry
entities (joints, members, shells, etc.) and load entities (joint loads, member loads, etc.). To switch between joints,
members, etc., use the drop-down list at the top of the explorer. To switch between geometry and loads, use the tabs
at the bottom of the explorer.

The values displayed in the explorer reflect the properties of the currently selected objects. If more than one object is
selected, the properties that all selected objects have in common are displayed, and properties which are not common
are left blank.
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To make a modification to the properties of selected objects, make the appropriate changes in the listing of properties,
and then click the checkmark button. Changes are not finalized until the checkmark is clicked to confirm them.
Properties which have been changed but not confirmed are shown in bold until they are confirmed.

The reset button (the arrow bending backward) will abort any unconfirmed changes and update the listing to display
the current properties again.

To add a new object, enter the properties of the object, and then click the add button (the plus sign). Be sure to set the
properties first, as the Explorer will continue to display the properties of all selected objects afterwards, not just the new
object. For geometry items, the add button will not be available unless a unique ID for the object has been supplied.

If no objects of the type being modified are currently selected, then the explorer will display default values, and the
checkmark will not be available.

The Model Data Explorer can be used to quickly select objects by their ID. If the Explorer is showing properties of
selected joints, enter the ID of a joint in the ID field and hit enter, and that joint will be selected. All other objects will
be deselected. You may also enter ranges and lists of IDs (e.g. 1-10,25,26).

This explorer can be used to edit:

• Joints [in LARSA 4D Reference Manual]

• Members [in LARSA 4D Reference Manual]

• Shells [in LARSA 4D Reference Manual]

• Springs [in LARSA 4D Reference Manual]

• Isolators [in LARSA 4D Reference Manual]

• Lanes [in LARSA 4D Reference Manual]

• Tendons [in LARSA 4D Reference Manual]

• User Coordinate Systems (page 141)
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Load Cases Explorer

The Load Cases Explorer is used to rapidly create and edit load cases and load combinations.

The Explorer lists all load cases and combinations in the project and indicates the contents of each load case beneath
the case. In the explorer shown here, the blue load icons denote a load case or combination.

Load case properties can be edited directly from the Explorer. The Explorer is also used to select the active load case.
Before modifying a load case, it must be selected in the Explorer.

The Load Cases Explorer

Using the Load Cases Explorer

To select a load case or combination, click it. It becomes the active load case for viewing and editing. Graphics
windows will show the loads within the active load case if Input Loads is checked in the Show window (page 43).

To create a new load case, click the Add Load Case button, which has a plus sign next to a single load icon.

To create a new load combination, click the Add Combo button, which has a plus sign next to a load group icon
(two arrows).

Right-click a load case or combination to modify its name, properties (including self-weight application), or to
duplicate the case.

Double-click a load case, or click the spreadsheet button in the Explorer, to edit the contents of the load case
numerically in a spreadsheet.
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Load cases can be added to load combinations by clicking-and-dragging the load case onto the appropriate load
combination. To remove a load case from a load combination, simply drag the case out of the combination. To edit a
load case's factor as applied in a load combination, right-click the load case.

To delete a case, select the case and then click the delete (X) button.

Load Case Properties

The following properties may be set for a load case:

Name
The load case name is used to identify the load case in the results. Any textual name may be given.

Type
The type of the load case is used to determine which analysis type will be used to solve that case. The type
is set automatically by LARSA as needed.

Load Class
The load class is used for extracting cumulative effects of load classes (page 209) in Staged Construction
Analysis [in LARSA 4D Reference Manual]. The load class chosen does not affect the analysis.

Weight Factor
Setting a weight factor causes LARSA 4D to apply self-weight to the members and shells in the
model according to their section and material properties. The weight-factor option is a vector in global
coordinates that determines the direction of gravity. When the z-axis is up, specify negative one to apply
gravity downward at normal scale. The 0 button turns off self weight. The -Z and -Y buttons set self weight
appropriate for z-up and y-up, respectively. (See Self Weight [in LARSA 4D Reference Manual])

Active
Uncheck this option to have LARSA 4D not solve this load case in the next analysis.

For More Information, please refer to the following documentation.

• Static Load Cases in LARSA 4D Reference Manual.

• Load Combinations in LARSA 4D Reference Manual.

• Self Weight in LARSA 4D Reference Manual.
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Structure Groups Explorer

For medium-to-large sized structures, breaking down a structure into groups can save time by allowing quick access
to a particular part of the structure. Structure Groups do just this.
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The Structure Groups Explorer

Structure groups are groups of objects in your structure: joints, members, shells, and springs. Groups allow you to
quickly select and unselect various geometric portions of a structure, for using the Model Data Explorer (page 89), or for
viewing results (page 171) in particular portions of the structure. Groups are also used in staged construction analysis
[see “Staged Construction Analysis” in LARSA 4D Reference Manual] and as design groups for Steel Design (page 375).
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To create a new Structure Group, click the Add Group button. A new group will be added containing all of the currently
selected geometry.

Structure groups may be organized into folders, and folders may be organized within folders as well.

Clicking on a structure group in the explorer will open an action menu for that group with the following choices:

Select
Unselects all current geometry and then selects the geometry in the Structure Group.

Select Into
Retains the current model selection and then additionally selects the geometry in the Structure Group.

Unselect
Unselects all geometry in the Structure Group.

Show
When Hide Unselected (page 51) is on, shows the geometry in the Structure Group. If Hide Unselected (page 51)

is not yet on, it is turned on and all other geometry is unselected and hidden.

Hide
When Hide Unselected (page 51) is on, hides the geometry in the Structure Group. If Hide Unselected (page 51)

is not yet on, it is turned on and the Structure Group is hidden.

Add Selected Geometry
Adds the selected geometry into the group, retaining the geometry that was already included in the group.

Set Group to Current Selection
Sets the Structure Group's contents to the currently selected geometry, discarding whatever was included
in the group previously.

Spreadsheet
Opens a spreadsheet showing the contents of the Structure Group.

Delete
Deletes the Structure Group.

Rename
Renames the Structure Group.

Color
Gives a color to all geometry in the Structure Group.

Add Group
Adds a group within the selected folder.

Add Sub-Folder
Adds a sub-folder within the selected folder.

Geometric objects may be members of multiple groups, and different types of geometry can all be in the same group.

Groups and folders may be moved into folders by clicking-and-dragging them on top of folders. Bring a group or
folder to the top level by dragging it into the empty space of the explorer.
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While dragging a group, hold CTRL to make a copy of the group in the folder where you drop the group. No new
members/shells will be created. Only a new structure group will be formed with the same contents as the old group.

LARSA can automatically divide a structure into groups of floors and walls if the floors and walls are in standard planes
(planes parallel to the global x-y, x-z, or y-z planes). Click the auto-group button and choose which axis represents
elevation. (If the floors are on planes parallel to the x-y plane, choose the z-axis.) Set a tolerance level so that objects
at nearly-identical elevations are grouped together.
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Construction Stages Explorer

The Construction Stages Explorer is used for Staged Construction Analysis to define the order in which a structure
is built.

The Construction Stages Explorer
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The Explorer is explained in detail in the Staged Construction Reference [see “Staged Construction Analysis” in LARSA
4D Reference Manual].

A construction "stage" represents a day of activity. Add a stage using the Add Stage button. Each stage can be assigned
a day, temperature, and humidity for a time-dependent analysis. To set a stage's day, click the stage, enter a day at the
bottom of the explorer, and then click the checkmark to confirm the change. To set the temperature and humidity, use
the stages spreadsheet in Input Data > Load Groups & Stages > Construction Stages .

Construction activities are grouped into "steps". Each step represents a single activity, such as construction and loading,
stressing a group of tendons, or changing support activities. To add a step to a stage, click the Add Step button.

To specify which model elements are constructed or deconstructed in a step, click-and-drag a structure group (page 93)

into a step. You must have both explorers open at once. Similarly, to add loading into a step, click-and-drag a load
case (page 91) into the step. To remove a structure group or load case from a step, click-and-drag it out of the step into
the empty white area of the explorer.

To add other activities to a step, right-click the step and choose the activity type from the menu. The activities
spreadsheets will be brought up in which activity data can be entered.

For More Information, please refer to the following documentation.

• Construction Stage Editor on page 157.
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Analysis Results Explorer

To efficiently explore results from analyzed load cases, each case of results is listed in the Analysis Results Explorer.

The Analysis Results Explorer

Result cases (to be distinguished from input load cases [see “Static Load Cases” in LARSA 4D Reference Manual] in the
Load Cases Explorer (page 91)) are the different scenarios that have been processed by the analysis engine. These cases are
the post-processing counterparts of load cases, load combinations, and construction stages [see “Staged Construction
Analysis” in LARSA 4D Reference Manual].
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Result cases do not always correspond directly to input cases. In Linear Static Moving Load Analysis and Dynamic
Rolling Stock Analysis [in LARSA 4D Reference Manual], one input load case is used to define the application of
moving load patterns to the structure, and the analysis engine generates numerous result cases representing the possible
positions of the load patterns on the structure. In these cases, the resulting generated cases are grouped together in
the Analysis Results Explorer.

Result cases are displayed hierarchically in the Analysis Results Explorer. Groups are indicated by a plus or minus
sign next to them. Click a plus sign to expand the group and see what result cases and groups it contains. Click a minus
sign next to a group to collapse the group and hide its children.

Using the Analysis Results Explorer

Results for a case can be viewed by clicking the result case, and then selecting either a graphical result to display or
a result spreadsheet from the Results  menu. You can also right-click a case to access its spreadsheet results quickly.
For more on accessing results, see Getting Results (page 171).

Select cases by clicking them. Hold CTRL  while clicking to select multiple cases. Hold SHIFT  to select a range of
cases. CTRL +click a group to select or unselect all of the cases in the group. Selected cases are shown in blue. The
last case clicked is highlighted.

When viewing results in Results Spreadsheets (page 179), results are displayed for each case selected in the Analysis
Results Explorer. When envelope is turned on in a results spreadsheet, then the spreadsheet displays an envelope of
the result cases selected in the Analysis Results Explorer.

When viewing results graphically (page 173), the results are shown for either the last result case selected or for an
envelope of all of the result cases selected in the Analyis Results Explorer. See Viewing Results Graphically (page 173).

The date and time that a result case was solved is displayed at the bottom of the Explorer, and the display scale factor
for displaying deformed structure, mode shape and force diagrams can be easily adjusted from the explorer by dragging
the slider at the bottom.

Use with Special Result Cases

Result cases created after an analysis is run (e.g. Linear Result Combinations (page 183), Extreme Effect Groups (page

187) and Influence Line & Surface Analysis [in LARSA 4D Reference Manual]) are also shown in the Analysis Results
Explorer.

Their properties can be edited by right-clicking on the case and choosing Properties .

They can also be deleted by right-clicking on the case and choosing Delete .

For More Information, please refer to the following documentation.

• For more on accessing results, see Getting Results on page 171.

100

LARSA4D_ReferenceManual.pdf%23analysis__Linear%20Static%20Moving%20Load%20Analysis%20and%20Dynamic%20Rolling%20Stock%20Analysis
LARSA4D_ReferenceManual.pdf%23analysis__Linear%20Static%20Moving%20Load%20Analysis%20and%20Dynamic%20Rolling%20Stock%20Analysis
LARSA4D_ReferenceManual.pdf%23analysis__Influence%20Line%20&%20Surface%20Analysis


LARSA 4D User’s Manual

Modeling Tools

LARSA provides a handful of modeling tools to help in the creation of your structure. The modeling tools are in the
Draw and Modify menus.

The Draw  menu's tools allow you to create new objects in your structure.

The Modify  menu's tools are for modifying existing objects.

Drawing Geometry and Loads 103
Drawing Joints 104
Drawing Members 105
Drawing shells 106
Drawing Springs 106
Drawing Loads 107
Drawing DOF Constraints 108
Drawing Lanes and Tendons 109
Drawing Mesh 109

Undo/Redo 111

Erase and Delete Loads 113
Erase 113
Delete Loads 113

Break, Merge, and Join 115
Break Members, Break Shells 115
Merge Joints 116
Join Members 116

Transformations 119

Generation Tools 123
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Drawing Geometry and Loads

There are number of methods to create a model in LARSA 4D, one of which is drawing.

This tool can be found on the “Draw” menu.

Draw Toolbox

With the draw toolbox, you can select the drawing plane and the elevation in which to draw. As you move the mouse,
a crosshair will continuously show the coordinates of the mouse.

The mouse snaps to objects, midpoints, and perpendiculars. Useful information is displayed right next to the mouse
pointer or on the status bar as the mouse is moved over these targets.

Graphics View: Drawing a Member
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On the toolbox, set the increment (grid snap size) for the movement of the mouse. If the increment is 2 feet, when the
mouse is not over any of the above targets it will always snap to locations that are multiples of 2 feet on both axes.

During the draw process, the Model Data Explorer (page 89) automatically becomes active to let you specify the properties
of the geometry you are drawing. Set properties in the model data explorer before drawing so that the new objects
you create take on those properties.

Right-clicking during the draw process will generally reset the current drawing command. When drawing plates,
however, right-clicking after specifying the third joint of the shell will create a three-node shell. For springs, right-
clicking after specifying the first node will create a grounded spring. right-clicking also has a special behavior when
changing the support conditions of a joint (see below).

Drawing Joints

This tool can be found on the “Draw” menu under “Geometry > Joints” .

Draw Joints Toolbox

Click in the graphics window to draw a joint at the location under the mouse. The Graphics Window Grid (page 49) may
be useful.

An existing joint can be moved by clicking on that joint and then clicking its new location. It is also possible to change
the support conditions of a joint with a right-click: Change the support conditions in the Model Data Explorer (page 89)

and then right-click joints to apply the support conditions to joints.
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Drawing Members

This tool can be found on the “Draw” menu under “Geometry > Members” .

Draw Members Toolbox

To draw members, click a start location and then an end location. If you do not click on joints, joints will be
automatically created at the location of the click.

Members can be broken into multiple parts while drawing by specifying a Break number on the draw toolbox. You
can also draw members with a pre-set length and/or angle by turning on the option on the draw toolbox (clicking it so
it is checked) and then entering the length and/or angle. The angle is measured on the selected 2D drawing plane.

There are three drawing styles available:

Point to Point
Click on a start location and then an end location. The member will be drawn between the points. Click the
next member's start location to draw another member.

Polyline
Click on a series of points one-by-one to draw a continuous line of members. Right-click to stop drawing
the polyline.

Arc
Use this to draw a circular arc of members.

1. Click the center of the circle that the arc will go around.

2. You will see a line from the first point to the mouse indicating the radius of the arc. Click the starting location
of the arc.

3. Click the ending location of the arc. It must be on the circumference of the same circle.
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Drawing shells

This tool can be found on the “Draw” menu under “Geometry > Shells” .

Draw Shell Toolbox

There are two ways to draw shells. With the Point To Point method, click on joints in counter-clockwise order to
form a shell. New joints will automatically be created if there is no joint at a location clicked. If you are drawing a
triangular shell, right-click after drawing the third point. (If you do not right-click, LARSA assumes you are drawing
a quadrilateral shell.)

With the Rectangular method, click on the two opposing points of the shell to create a quadrilateral shell.

You can also draw shells with a pre-set width and height. Turn on a dimension restriction by clicking it (so that it is
checked) and then enter the appropriate value.

You can also break shells while drawing by entering Break X and Y values. Shells will be broken in X pieces along
its width and Y pieces along its height. The width of a shell is from the first joint clicked to the second joint clicked.
The height of a shell is from the second joint clicked to the third joint clicked.

Drawing Springs

This tool can be found on the “Draw” menu under “Geometry > Springs” .
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Draw Springs Toolbox

You can draw springs by clicking on locations in the graphics window as you would for drawing members (see above).

To draw grounded springs, click on a joint and then right-click to let LARSA know that you are done drawing.

Drawing Loads

This tool can be found on the “Draw” menu under “Loads” .
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Draw Loads Toolbox

Joint loads, support displacements, member loads, member thermal loads, shell loads, and area loads can all be drawn
with the mouse.

Begin drawing by first clicking on the appropriate menu, as shown to the center.

Enter the properties of the loads you are about to draw in the Model Data Explorer (page 89).

Then click on individual joints, members, or shells, as appropriate, to apply the load. To apply the load to many objects
at once, window the objects as if you were selecting (page 31) them.

Drawing DOF Constraints

This tool can be found on the “Tools” menu under “DOF Constraints” .

Besides creating DOF Constraints with the geometry spreadsheets, it is also possible to create and remove DOF
Constraints directly on the graphics window. This command pairs up the selected joints based on their distance to each
other and allows you to define (or remove) DOF Constraints between each pair. This assumes that constrained joints
are most of the time at the same location, and it should work fine even for cases where they are not at the same location
as long as distance can be used to pair them up appropriately. (Bear in mind that DOF Constraints between two joints
that are apart from each other is not same as having a rigid connection between those joints. DOF Constraints will not
have the effect of the rigid arm induced by the distance.

In order to use the feature, you should first select the set of joints you would like to modify. To define DOF Constraints,
start this tool and then select the directions in which you would like to create the relation, and click Create DOF
Constraint . If there is already a DOF Constraint between any of the paired joints, then it will be overwritten. To remove
DOF Constraints, click Remove DOF Constraint .
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The result of the process can be verified graphically if DOF Constraints are visible in the graphics window (see Graphics
Display Options (page 43)).

Drawing Lanes and Tendons

This tool can be found on the “Draw” menu under “From Selected Members” .

Draw Lanes and Tendons Menu

Lanes and tendons often follow a chain of members. To create a new tendon or lane following the selected members,
use the Draw > From Selected Members commands.

Drawing Mesh

This tool can be found on the “Draw” menu under “Mesh...” .
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Draw Mesh Menu

Areas of mesh can be shown using the mesh tool in the Draw menu. First select the meshed area, define the holes and
mesh type and click the Mesh button.
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Undo/Redo

Undo/Redo allows the user to reverse a change to the project — perhaps undoing an accidental change — and then
put it back again.

Undo or Redo Actions

In LARSA 4D nearly all operations can be undone. Undo/Redo works seamlessly with the spreadsheets, graphical
editing tools, and Explorers. There is no limit to the "Undo History," allowing you to undo all operations in the open
project since the current LARSA session began. Undo/Redo data is not saved with the project, so it lasts only as long
as LARSA 4D is running.

The Undo and Redo commands are on the Modify  and Edit  menus. (Only one of the two menus is visible at a time. The
Modify  menu is available for the Graphics windows, and the Edit  menu is available for the spreadsheet windows.)

When the Undo and Redo commands are available, a small description of the action that can be undone appears in the
menu item. The Undo command, for instance, might read "Undo Add Joint," indicating the last operation that can be
undone is adding a new joint. Choosing Undo will delete that joint, as if it had never been created.

Redo puts back the last operation that was undone. As in the last example, Redo would recreate that joint with the
properties that it had before Undo removed it.

Undo/Redo data is stored in a temporary file. The size of that file is displayed in the status bar. Only on very large
models does the Undo/Redo file grow beyond a megabyte.

A small number of operations cannot be undone, including applying a unit conversion to the entire project. After such
operations, all undo/redo data is cleared. Earlier operations can no longer be undone. The user is prompted to confirm
these operations and is warned of the consequences.
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Erase and Delete Loads

The Erase and Delete commands, found on the Modify  menu, remove geometric and load entities from the model.

Erase

This tool can be found on the “Modify” menu under “Erase” .

Erase Geometry

The Erase command deletes all selected geometric elements: joints, members, shells, springs, and isolators. All loads
applied to the erased geometry are deleted.

If a joint is an end-point of a member and that member is not selected for erasure, then the joint cannot be erased.

Members and shells that are used in a lane [see “Lanes” in LARSA 4D Reference Manual] or tendon [see “Tendons”
in LARSA 4D Reference Manual] path also cannot be erased. Erase the lane or tendon first, or edit the path so that the
member or shell is not referenced by the path.

Delete Loads

This tool can be found on the “Modify” menu under “Delete Loads” .
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Deleting Loads

The Delete Loads command removes all selected loads. Loads, like geometric elements, have a selected state. Only
the selected loads in the active result case are removed. Geometric elements that are not selected cannot have selected
loads, so loads on unselected geometric elements are guaranteed to be ignored. No geometric elements are modified
by Delete Loads.

To activate a load case, click it in the Load Cases Explorer (page 91).
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Break, Merge, and Join

Break, merge, and join are three tools for manipulating joints, members, and shells. These tools are on the Modify
menu.

Break Members, Break Shells

This tool can be found on the “Modify” menu under “Break Members / Break Shells” .

Break Members

These tools are used to break the selected members and shells into pieces. All of the loads placed on the initial members
and shells will be appropriately reassigned or redistributed onto the pieces.

For breaking members, the number of segments n to break each member into is specified. By default, the members
will be split evenly n ways. However, the position of the n-1 break points can also be specified. Break points are given
in relative terms, where 0 is the beginning of the member (the start joint) and 1 is the end of the member (the end
joint). 0.5 specifies the middle. To specify break points, enter the relative positions and separate each position with
a semicolon.

For breaking shells, the number of horizontal and vertical segments to break each shell into is specified. If 3 horizontal
segments and 2 vertical segments are specified, each shell will be broken into 3*2 = 6 pieces. The direction meant by
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horizontal (X) is the direction of each shell's local x-axis. A shell's local x-axis is from its first joint to its second joint.
(See Shells [in LARSA 4D Reference Manual].)

Repeatedly breaking square shells can serve as a simple form of shell meshing.

Merge Joints

This tool can be found on the “Modify” menu under “Merge Joints” .

Merge Joints

The Merge Joints command scans the selected joints looking for joints that have the same location. A tolerance can
be specified to allow for rounding error.

After selecting Merge Joints from the menu, click Check to begin scanning. This process may take some time if
thousands of joints are selected.

Once the check is done, a list of each group of coincident joints is presented. Each row lists all of the joints that were
found at a particular location. Uncheck a row if you do not wish to merge those joints into one joint. Because a tolerance
may be used, the coordinates of coincident joints may not be identical. In that case, for each row, you can choose which
joint's coordinates to merge the joints into.

Finally, click Merge to perform the merge on any checked rows.

Join Members

This tool can be found on the “Modify” menu under “Join Members” .
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Join Members

Join Members looks through all of the selected members for any chain of members that forms a straight line. Join
Members then joins all of those contiguous members into one, deleting any intermediate joints. If any intermediate
joints cannot be deleted, then the chain will not be joined.

All of the loads placed on the initial members will be appropriately reassigned or redistributed onto the new member.
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Transformations

LARSA provides various commands found on the Modify  menu to alter and duplicate parts of a structure. Among
those commands are the four transformations: Translate, Rotate, Mirror, and Scale.

These commands operate on all of the selected objects in your project. For example, when using the Translate
command, only the selected members will be moved. The unselected members will not be affected.

The four commands have a Make a Copy option. The Make a Copy option instructs LARSA to first duplicate all of
the selected objects, and then perform the operation. When making a copy, the Merge Duplicate Joints option instructs
LARSA to check that it does not create new joints where joints already exist.

All transformations are with respect to the active coordinate system (page 141). If no user coordinate system is active,
the global coordinate system is used.

Translate
Moves the selected objects a certain distance in a given direction. The specified x, y, and z values will be
added to the x-, y-, and z-coordinates of all of the selected joints.

Translate Window

Rotate
Rotates the selected objects about the origin by the angles specified. Specifying an X Rotation of 30
degrees will rotate the selected objects around the x-axis by that angle.

119



LARSA 4D User’s Manual

Rotation Window

Mirror
Reflects the selected objects over the specified plane.

Mirror Window

Scale
Multiplies the x-, y-, and z-coordinates of the selected objects by the specified scale factors.
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Scale Window

Skew
Skews the selected structure on the choosen plane and axis combination.
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Skew Window
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Generation Tools

The generation tools quickly generate new structural elements by copying, extrusion, and meshing.

This tool can be found on the “Draw” menu under “Generation” .

There are four types of generation commands. Select the command by clicking on its name in the listing on the left
of the window.

The Generation Tools

Repeated Copy

Repeated Copy clones the selected objects, moves the objects in a specified direction, and then repeats. The
number of copies (repetitions) and the offset of each subsequent copy (Delta X, Delta Y, Delta Z) can be
specified.

For instance, if a joint is at (10, 0, 0), to create joints at (20, 0, 0), (30, 0, 0), and (40, 0 ,0), use repeated copy
with repetitions set to 3, Delta X set to 10, and Delta Y and Z set to 0.

Repeated Copy can be applied in either the Global Coordinate System or in any user coordinate system (page

141) of any type. In a rectangular UCS, the Delta X/Y/Z values are applied in the directions of the UCS's
axes. In a cylindrical or spherical coordinate system, Delta R/Theta/Z or Delta R/Phi/Theta is specified,
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respectively. In those cases, the translations of each object will curve about the axes of the UCS. Arcs, spirals,
and helixes can be created using Repeated Copy in a non-rectangular coordinate system.

To create joints in a circular arc, use a cylindrical coordinate system at the center of the circle. Create a joint
at one side of the arc. Then use repeated copy with Delta Theta set to the degree angle between joints on the
arc. The arc will be created by rotating the joint around the global z-axis. Delta R and Delta Z must be set
to zero because each subsequent joint will be at the same radius and on the same xy-plane.

Repeated Copy Window
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Creating an Arc with Repeated Copy

The Merge Duplicate Joints option instructs LARSA to not create new, separate joints at locations where
joints already exist. For instance, if a joint at (10, 0, 0) is selected and you specify a repeated copy with Delta
Y = 5 and a joint already exists at (10, 5, 0), then the existing joint at (10, 5, 0) will be used as the copy, rather
than creating a second joint at that location. If this option is not checked, coincident joints may be created.

Extrusion

Extrusion will extrude selected joints into members or selected members into shells along the given direction.
The extrusion will repeat a specified number of times.

The direction of extrusion follows the coordinate system specified in the Generation Coordinate System box.
See Repeated Copy (above) for more information on using a UCS or non-rectangular coordinate system.

Select whether to extrude members, shells, or both in the Element Type drop-down choice.

If only joints are being extruded into members, then all of the selected members will be copied in tandem
with the extrusion in the same manner as Repeated Copy.

When extruding members, the new members will be given the type specified in the Member Type drop-
down choice.

See the description of Merge Duplicate Joints, above.
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Extrusion is very useful for creating the girders of a bridge, even on a curved bridge path. Use bridge path
coordinate systems (page 141) to lay out the geometric path of the deck. Then use extrusion, setting the user
coordinate system to the bridge path. Specify a Delta Station value as the spacing of joints along the bridge
path. Leave Delta Transverse and Delta Elevation at zero to extrude exactly along the path.

Extrusion Window
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Extruding Along a Bridge Path

Framework

Framework generates a framework of members based on a set of floor height and bay width/depth parameters.
Framework can be used to quickly set up a building model.

The resulting framework has one base corner at (X Start, Y Start, Z Start). It's width, depth, and height are
# of Bays (X) * Bay Width (X) , # of Bays (Y) * Bay Width (Y) , and # of Stories
* Story Height , respectively.

Check the Ground Floor Members option to generate members in the plane of the ground floor. If the option
is not checked, the framework will start with columns coming out of the ground, and no members resting
on the ground.

See the description of Merge Duplicate Joints, above.
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Framework Window
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Framework Generation

Span Meshing

Span Meshing is a specialized tool to generate a mesh of shells between two parallel chains of members.
Span Meshing will also work for a series of parallel chains of members.

A chain of members is a series of contiguous members, such as from joint 1 to joint 2, from joint 2 to joint 3,
from joint 3 to joint 4.... For span meshing, the chains must be in a a straight line, or close to it. In addition,
each of the chains must be approximately parallel. Furthermore, each chain must have the same number of
members.

Given a pair of member chains that satisfy these constraints, Span Meshing will create one shell between the
chains for each pair of corresponding members. The shell will span the existing joints on the member chains.

The simplest case of Span Meshing is for two parallel members: member 1 goes from joint 1 to joint 2, and
member 2 goes from joint 3 to joint 4. Span meshing will create a shell around joint 1, joint 2, joint 4, and
joint 3. The diagram below may illustrate Span Meshing better.
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Span Meshing Window

Span Meshing

There are three member chains each composed of three members. Each of the three chains are close to
straight lines, and the three chains are close to parallel. Span Meshing generated the six shells by connecting
the adjacent chains at their corresponding joints.

See the description of Merge Duplicate Joints, above.
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Project Options

The follow sections describe global project options.

Model Units 133

Universal Restraints 135

Connecting Databases 137
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Model Units

Numeric entries in LARSA are tied to several categories of units used by the project. The units used by the open project
can be edited using the Units window.

This tool can be found on the “Input Data” menu under “Units” .

Changing Model Units

The Units dialog is arranged into a simple matrix. The rows represent categories of units:

Coordinates
Used for joint locations and other measurements of coordinates.

Section
Used for section properties, including section dimensions, and tendon offsets within section bounds.

Material
Used for material properties.

Loads
Used for load positions and magnitudes.

Springs/Isolators
Used for spring and isolator properties.

Mass
Used for mass elements and other properties.

The units for each category can be independently changed so that, for instance, joint locations need not be in
the same units as section dimensions.

The columns of the matrix represent unit types: Length, Force, and Temperature. The unit in the cell in the Force
column and Loads row will be used for Force (or derived) units for load entities.
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A unit can be selected for most cells in the matrix. Some cells are gray, such as Coordinates/Force, for which unit
selection is not applicable.

Click the Metric or Imperial buttons to immediately change all units to the standard metric or imperial (American) units.

Click Apply Conversion to convert all numeric values in the projects to the new units you have specified.

Click Change Labels to set the project's units without applying a unit conversion. This is useful if you have entered all
numeric values in the wrong units. For instance, if you have entered coordinates in meters but coordinate length units
were set to feet, you can change the coordinate length units to meters and then click Change Labels. The coordinates
will be left unchanged but they will then be labeled with the correct unit.

Click Cancel to discard any changes you have made to the units.

The Units dialog only applies to numeric entries for model data. Results units are selected in the results units window
(page 195).
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Universal Restraints

Universal restraints are restraints in translation and rotation applied to all joints in the project. They are useful for
constraining a model into two-dimensions.

This tool can be found on the “Input Data” menu under “Universal Restraints” .

Setting Universal Restraints

The degrees of freedom selected as universal restraints are excluded from all analyses of the open project for all joints
in the model, regardless of the joint's own restraints.

Click a degree of freedom to make it universally restrained.

The standard six degrees of freedom can be restrained:

• X Translation

• Y Translation

• Z Translation

• X Rotation

• Y Rotation

• Z Rotation

Care should be taken when using both universal restraints and joint displacement coordinate systems [see “Joints”
in LARSA 4D Reference Manual]. When both are used, universal restraints are applied in joint local directions, not
global directions.
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Connecting Databases

Some types of data which may be common to more than one project are saved externally to a project in LARSA
database files. You can connect databases to your project using the Connect Databases command.

Connect Databases Dialog Box

This tool can be found on the “Input Data” menu under “Connect Databases” .

Moving load pattern data is one of the types of data that gets saved into an external database. By attaching a moving
load pattern database, you make all the patterns in that database available to the project. To connect LARSA's standard
database of American load patterns, click Connect Standard Database and open the file "movedata.dml."

Also all time history curves and response spectra curves are saved to an external database and can be connected
to the open project.

The Connect Databases dialog box is also used to connect section databases that are created in the Section Composer
[see “LARSA Section Composer” in LARSA Section Composer Manual].

For moving load, time history, and response spectra databases, only one database of each type can be connected to
the project.

To connect a database: Click Connect User Database and select the database file using the browse dialog box. Once
the database is connected, it will appear in the Linked Databases list.

To disconnect a database: Select the database from the list and click Disconnect.
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To edit a database: Select the database from the list and click Edit. This will activate the Database Editor (page 159).
Section databases can only be edited in the Section Composer [see “LARSA Section Composer” in LARSA Section
Composer Manual].

For More Information, please refer to the following documentation.

• For information on how to create and edit databases, see The Database Editor on page 159.
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Special Data Tools

LARSA 4D provides several specialized tools for working with materials, sections, and coordinate systems and a
special tool for checking for modeling errors.

User Coordinate Systems 141
Defining UCSs 144

Integrity Check 147
Integrity Tests 148

Loading Standard Materials 151

Loading Standard Sections 153

Creating Custom Sections 155

Construction Stage Editor 157

The Database Editor 159
Creating a Database 159
Adding/Removing Records 159
Adding/Editing/Removing Data 160
Other Data Views 160
Additional Options 160

Spreadsheet Formulas 161

Templates 163
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User Coordinate Systems

User coordinate systems are used to enter and view coordinates in systems other than global coordinates, and to apply
loads and set restraints in directions other than global directions.

Coordinate systems are accessed through the spreadsheets (page 53) or through the Coordinate Systems Explorer, which
is part of the Model Data Explorer (page 89).

There are four types of user coordinate systems: rectangular, cylindrical, spherical, and bridge path. For more
information on how each system works, see User Coordinate Systems [in LARSA 4D Reference Manual].
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Working with Coordinate Systems

UCSs are used in the following ways:

Active Coordinate System

There is always an active coordinate system. When LARSA 4D starts, the active coordinate system is the
global coordinate system. Joint coordinates in the spreadsheets (page 53) and the Model Data Explorer (page 89) are
always reported with respect to the active coordinate system. Transformations (page 119) and generation tools
(page 123) are also applied in the active coordinate system, and the graphics window grid (page 49) is displayed
in the active system.
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A user coordinate system can be set as the active coordinate system by right-clicking the coordinate system
in the Model Data Explorer and choosing Make This the Current UCS. To put the global system back as the
active system, right-click the coordinate system again and choose Make Global System the Current UCS.

Changing the active coordinate system does not affect the positions of joints in the project. It only affects
how joint coordinates are displayed and how modeling tools operate.

Joint Displacement Coordinate Systems

When joints are restrained, the restraints are applied in the directions of a user coordinate system applied to
the joint, rather than in global directions. Also, joint loads and grounded springs act in the directions of a
user coordinate system applied to the joint. See Joints [in LARSA 4D Reference Manual], DOF Constraints
[in LARSA 4D Reference Manual], Joint Loads [in LARSA 4D Reference Manual], and Springs [in LARSA
4D Reference Manual] for more information.

The explorer shows all of the coordinate systems in the open project. Click the plus sign to create a new user coordinate
system. If a user coordinate system is the active coordinate system, it is listed in bold.

Right-click a UCS and choose Edit UCS... to edit the user coordinate system. The window show below is used to set
the origin position, orientation, and type of UCS.
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Editing a User Coordinate System

Defining UCSs

All four UCS types can be shifted and rotated from the global axes. The origin coordinates define the origin of the
system, and they are specified in global coordinates. For rectangular UCSs, the origin is the (0, 0, 0) point in local
coordinates; for cylindrical UCSs, this is the center of the cylinder at z = 0; for spherical UCS, this is the center of the
sphere; and for bridge paths, this is the location of the first point on the path.

To choose the origin coordinate, type in the coordinates in the Origin fields, or click the Pick button next to the origin
fields. After clicking Pick, the UCS window will disappear, allowing you to click on a joint or grid point (page 49) to
choose the origin location. A floating window titled Select UCS Origin will appear. To cancel picking an origin, click
the Done button on the floating window.

The local directions of the UCS are defined by two vectors, one giving the direction of the x-axis, and the other
giving the direction of the z-axis. The direction of the y-axis can be determined by the right-hand rule. To set the local
directions, type in vectors in the X Axis, Z Axis or Point on XY Plane fields. The vectors are in global directions.
For instance, to line the local x-axis up with the global z-axis, enter (0, 0, 1) in the X Axis fields (regardless of the
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location of the origin). Alternatively, use the Pick buttons to choose a joint or grid point on the local x-axis, z-axis,
or a point on the local xy-plane.

For bridge paths, edit the path by clicking the Edit Path button at the top of the UCS window. For more information
on bridge paths, see Bridge Paths [in LARSA 4D Reference Manual].

For More Information, please refer to the following documentation.

• User Coordinate Systems in LARSA 4D Reference Manual.
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Integrity Check

The Integrity Check command checks a model for common modeling errors.

When one is modeling a structure, it is easy to accidentally enter numbers which are invalid, or forget to enter values
where they are required. The Integrity Check scans a model for common, detectable errors, reports the errors to the
user and suggests ways to fix the problem.

This tool can be found on the “Input Data” menu under “Integrity Check” .

Integrity Check

Select which integrity checks to run on the model by clicking on each item so that it has a checkmark next to it. By
default, all tests are performed. Click More Options to see a list of more advanced tests

Click Check to scan the model. This process can take several minutes on large models, especially ones with long
tendons.

A summary of results for each test will be listed in the upper-right box. Each test will have next to it either a green
check indicating the test found no problems or a red exclamation point indicating errors or warnings were found.

Click an item in the summary list to see details in the lower-right list. Details will report the exact errors that were found.
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Integrity Tests

The following checks are performed for each test.

See the Model Data Reference [in LARSA 4D Reference Manual] for more information about correctly entering data.

Stray Joints
Checks for joints that are not connected to any elements.

Elements
Checks that...

• Members, springs, and isolators are assigned a distinct start and end joint.

• Members have two joints, non-zero length, a section and material, and valid rigid zones.

• Shells are either triangular or quadrilateral, have been given a material, and have non-zero thickness.

• Isolators have been assigned an isolator property definition.

• Master joints in DOF Constraints are not also dependent joints.

• Mass Elements are properly defined.

Tendons
Checks that tendons have a material, a positive strand area, jacking force, and number of strands, and a
well-defined path.

Lanes
Checks that lanes have a well-defined path.

Materials/Sections
Checks that materials have a non-zero shear modulus and a Poisson ratio between 0 and 0.5. Also checks
that members have unique names and sections have unique names.

User Coordinate Systems
Checks that user coordinate systems are well-defined.

Spring Definitions

Checks that spring curves have at least two points, no point through the origin if it is hysteretic, and have
x-values that are only increasing.

Checks hysteretic spring definitions for Beta1, Beta2 between 0 and 1, and Alpha at least 2. Checks that
bilinear backbone spring definitions have 4 points on the curve and trilinear 7.

Loads
Checks that loads are properly defined.

Coincident Joints
Checks whether multiple joints are coincident (at the same location).

Overlapping Members
Checks for multiple members that span the same two joints.

Overlapping Shell
Checks for multiple shells that span the same set of joints.
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Spans
Checks that spans are properly defined and are collinear.

Construction Stages
Checks that construction stages and construction activities are properly defined. Ensures members are cast
before they are assembled.
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Loading Standard Materials

Before a member or shell can be given material [see “Materials” in LARSA 4D Reference Manual] properties, those
properties must be loaded into LARSA. The properties can be entered manually in the materials spreadsheet (page 53), or
they can be imported from the standard materials database. The latter method is explained in this section.

This tool can be found on the “Input Data” menu under “Materials” .

Importing Standard Material Properties

Standard materials can be added into the open project by opening the Standard Materials tool.

Materials in the standard database are organized by type: Steel and Concrete. Select the type of material you want to
add into the open project.

A list of available materials will be presented in the next box. Check the box next to the materials you want to add
to the open project, and then click OK when done.

For More Information, please refer to the following documentation.

• Materials in LARSA 4D Reference Manual.

• Members in LARSA 4D Reference Manual.

• Shells in LARSA 4D Reference Manual.
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Loading Standard Sections

Before a member can be given sectional properties [see “Sections” in LARSA 4D Reference Manual], those properties
must be loaded into LARSA. The properties can be entered manually in the sections spreadsheet (page 53), by creating a
custom section (page 155), or they can be imported from the standard sections database. The latter method is explained
in this section.

This tool can be found on the “Input Data” menu under “Sections” .

Loading Standard Sectional Properties

Standard sections can be added into the open project by opening the Standard Sections tool.

Sections in the standard database are organized by database (AISC, UK, etc.) and type (I, T, C, etc.). They can also be
filtered by name. Select these options in the first three drop-down lists.

A list of available sections will be presented in the next box. Check the box next to each section you want to add to
the current project, and click OK when done.

For More Information, please refer to the following documentation.

• Sections in LARSA 4D Reference Manual.

• Members in LARSA 4D Reference Manual.
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Creating Custom Sections

Before a member can be given sectional properties [see “Sections” in LARSA 4D Reference Manual], those properties
must be loaded into LARSA. The properties can be entered manually in the sections spreadsheet (page 53), imported
from the standard sections database (page 153), or created with the Custom Section tool. The latter method is explained
in this section.

Use the Custom Section tool when you want to add sectional properties to the open project that are not found in the
standard database but are based on standard shapes.

This tool can be found on the “Input Data” menu under “Sections” .

To create custom sections, open the Sections window and switch to the Custom tab.

Creating a Custom Section

Select the shape of the section from the list on the left. Available shapes include the basic shapes (rectangular, tube
and pipe, I, T, C, L, Z, triangular, trapezoidal, and half circle) and many code-based advanced shapes.

In the spreadsheet in the middle, provide a name for the section and enter the section's dimension. Parameters are given
appropriate to the shape type chosen.

The diagram on the right side of the dialog shows the orientation of the axes of the shape, which affect how you will
choose the dimensions and set the member orientation angle [see “Members” in LARSA 4D Reference Manual] later.
It also indicates the meaning of the parameters to enter in the spreadsheet.

When all of the dimensions have been entered, click Import.
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For More Information, please refer to the following documentation.

• Sections in LARSA 4D Reference Manual.

• Members in LARSA 4D Reference Manual.
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Construction Stage Editor

The Construction Stages Editor is used for Staged Construction Analysis to define the order in which a structure is built.

The Construction Stages Editor

The editor is explained in detail in the Staged Construction reference [see “Staged Construction Analysis” in LARSA
4D Reference Manual].

For More Information, please refer to the following documentation.

• Construction Stages Explorer on page 97.
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The Database Editor

The Database Editor is a tool within LARSA 4D to create and edit external LARSA database files.

You can activate the Database Editor from the Input Data  menu under Edit Databases , or you can select the database
in the Connect Databases (page 137) dialog box.

Database Editor View

Creating a Database

When you activate Database Editor, all databases connected to the active project automatically shows up in Databases
and Records Explorer. Use the New Database link at the top-left side of the Database Editor and choose the type of
the database. Currently you can create Moving Load, Time History and Response Spectra databases. Once the new
database is created it will show up on the Databases and Records Explorer on the left.

Adding/Removing Records

To add a new record, click on the database name on the Databases and Records Explorer and click the button with
the plus sign.

To remove an existing record, click on the record on the Databases and Records Explorer and click the button with
the minus sign.
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Adding/Editing/Removing Data

The data spreadsheet should be used to modify the records in the database. Click on the record you would like to edit
from the list on the left. The spreadsheet tab will activate. Use this spreadsheet to insert/remove/edit data. Since this
spreadsheet is like any other spreadsheet in LARSA 4D, you can use almost all menu items to format the spreadsheet.
See Using the Model Spreadsheets (page 53).

Other Data Views

Other than the spreadsheet view, each database may have different types of view options. For example Moving Load
Database records can be edited on the spreadsheet and then can be viewed visually on the next tab called Graphics.
This allows users to easily verify their data. For Time History Curve and Response Spectra Curve databases, Database
Editor will give you the option to view a graph of the data.

Additional Options

Depending on the database type, every record may have some additional options other then the actual data. For example
for a Response Spectra Curve database you can choose to input time vs displacement or frequency vs displacement.

For More Information, please refer to the following documentation.

• For information on how to connect databases to a project, see Connecting Databases on page 137.
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Spreadsheet Formulas

The Apply Formula tool allows the user to enter formulas to compute the value of spreadsheet cells.

Formulas are entered in the Apply Format dialog box, which is accessible by right-clicking the input spreadsheets (page

53). The formula will be used to compute new values for the selected cells in the spreadsheet.

Apply Formula

Unlike the formulas that can be entered directly into spreadsheet cells, formulas entered this way can refer to other
cells in the spreadsheet and can make use of each cell's row index and current value.

Formula
Enter a formula that will evaluate to the desired value for each cell. The formula can make use of a small set of
variables, which are defined below. The special variable x represents the current value of any given cell. Thus,
the default formula x will replace the value of each selected cell in the spreadsheet with the value currently in
the spreadsheet: no change will occur. Some simple example formulas are:

5/2.54 (converts 5 centimeters to inches)
x (leaves spreadsheet cells unchanged)
2*x (multiplies each spreadsheet cell by 2)
-x (changes the sign of the selected cells)
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Variables
The variables available to formulas include:

x
The current value of a cell.

row
The row number of a cell, starting at 0 for the first row in the selected block of cells.

col#
The value in the other columns of the spreadsheet, in the same row as the cell being updated. A list of col#
variables appears in the Apply Formula dialog box.

Functions
The following functions are available to formulas:

• abs, sgn, fix (round toward zero)

• sqr, exp, log

• sin, cos, tan, atn (uses radians)

Some further examples follow.

row (would set a single column of cells to the consecutive numbers starting at 0)
2*col2 (in the Joints spreadsheet, would set the selected cells to have twice the value of the x-coordinate value in the
corresponding row)
col2+col3 (in the Joints spreadsheet, would set the selected cells to have the sum of the x- and y-coordinate values in the
corresponding row)
10+(25-10)*(col4-5)/(15-5) (in the Joints spreadsheet, if the z-coordinates in the selected rows range from 5 to 15, then this
function sets the values of the selected cells to a linear interpolation between 10 and 25 at the position of the corresponding z-
coordinate.)

For More Information, please refer to the following documentation.

• Using the Model Spreadsheets on page 53.
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Templates

New models can be generated automatically with very little effort using built-in templates.

These templates offer special advantages for creating models of structures that can be defined parametrically. In many
cases it is most convenient to start your model with structural models created from a template. The models can then
be modified with using spreadsheets (page 53), graphics (page 29) and explorers (page 87).

This tool can be found on the “Draw” menu under “Templates” .

The following template categories are available:

• Box Girder Bridges of several types

• Cable Bridges, including one- and two-pylon cable-stayed bridges

• Frames, including buildings with and without shell floors

• Plate Models, including barrel and cylindrical shells

• Special Structures, including well foundations

• Trusses of various types

Template Wizard
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Templates have parameters such as length, height, number of cables, section type, material type, etc. Section and
material choices come from the sections and materials already imported in the project, so sections and materials should
be imported first before starting the template wizard.

To use the templates, start the template wizard from the Draw  menu. Choose a template category and click Next.

Template Categories

Next choose from among the available templates in the chosen category. Enter values for each of the parameters, and
click Generate to create the new template geometry.
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Truss Templates

For the box girder bridge models, a Bridge Path Coordinate System [see “Bridge Paths” in LARSA 4D Reference
Manual] can be chosen in which to create the model. This is a quick way to generated curved bridges.
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Running an Analysis

This tool can be found on the “Analysis” menu.

Running an analysis, the core feature of LARSA 4D, takes the structural model you have created and subjects it to
various types of analyses. For more detailed information on how analyses are performed, see the Analysis Reference
[in LARSA 4D Reference Manual].

Selecting an Analysis

Analyses are grouped by type in the Analysis  menu as follows:

• Linear Static and P-Delta Analyses

• Nonlinear Static Analysis

• Nonlinear Plastic Pushover and Collapse

• Eigenvalue (Standard/Stressed) and Response Spectra Analyses

• Time-History (linear/nonlinear) Analysis

• Moving Load and Influence Line/Surface Analysis

• Staged Construction Analysis

A red arrow next to an analysis group indicates which type of analysis was last run for the open project. If no analysis
has been run, the arrow points to the first group.

Selecting one of the analysis groups brings up the analysis dialog box.
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Run an Analysis

Choosing Analysis Options

Each type of analysis within the chosen group will be listed on the left in the Select Analysis Type box. Click the
analysis type desired.

All of the analysis options for the selected type of analysis will be listed on the right. Some analysis types have no
options, while others have many. For descriptions of all analysis options, see the Analysis Reference [in LARSA 4D
Reference Manual].

All analysis types share several common options:

Keep Previous Results
When checked, the LARSA analysis engine will try to hold on to the results of previous analyses when the next
analysis is performed. In some cases, old results cannot be retained.

Perform Quick Integrity Check
Often problems in an analysis are a result of simple mistakes in the model. When this option is checked, a fast
integrity check of the model is performed before the next analysis is run. The check is able to find common
mistakes. It is highly recommended that you leave this option checked.
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Running the Analysis

To run the analysis based on the options you have chosen, click Analyze. The analysis window will appear, showing
the progress of the analysis as it happens. Analysis errors will also be shown in the window.

Click Close to save your analysis options but not perform an analysis.

Click Cancel to discard changes to the analysis options and abort running an analysis.

For More Information, please refer to the following documentation.

• Analysis Reference in LARSA 4D Reference Manual.
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Getting Results

The sections below describe how to access results graphically and numerically.

See Analysis Results Reference [in LARSA 4D Reference Manual] for a detailed description of each result type available
in LARSA.

For More Information, please refer to the following documentation.

• Analysis Results Reference in LARSA 4D Reference Manual.
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Viewing Results Graphically

Most of the results computed by the analysis engine can be viewed graphically, including deformed structure, mode
shapes, member forces/stresses, and shell forces/stresses.

This tool can be found on the “Results” menu under “Graphical” .

Results can be viewed graphically by choosing an item from the graphical results menu or by clicking a graphical
result icon in the toolbar. The icons on the toolbar are the same as those on the menu shown here.

Choosing Graphical Results

173



LARSA 4D User’s Manual

Graphical Results Tool Window

Graphical results are shown for the active result case or are an envelope of the selected result cases. To activate and
select result cases, use the Analysis Results Explorer (page 99).

When graphical results are active, the Graphical Results Options tool window appears near the graphics window. It is
shown to the right. The tool window provides a number of display options. The first button turns animations on and
off. The second button turns on and off incremental results (page 209), and the third turns on and off influence coefficient
view (page 211).

To label points on graphical diagrams, check the Value Labels checkbox at the bottom of the graphics window.

Types of Graphical Results

Deformed Model

Deformed Model Options
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To view the deformed model, select Results > Graphical > Deformed Model .

The Graphics Results Options toolbox will pop up (shown to the right). You can view model deformation
for the selected result case with Force Reactions, Moment Reactions or without any reaction labels.

The scale factor of the deformed model is set in the Analysis Results Explorer (page 99) or in Graphical Results
Options (page 197). In Graphical Results Options (page 197), you can also choose to display the undeformed
structure in a ghosted mode and whether to display member span deflections (which can be very slow for
large models).

See: Joint Displacements [in LARSA 4D Reference Manual], Joint Reactions [in LARSA 4D Reference
Manual] (for reaction labels), Member Displacements [in LARSA 4D Reference Manual] (for span deflection)

Mode Shapes

To view mode shapes, select Results > Graphical > Mode Shapes .

Setting Scale Factor

The scale factor of the mode shapes is set in the Analysis Results Explorer (page 99) or in Graphical Results
Options (page 197). In Graphical Results Options (page 197), you can also choose to display the undeformed
structure in a ghosted mode.

See: Mode Shapes [in LARSA 4D Reference Manual]

Member Forces

To view member forces, select Results > Graphical > Member Forces .

The Graphics Results Options toolbox will allow you to select which direction of forces to view: Axial Fx,
Shear Fy, Shear Fz, Torsion Mx, Moment My, Moment Mz.

The diagram size is set in the Analysis Results Explorer (page 99) or in Graphical Results Options (page 197).
Also in Graphical Results Options (page 197), you can choose whether to display the diagram as a line diagram
or with solid shading, whether to invert the diagrams, and the number of stations along the members to report
forces at.

See: Member Sectional Forces [in LARSA 4D Reference Manual]

Member Stresses

To view member stresses, select Results > Graphical > Member Stresses .

The Graphics Results Options toolbox will allow you to select the location of the stress to view: at the
centroid (P/A), at Stress Point A, at Stress Point B, at Stress Point C, at Stress Point D, the Shear Stress in
Y, the Shear Stress in Z, the Maximum Absolute Stress, the Maximum Tensile Stress, and the Maximum
Compressive Stress.

The diagram size is set in the Analysis Results Explorer (page 99) or in Graphical Results Options (page 197).
Also in Graphical Results Options (page 197), you can choose whether to display the diagram as a line diagram
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or with solid shading, whether to invert the diagrams, and the number of stations along the members to report
forces at.

See: Member Stresses [in LARSA 4D Reference Manual]

Shell Deformation

Shell Deformation Options

To view shell deformations, select Results > Graphical > Shell Deformations .

The Graphics Results Options toolbox (shown to the right) will allow you to select the direction and the
envelope type from the option lists.

Shell deformations are displayed as a contour diagram and are based only on the displacements of the joints.

Contour diagram must be selected in Graphical Results Options (page 197). There, you can choose whether to
display the contour diagram on the deformed position of the shells and how the diagram should be displayed
(lines only, solid shading, or smooth shading).

See: Joint Displacements [in LARSA 4D Reference Manual]

Shell Forces

To view shell forces, select Results > Graphical > Shell Forces .

The Graphics Results Options toolbox will allow you to select the direction of force or moment and the
envelope type from the option lists.

Choose the display mode in Graphical Results Options (page 197). There, you can choose whether to display
forces as a contour diagram or by shading each shell with a color representing the forces on the shell. You
can also choose whether to display the diagram on the deformed position of the shells and how a contour
diagram should be displayed (lines only, solid shading, or smooth shading).

Shell force diagrams are based on the Shell Forces - Averaged at Joints [see “Shell Forces - Internal (On
Center, At Joints, and Averaged)” in LARSA 4D Reference Manual] spreadsheet when the contour diagrams
option is turned on in Graphical Results Options (page 197). When the solid shading option is on, Shell Forces
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on Center [see “Shell Forces - Internal (On Center, At Joints, and Averaged)” in LARSA 4D Reference
Manual] are used.

Shell Stresses

Plate Stresses Options

To view shell stresses, select Results > Graphical > Shell Stresses .

The Graphics Results Options toolbox will allow you to select the stress direction, the stress location (top,
middle, or bottom), and the envelope type .

Choose the display mode in Graphical Results Options (page 197). There, you can choose whether to display
stresses as a contour diagram or by shading each shell with a color representing the stresses on the shell. You
can also choose whether to display the diagram on the deformed position of the shells and how a contour
diagram should be displayed (lines only, solid shading, or smooth shading).

Shell stress diagrams are based on Shell Stresses - Averaged at Joints [see “Shell Stresses (On Center, At
Joints, and Averaged)” in LARSA 4D Reference Manual] when the contour diagrams option is on. The stress
shown at each joint is the average of the stresses that are reported across all of the shell elements connected to
that joint, to smooth out the discontinuities discussed in Shell Stresses (On Center, At Joints, and Averaged)
[in LARSA 4D Reference Manual]. Shell stress diagrams are based on Shell Stresses on Center when the
solid shading option is on.

Stress trajectories can also be viewed on each shell. Each stress trajectory icon indicates the direction and
sign of the principal stresses in each shell. The longer, red line shows the direction of the principal maximum
stress. The shorter, blue, perpendicular line shows the direction of the principal minimum stress. Each line
is either solid for positive (tensile) stress or dashed for negative (compressive) stress. Stress trajectory icons
can be turned on and off in Graphical Results Options (page 197).

Element Yield

To view element yield, choose Results > Graphical > Deformed Model .

The Graphics Results Options toolbox will allow you to select the whether the result will be viewed with
icons for plastic hinges.
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See: Member Yield and Strains [in LARSA 4D Reference Manual]

For More Information, please refer to the following documentation.

• Graphical Results Options on page 197.

• Results Spreadsheets on page 179.

• Analysis Results Reference in LARSA 4D Reference Manual.
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Results Spreadsheets

All analytical results can be viewed in numerical form through LARSA's results spreadsheets.

This tool can be found on the “Results” menu under “Spreadsheets” .

A toolbar for quick access to the results spreadsheet can be activated from View > Toolbars > Numerical Results  menu.

Results Data Toolbar

Selecting Result Cases

Results are reported for selected result cases. Result cases are selected in the Analysis Results Explorer (page 99).

Sorting

Sorting Results Spreadsheets

Result spreadsheets can be sorted according to the values in one, two, or three columns.

This tool can be found on the “Edit” menu under “Sort” .

Select columns on which to sort and the sorting direction. Then click OK.

If Torsion X, Moment Y, and Moment Z are chosen as the sorting columns (in that order), then:

• The rows in the spreadsheet are first sorted according to their torsion values.

• If two or more rows in the spreadsheet have the same torsion values, then those rows are sorted according to
their moment y values.

• If in those rows two or more rows have the same moment y values, then those rows are sorted according to
their moment z values.
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Enveloping

All result spreadsheets can be enveloped by checking the Envelope Selected Result Cases check box above the
spreadsheet. A select box will appear to let you specify the column to envelope for. Select the column from the select
box.

The spreadsheet will show the result data enveloped over that column. The enveloped spreadsheet rows are colored
to differentiate between minimum and maximum. Gray rows, the second row of each pair, always represent the
maximums.

Normally, LARSA will present the result case with the most negative value in the minimum rows and the result case
with the most positive value in the maximum rows. If no result case had a negative value in the enveloped column,
then no data will be displayed in the minimum row. Similarly, if no result case had a positive value in the enveloped
column, then no data will be displayed in the maximum row.

LARSA can also envelope using absolute values. In this case, LARSA will report the result case with the value smallest
in magnitude (ignoring sign) in the minimum row and the case with the value largest in magnitude in the maximum
row. This is not available for influence-based results.

Enveloping Spreadsheet Results

Influence-based results, linear result combinations, and extreme effect groups will not report positive minimums or
negative maximums. When enveloping influence-based results, linear result combinations, or extreme effect groups,
some cells in the results spreadsheets may show up empty. In a minimum row, this indicates that no condition resulted
in a minimum value that was negative. Likewise, in a maximum row, this indicates that no condition resulted in a
maximum value that was positive.

Finding Minimums and Maximums

Select Minimum/Maximum  under Results  menu. Select the result type and the column to find the minimum and
maximum values. Users also have the option to compute using the absolute value. Click Find Min/Max to get the
minimum and maximum values for the specified column. The dialog box will expand to show the results in spreadsheet
format.
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Mode Shape Options

Incremental and Class-Based Partial Cumulative Results

In Staged Construction Analysis, result cases normally report the cumulative effects of loads and other construction
activities on the structure. Check the Incremental check box at the top of the results spreadsheets to see just the
incremental effects of the selected construction step. Sometimes it is important to see the cumulative effects of just
post-tensioning or other types of loads, and for this extraction of partial cumulative results is possible using the drop-
down list of load classes.

For more information, see Incremental and Cumulative Results (page 209).

Other Options

Some features associated with result spreadsheets can be accessed under Edit  menu or by right-clicking the
spreadsheet.

• Sum Selected Cells: Show the summation of the values of the selected cells.

• Create Input Load Case: Creates an input load combination based on result case that resulted in the row
under the cursor.

• Create Result Case: Creates a linear result combination based on the result case that resulted in the row
under the cursor.

For More Information, please refer to the following documentation.

• Viewing Results Graphically on page 173.

• Analysis Results Reference in LARSA 4D Reference Manual.
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Linear Result Combinations

Linear Result Combinations provide the ability to combine result cases after an analysis has completed. Whereas load
combinations combine load cases defined before an analysis, and in a nonlinear analysis account for the nonlinear
effects of combining two load cases, linear result combinations combine result cases after an analysis without the need
to reanalyze the structure, but combine their results linearly (i.e. by simple addition).

Results for these combinations are generated only when they are needed, so creating and editing linear results
combinations are fast operations. In addition, results for linear result combinations are discarded immediately after
they are used, so linear combinations will perform slower than pre-analyzed results, but no extra analysis time or hard
drive space is needed to form the combinations.

This tool can be found on the “Results” menu under “Linear Combination” .

Linear Result Combinations

How They Work

Linear result combinations operate by summing together the results of multiple cases. Factors may be applied to the
cases to achieve a weighted linear combination.

Any type of result case may be used in a linear result combination. Two dead load cases may be combined together,
for instance. Or, one step in a time history analysis can be combined with one position of a load pattern from a moving
load analysis.

Linear result combinations have several additional uses for influence-based results. Because an influence-based result
case has the effect of only one lane's loading, linear result combinations can be used to combine multiple influence-
based cases. The result, a linear combination of linear combinations of influence line data, represents the combined
worst-case effect of multiple lane loadings. Furthermore, influence-based cases can be combined with static or live
load cases for use with design codes.
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Each result case added into a linear result combination has three options: a load factor (default 1.0), a staged
construction extraction method (cumulative (default), incremental, or a load class), and whether the case should be
combined for extreme effects (default no).

Staged Construction Extraction Method
(Incremental Results and Load Class Extraction)

When selecting result cases from a Staged Construction Analysis, it is possible to include either the cumulative results
at the selected step, the incremental results at that step, or the extracted cumulative effects for a particular load class
(page 209) up to that step. For instance, to combine the incremental effects of two result cases, in the Extract Load Class
column, change All to Incremental for both result cases. To create a factored load combination of the effects of different
load classes at a stage, add the result case corresponding to the same time point under consideration multiple times
into the linear combination, and change the Extract Load Class choice for each to a different load class, specifying
factors as appropriate.

A load class can be chosen for the linear result combination as a whole so that the group can be used with the Automatic
Code-Based Load Combinations (page 203) tool. The load class for the combination as a whole does not affet its output
(results).

Combine for Extreme Effects

This option is used with enveloped results only. When this option is checked, the selected result case will be excluded
from the combination if its value in the enveloped column is positive for minimums or negative for maximums.

For example, consider the case of applying dead load, wind load (as a static case), and live load results. Live load
results will always report negative values for the min and positive values for the max. However, dead and wind load
(when analyzed as static cases) will always report the same value for the min and max. It may be either positive or
negative. You may turn on Combine for Extreme Effects on the wind load case so that it is combined for mins only
when its value is negative, and inversely for maximums. If the wind load yields a positive value, it will be omitted from
the mins so that it does not reduce the magnitude of the resulting min. However you might want to turn off Combine
for Extreme Effects for dead load. In this case the dead load will be included in mins and maxes regardless of its sign.
If the sign of the dead load is positive, it will detract from the effect of live load. The reported min might be positive.

Using Linear Result Combinations

To create a linear result combination, go to the Results  and choose Linear Combination .

Select the result cases to be combined from the list on the left and click the right-directed arrow to add them into the
list on the right. Enter any factors, if needed, in the list on the right.

Click OK to create the new case. The new case will add together each of the result cases in the list on the right. The
new case will appear in the Analysis Results Explorer (page 99).

A name for new linear result combination case will be supplied automatically, but the name may be changed if needed.

If a result group (e.g. "Load Combinations", "Moving Load 1") is added into the list on the right, then the worst case
in that group will be used in the linear combination. The worst case is chosen each time a result is requested such that
LARSA always reports the most extreme value.
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To edit a linear result combination after it has been created, find the combination in the Analysis Results Explorer,
right-click it, and then click Properties.

To delete a linear result combination, find the combination in the Analysis Results Explorer, right-click it, and then
click Delete.

Using the Loading Matrix

It is also possible to edit linear result combinations using the Loading Matrix. The Loading Matrix shows a matrix
with columns for each result case analyzed and rows for each linear result combination in the project.

Before using the loading matrix, create and name the linear result combinations you will need, without putting any
result cases actually into the combinations. That is, leave the combinations empty, besides a name.

To get to the Loading Matrix, go to the Results  menu, choose Origanize Cases , and click Edit Matrix .

In the matrix, enter 1, or another factor, to include the result case for that column in the linear combination for that
row. Or, specify a factor of 0 or clear the cell to remove the result case from the combination.

You can also copy and paste the matrix to and from another program, such as Microsoft Excel, using the Edit  menu
in the Loading Matrix window. (Not the main Edit menu of LARSA 4D.)

For More Information, please refer to the following documentation.

• Extreme Effect Groups on page 187.
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Extreme Effect Groups

Extreme effect groups represent the worst-case scenario from a set of result cases, similar to envelopes, but they are
saved as new result cases.

For each row in a results spreadsheet, or each result value plotted graphically, an extreme effect group returns the data
from the one case in the group that had the most negative (when a minimum is being reported) or positive (when a
maximum is being reported) value. Extreme effect groups can only be used when enveloping results.

As with Linear Result Combinations (page 183), results for these combinations are generated only when they are needed,
so creating and editing linear results combinations are fast operations. In addition, results for linear result combinations
are discarded immediately after they are used, so linear combinations will perform slower than pre-analyzed results,
but no extra analysis time or hard drive space is needed to form the combinations.

This tool can be found on the “Results” menu under “Group for Extreme Effect” .

Extreme Effect Groups

How They Work

Extreme effect groups can also be thought of as a "pick one," because only the data from the case with the most extreme
values are shown for any given result value.

Extreme effect groups can only be used when enveloping result data. As with the influence-based results, not all
graphical results are enveloped and so they cannot be used to display extreme effect group results.

Although envelopes of result data can be quickly found by selecting multiple cases in the Analysis Results Explorer
(page 99), the list of cases which make up these on-the-fly envelopes cannot be saved for later use. Furthermore, the data
from those envelopes cannot be used in linear result combinations. Extreme effect groups achieve a similar result but
do not have these limitations.
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Extreme Effect Group Options

Extreme effect groups will usually not return a maximum that is negative or a minimum that is positive. This follows
the definition of extreme effects used in influence-based results and differentiates extreme effect groups from simple
envelopes. However, to allow the reporting of positive minimums and negative maximums, check the option Allow
Positive Minimum and Negative Maximum.

Besides specifying a factor, when selecting result cases from a Staged Construction Analysis, it is possible to group
both the incremental and the cumulative effects for particular load classes (page 209) of separate stages. For instance,
to group the incremental effects of two result cases, in the Extract Load Class column, change All to Incremental for
both result cases.

A load class can be chosen for the group so that the group can be used with the Automatic Code-Based Load
Combinations (page 203) tool.

Using Extreme Effect Groups

To create an extreme effect group, go to the Results  and choose Group for Extreme Effect .

Select the result cases to be grouped from the list on the left and click the right-directed arrow to add them into the list
on the right. Enter any factors, if needed, in the list on the right.

Click OK to create the new case. The new case will add together each of the result cases in the list on the right. The
new case will appear in the Analysis Results Explorer (page 99).

A name for new group will be supplied automatically, but the name may be changed if needed.

To edit an extreme effect group after it has been created, find the combination in the Analysis Results Explorer, right-
click it, and then click Properties.

To delete an extreme effect group, find the combination in the Analysis Results Explorer, right-click it, and then click
Delete.

For More Information, please refer to the following documentation.

• Linear Result Combinations on page 183.
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Graphing Results

Analysis results can be graphed using LARSA's graph feature. Result versus case, result versus time, and result versus
result are all supported.

Graphs are an easy way to see result data graphically. Graphs can be used to show

• The displacement of a joint over time.

• The moment on a member as a truck passes over it.

• The reaction of a joint versus its rotation, over time.

• The stress in a member versus the displacement of its i-joint, over time.

• The difference between joint A's displacement and joint B's displacement versus the forces on joint A, over time.

But LARSA 4D's graphs are not limited to only these few possibilities.

This tool can be found on the “Results” menu under “Graph” .

Graphing Results
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Overview

Data Set
Select from what result data to plot the graph. Graphs can be plotted over the steps in moving-load and
influence-line cases, time-history cases, and construction stages. A data point will be plotted for each case in
the data set.

The x-axis and y-axis of your graph are set up independently. Each axis's parameters are explained below.

Click the Update button at the top of the window to update the graph based on your choices.

X-Axis

X-Axis Parameters

Choose what will be plotted on the x-axis of the graph.

Case Number
The ordinal number of the result case will be plotted on the x-axis. This is generally acceptable when cases are
evenly spaced, such as in a moving-load or time-history analysis.

Distance
The distance of the load patterns applied to the structure from the start of the lane is plotted on the x-axis.
This is only available if the dataset is a moving-load or influence-line case [see “Linear Static Moving Load
Analysis and Dynamic Rolling Stock Analysis” in LARSA 4D Reference Manual].

Time
The time of the case is plotted on the x-axis. This is only available if the dataset is a time-history case [see
“Linear Time History Analysis” in LARSA 4D Reference Manual].

Day
The day number of the case is plotted on the x-axis. This is only available if the dataset is a staged-construction
case.

Result Data
A particular result data from the case will be plotted on the x-axis.
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Result Type
Select the type of result from the first selection box, such as Member End Forces, and then select the particular
result in the second selection box, such as Force -- Z -- At Start Joint.

Data Selection

Then, fill in all of the fields in the next box. If you chose Joint Displacements / Translation -- X, then the next
box will display Joint, indicating you need to enter a joint number. The x-translation displacements of that joint
will be plotted on the x-axis for each case in the data set.

All fields must be filled in.

Invert
Displays the graph mirrored horizontally.

Log Scale
Displays the x-axis on a logarithmic scale.

Y-Axis

Y-Axis Parameters

Choose what will be plotted on the y-axis of the graph. The y-axis is set up similarly to the x-axis, except that only
result data can be plotted on the y-axis.

Invert
Displays the graph flipped vertically.

Log Scale
Displays the y-axis on a logarithmic scale.

Result Type
Select the type of result from the first selection box, such as Member End Forces, and then select the particular
result in the second selection box, such as Force -- Z -- At Start Joint.
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Data Selection

Then, fill in the fields in the next box. If you chose Joint Displacements / Translation -- X, then the next box will
display Joint, indicating you need to enter a joint number. The x-translation displacements of that joint will be
plotted on the y-axis for each case in the data set.

Unlike for the x-axis, you do not need to fill in all of the fields in this box. If a field is left with an asterisk,
then multiple series will be plotted on the graph, one for each possible value of the field. For instance, if you
are plotting member sectional forces, if you enter a member number but leave out a station number, then one
series will be plotted for each station on the member. (The number of computed stations is set up in Graphical
Results Options (page 197).)

Relative To
Check this box to plot values on the y-axis relative to another value. For instance, you may want to plot the x-
translation displacement of joint 1 relative to the same type of displacement of joint 2. (That is, the first value
minus the second value.) Fill in all of the fields in this box to choose what to plot the values relative to. The
same result type as selected above applies to these values.

For More Information, please refer to the following documentation.

• Custom Graphs on page 193.
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Custom Graphs

Any data presented on spreadsheets in LARSA 4D can be graphed using the Custom Graph Tool.

Custom Graph Dialog

Unlike the result graphs (page 189) feature, custom graphs are not aware of the context of the data. The tool expects user
to provide the source spreadsheet, the column and a range of rows to specify the data to be graphed. User may provide
data from different spreadsheets for x and y axis.

Custom Graph Tool is accessible by right-clicking the spreadsheets (page 53).

Spreadsheet
Choose the spreadsheet from which you would like to get the data. The list contains all open spreadsheets in the
application.

at Column
Column number from which the data will be retrieved.

from row #
The tool will graph the data starting from this row.

to row #
Specifies the last data of the graph.
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For More Information, please refer to the following documentation.

• Using the Model Spreadsheets on page 53.

• Graphing Results on page 189.
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Results Units

Results in LARSA are displayed according to the results units selected for the project. The results units used by the
open project can be edited using the Results Units window.

This tool can be found on the “Results” menu under “Units” .

Changing Results Units

The Results Units dialog only applies to numerical results. Model units are selected in the model units window (page 133).

The Results Units dialog is arranged into a simple matrix. The rows represent categories of units:

Displacement
Used for joint displacements and related units.

Forces
Used for units that are related to forces.

Stress
Used for units that are related to stresses.

The units for each category can be independently changed so that, for instance, joint displacements need not
be in the same length units as member section stresses.

The columns of the matrix represent unit types: Length, Force, and Angle. The unit in the cell in the Force column
and Stress row will be used in units that indicate stress.

A unit can be selected for most cells in the matrix. Some cells are gray, such as Displacement/Force, for which unit
selection is not applicable.

Click the Metric or Imperial buttons to immediately change all units to the standard metric or imperial units.
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Click Apply to update the units used to display results. No immediate unit conversion is performed.
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Graphical Results Options

The graphical results display settings control how graphical results are displayed. Display settings can be access by
right-clicking the graphics window.

Graphical Results Settings

This tool can be found on the “Results” menu under “Display Settings” .

Deformed Model and Mode Shapes
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These options control how deformed model and mode shapes are displayed.

Deformed Model Only
Indicates only the deformed position of the structure will be displayed.

Overlay Undeformed Model
Indicates that in addition to the deformed position of the structure, the original position will be displayed
ghosted.

with Member Span Deflections
Indicates that the span deflection of each member will be displayed. For large models, this process can be very
slow. It is recommended that if the graphics drawing time is too much, you should uncheck this option. With
this option unchecked, members are drawn as straight lines between the deformed positions of the joints.

Scaling Factor

These settings can be changed by using the slider at the bottom of the Analysis Results Explorer on the right-hand
side of the screen.

Displacement Magnification
Specifies the magnification factor of the joint displacements used to display deformed model graphically.

Diagram Size
A number between 1 and 20, specifies the size of moment and stress diagrams on the screen. A value of 1
indicates diagrams should be drawn very small, and 20 indicates diagrams should be drawn very large.

Animations

This setting controls how results are animated.

Animation Speed
Determines the rate at which animations proceed. A value of 500ms indicates animations will update every 500
milliseconds, or twice every second.
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Member Force/Moment Diagrams

These settings control how member force and moment diagrams are displayed.

Line Diagram
Indicates force/moment diagrams are displayed as line diagrams, which sometimes make it easier to read the
value labels.

Solid Diagram
Indicates force/moment diagrams are to be filled in according to the color legend on the right-hand side of the
graphics window.

Segments
Indicates how many segments to divide each member into to display the forces/moments. A value of 10 is
usually sufficient, for which 11 data points are drawn. To see a smoother diagram, increase the number of
stations. A greater number of stations means the results will take longer to draw. This option also controls the
number of segments displayed in the spreadsheets.

Shell Force/Stress Diagrams

These settings control how shell force and stress diagrams are displayed.

Solid Shading
Indicates each shell will be filled with the color that corresponds to the average force or stress acting on it.
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Contour Diagram
Indicates a contour diagram will be drawn over the surface of the shells, showing the contours of the forces or
stresses on the shells.

Show on Deformed Model
Indicates the diagram will be displayed on shells in their deformed position. Otherwise, the shells are drawn in
their original position.

Show Stress Trajectories
Indicates stress trajectories will be drawn over each shell. Each stress trajectory arrow indicates the direction of
the maximum principal stress in each shell. A small perpendicular line is also drawn on each shell to show the
direction of the minimum principal stress.

Contour Options
Specifies how a contour diagram of shell forces or stresses is to be displayed. For Style: Lines indicate only
contour lines will be drawn, Solid indicates each contour "bar" will be solid-shaded, and Smooth indicates full-
color shading will be used to show the forces or stresses. Strips specifies the number of contour lines/strips to
draw. More lines means the diagram will be drawn slower, but more precisely.
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Capture Deformed Structure

Creates a new project from the deformed geometry of the open project.

Capture Deformed Structure

The Capture Deformed Geometry tool is used to take the deformation and prestress results of an analysis and create a
new project with joints initially at those deformed coordinates and members initially with those prestresses.

To create a new project based on the deformed model, open the Capture Deformed Structure tool.

This tool can be found on the “Results” menu under “Capture Deformed Structure” .

Result Case
Select the result case from the list on the left from which you want to take the deformations and prestresses.

Member Types
Select which types of members for which prestresses should be captured: Cables, Trusses, and Beams. All three
member types are on by default. Click a member type to not capture those prestresses.

Click OK to create the new project. The open project will be closed. You will be prompted to save your changes if
the project has been modified since it was last saved.
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Automatic Code-Based Load
Combinations

The Auto Load Combinations tool is used to create input load combinations (page 91) and linear result combinations (page

183) according to standard design codes and user defined codes.

This tool can be found on the “Input Data/Results” menu under “Auto Load Combinations” .

Five standard design codes are included with the Auto Load Combinations tool:

• AASHTO-LFD Load Factor Design: TABLE 3.22.1A from Standard Specifications For Highway Bridges,
Sixteenth Edition.

• AASHTO-LFD Service Load: TABLE 3.22.1A from Standard Specifications For Highway Bridges,
Sixteenth Edition.

• AASHTO-LRFD: TABLE 3.4.1-1 - Load Combinations and Load Factors from AASHTO LRFD Bridge
Design Specificatios, Second Edition 1998.

• LRFD 2001: ASCE 7 from Load and Resistance Factor Design, Third Edition.

• Canadian Code: Clause 7, Load and Safety Criterion, Handbook of Steel Construction.

Users can also enter and save their own codes.

A code consists of a set of combinations. Each combination is of a form similar to:
1.2 * (1*Dead + 1.5*Live + 2*Seismic + . . .)

The Auto Load Combinations tool selects existing load cases or result cases in the open project and combines them
based on their Load Class, according to the chosen code.

Some codes have factors that are chosen by the engineer. The Auto Load Combinations tool calls these factors Code
Variables, and they can be set by the user.

Example Use

Take the following setup as an exmaple:

A code specifies these combinations:
Code Combination 1: Dead Load + Live Load

Code Combination 2: Dead Load + Wind Load

Code Combination 3: Live Load + Wind Load

And the user selects to combine these load cases:
Load Case 1 (Load Class = Dead Load)

Load Case 2 (Load Class = Live Load)

Load Case 3 (Load Class = Wind Load)

The Auto Load Combination tool will produce these load combinations:
Load Combination 1: Load Case 1 + Load Case 2
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Load Combination 2: Load Case 1 + Load Case 3

Load Combination 3: Load Case 2 + Load Case 3

Simple Combinations versus Permutations

If in the above example, the user selected two load cases both with Load Class set to Dead Load, the Auto Load
Combinations tool can take one of two routes.

In the simple combination method, code combinations involving dead load will include both dead load cases. For the
above example, if the second dead load case is Load Case 4, then the Auto Load Combinations tool will create these
combinations:
Load Combination 1: Load Case 1 + Load Case 4 + Load Case 2

Load Combination 2: Load Case 1 + Load Case 4 + Load Case 3

Load Combination 3: Load Case 2 + Load Case 3

However, the user might instead want only one dead load case to be in each combination. Using the permutation
method, the Auto Load Combinations tool will create load combinations for all of the possible choices of load cases
to use for each combination. For the above example, it will produce:
Load Combination 1A: Load Case 1 + Load Case 2

Load Combination 1B: Load Case 4 + Load Case 2

Load Combination 2A: Load Case 1 + Load Case 3

Load Combination 2B: Load Case 4 + Load Case 3

Load Combination 3: Load Case 2 + Load Case 3

Similarly, if there is additionally a second live load case Load Case 5, then these load combinations will be produced:
Load Combination 1A: Load Case 1 + Load Case 2

Load Combination 1B: Load Case 4 + Load Case 2

Load Combination 1C: Load Case 1 + Load Case 5

Load Combination 1D: Load Case 4 + Load Case 5

Load Combination 2A: Load Case 1 + Load Case 3

Load Combination 2B: Load Case 4 + Load Case 3

Load Combination 3A: Load Case 2 + Load Case 3

Load Combination 3B: Load Case 5 + Load Case 3

The number of load cases selected per class is not limited to two. Any selection of load cases can be used.
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Using Auto Load Combinations

Auto Load Combiantions

The Design Codes list displays the standard design codes and any user-created codes previously entered. Select a code
from the list.

The code's combinations can be viewed by clicking the View button.

Some codes have factors that can be set by the engineer. The Code Variables spreadsheet contains these factors to be
set. Variables have default values when a code specifies them. Enter values for these variables where needed.
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The list on the lower left displays load cases from the Load Cases Explorer or result cases from the Analysis Results
explorer, depending on whether the tool was opened from the Input Data  or Results  menu.

Choose which load cases/result cases to combine by selecting them from the list on the left and clicking the Add
button.

On top of the factors specified by the design code, factors may be applied to individual load cases as they are used
by the code. A factor of 1.00 indicates not additional user factor is to be applied on top of the code.

If multiple load cases with the same load class have been selected, choose whether simple combinations or
permutations should be used. The difference is explained above.

Click Generate to create the new load combinations or linear result combinations. If this tool is run more than
once, clicking Generate will not delete load cases or result combinations previously created by the tool.

Creating New Codes

User-defined codes can be created and used in the Auto Load Combinations tool.

New is used to create a new user defined design code.

Or, use Copy to create a new user code based on an existing code.

Click Edit to edit a user-defined code.

A window with a spreadsheet will appear. The rows of the spreadsheet are code-based combinations, and the columns
are load classes. For each combination, enter the factor to be used for each load class in the appropriate column. For
load classes not included in the combination, leave the factor as zero.

A factor can be applied to all load classes, on top of any factors specified per class, by entering a factor in the first
factor column.

Factors that must be set by the engineer at the time of generating combinations (code variables) can be entered using
a variable name instead of a numeric factor. Variable names must start with a letter.

User codes are stored in My Documents\LARSA Projects\User Codes  with the file extension code .
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Tendon Results Tools

The tendon results tool visualizes tendon results, including geometry, losses and primary/secondary moments.

This tool can be found on the “Results” menu under “Tendon Results” .

Tendons at Cross-Section

This tool shows all the tendons passing through at the given location of a member on its cross-section. Each tendon
shown inside the cross-section is color coded and matched with the spreadsheet showing tendon forces at this location.

Tendon Cross-Sectional View

Select the tendon from the list box located at the top left side of the window. This will fill in the list of members
located on the path of the selected tendon.

Select the member and the location on that member (start/end) to view.
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All the tendons passing through that location will be shown on the cross-section by its actual local coordinates with
a color code. On the right hand side user can see the each tendon force. Clicking on each row on this list highlights
the selected tendon.

Tendon Forces

This tool graphs short-term and long-term losses along the PT path. The vertical axis shows the force in the tendon.
The horizontal axis shows the distance from the start of the tendon path. Short-term losses are represented in dark red,
and long-term losses are shown in blue.

Primary Moments

This tool shows the primary moments at the end of each selected member graphed according to the members' x-
coordinates. The horizontal axis is the member end x-coordinate, and the vertical axis is the primary moment at that
location.

Secondary Moments

This tool shows the secondary moments at the end of each selected members, graphed according to the members' x-
coordinates, as with the primary moments graph.

For More Information, please refer to the following documentation.

• Tendons in LARSA 4D Reference Manual.

• Tendon Results in LARSA 4D Reference Manual.
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Incremental and Cumulative Results

Incremental results are an option of graphical and numerical results that show the changes to the structure since the
previous construction step. Load class extraction is an option that shows the cumulative effects of particular load
classes, such as creep.

These options are only available for Staged Construction Analysis [in LARSA 4D Reference Manual] results.

Incremental Results

When the Incremental Results option is active, results shown will be the difference between the current step and the
previous step, such as the change in moments between two steps, rather than the cumulative results up to that step.
This is useful for determining how a construction activity affected the model.

Cumulative Results with Load Class Extraction

Sometimes it is important to see the cumulative effects of just post-tensioning or other types of loads. Even if a structure
has been subjected to different types of loads, partial cumulative effects can be reported for particular load classes. If
construction steps have load classes associated with them, then a drop-down list of used load classes appears at the
top of results spreadsheets and in the graphics window.

When Load Class Extraction is used, LARSA will display results representing the cumulative effect of a particular load
class. Load classes include live load, post-tensioning, creep, shrinkage, etc. Load cases may be given a load class from
the Load Cases Explorer (page 91). Autogenerated result cases for time-dependent effect such as creep and shrinkage, and
for post-tensioning, are assigned load classes automatically.

LARSA computes cumulative effects of load classes by summing the incremental results of steps where loads of that
class where applied. (Only one load class can be used in any given step.)

The text View Full Cumulative Results is the normal mode for viewing results. This indicates the option explained
here is not in use. Text such as Extract Creep indicates LARSA is extracting the cumulative effects for only the creep
load class.

Please review the notes about extracting class-based cumulative results when using Support and Hoist Activities [in
LARSA 4D Reference Manual] and deconstructing elements with Construct and Deconstruct Activities [in LARSA 4D
Reference Manual].
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Using Incremental and Cumulative Results

Graphical Results Tool Window

In the graphics window, incremental results is activated by clicking the incremental results button in the Graphical
Results Tool Window. The button's icon is the Greek delta, or a triangle. Click the button again to turn off incremental
results.

Cumulative results is activated by clicking the drop-down menu that reads View Full Cumulative Results. The menu will
not be present if load classes were not used in the model, or if Staged Construction Analysis results are not available.
Choose the load class for which to extract cumulative results.

In the numerical results spreadsheets, incremental results can be turned on by clicking the Incremental Results option.

Cumulative results in the results spreadsheets can be activated by clicking the drop-down list that reads View Full
Cumulative Results and choosing the load class for which to extract cumulative results. To return to normal, full
cumulative results, choose set the option back to View Full Cumulative Results.

Numerical Results Options
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Influence Coefficients Graphical View

Influence Coefficients View provides a graphical representation of the influence coefficients for an influence line or
surface live-load analysis.

When performing an Influence Line & Surface Analysis [in LARSA 4D Reference Manual], influence coefficients are
used to compute the effects of live loads. It is useful to visually inspect the influence coefficients computed by LARSA,
as well as the vehicle positions computed by influence line or surface result cases.

Once influence-based results cases specifying vehicle loads and/or lane loads have been created, use the Influence
Coefficients View to determine what configuration of truck and lane loading was used to compute the effects for a
particular result.

Graphical Results Tool Window

Activate the influence-based result case in the Analysis Results Explorer (page 99) that you want to inspect the results of.
Then turn on the appropriate graphical results (page 173). (LARSA may begin rendering the influence envelope for the
result case. Hit ESC to abort rendering.) Then turn on the Influence Coefficients View by clicking the Influence button
in the Graphical Results Options tool window. Its icon is a small influence graph with axles.

Next, choose the particular result to inspect. For member sectional forces, click on the member to inspect. You will then
be prompted to enter a station, starting at 0 for the start of the member. For shell force and stress results, simply click
on the shell to view and select the type of force or stress from the Graphical Results Options tool window like normal.

LARSA will then display the influence coefficients for that result (i.e. that member station or shell), and on the
coefficients graph it will show the positions of the vehicles that produce the most extreme results. A graph is shown
on top of the lane in blues for maximums, and simultaneously underneath the lane in oranges for minimums. Rotate
the graphics window to see both sides.
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Influence Coefficients View

For More Information, please refer to the following documentation.

• Influence Line & Surface Analysis in LARSA 4D Reference Manual.
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Installing Plugins

Plugins are special programs that attach themselves into LARSA 4D to expand its functionality. All plugins are stored
in files with the ".plugin" extension and they can be downloaded from our website.

Installing Plugins

Plugins Dialog box

Before installing a plugin please make sure that you don't have a previous version of the same plugin already installed.
You can check the list of already installed plugins in plugins dialog box.

To install a new plugin:

• Open the Tools  menu and click Plugins... .

• From the plugins dialog box hit Install.

• Finally, browse to the plugin file you have downloaded from our website and hit Open to activate installation.

Uninstalling Plugins

With every new version, plugins may loose compatibility with LARSA 4D, or there may just be a new version of the
plugin that you would like to use. For both cases you have to download the compatible version of the plugin from the
LARSA website. Before installing the new version, you will have to uninstall the existing one.
To uninstall an existing plugin:

• Open the Tools  menu and click Plugins... .

• Select the name of the plugin from the list and hit Uninstall.

LARSA 4D will have to close down for the changes to take effect. It will not proceed with uninstallation of the plugin
if you have an unsaved active project.
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For More Information, please refer to the following documentation.

• For an overview of plugins, see Creating a Plugin in LARSA 4D Macro Training Manual and Developer’s Guide.
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Code Check and Design Tools

This section is a guide to the code check & design tools in LARSA 4D.

Ultimate Strength Check 219
Preparing the Model 219
Ultimate Strength Computation 219
Using the tool 220

Moment Curvature Analysis 223
Introduction 225

Application Overview 225

Concrete Material Models 229
Steel Material Models 241
Moment-Curvature Analysis Options 247
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Use Section Composer to Create the Section 249
Create the Structural Model using LARSA 4D 254
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Pushover Analysis 260
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Biaxial Interaction Analysis 291
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Biaxial Interaction Analysis Options 299
Concrete Material Models 301
Steel Material Models 303
Biaxial Interaction Analysis Results Options 305

Factoring the Biaxial Interaction Analysis Results 305
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Yield Surface 307
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Using Structure Groups and Spans 377
Code Check 377
Design 378
Graphics 379
AISC-LRFD2000 Design/Code Check 379
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Pier Column Code Check Tool 389
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401
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Ultimate Strength Check

The Ultimate Strength Check tool allows users to compute flexural strength (also known as moment capacity) on
prestressed and/or reinforced concrete or steel structures. Currently, the tool has support for the following codes:
AASHTO LRFD 2006, BS5400, and EN 1992-1-1:2004.

This tool can be used both in LARSA 4D as well as in LARSA Section Composer. In LARSA 4D it can be found in
the Tools  menu and in Section Composer it can be found in the Analysis  menu as Ultimate Strength Check .

The utlimate strength check computes the flexural strength for the section taking into account the placement of
reinforcement bars within the section and, if run from LARSA 4D, post-tensioning tendons running through the section
and either their short-term or long-term forces.

Preparing the Model

If the cross-section is composed of multiple materials, then it must be defined using Section Composer [see “LARSA
Section Composer” in LARSA Section Composer Manual] (see Composite Material Sections [in LARSA Section
Composer Manual]). Reinforcements must be defined on the sections prior to running this tool. For sections created in
Section Composer, the location of rebars is set there (see Reinforcement Bars [in LARSA Section Composer Manual]).
Otherwise, reinforcements can be defined within LARSA 4D: right-click a section in the sections spreadsheet ( Input
Data  → Properties  → Sections ) and click Rebars .

When using this tool in LARSA 4D, a model must be created and run with Staged Construction Analysis [in LARSA
4D Reference Manual]. This will generally consist of at least one construction step assembling the structural elements
and a second construction step stressing any post-tensioning tendons [see “Tendons” in LARSA 4D Reference Manual].
The analysis must be performed before running this tool and a result case must be selected in the Analysis Results
Explorer (page 99) at the time point of interest for the ultimate strength check. If long-term material time effects are not
of interest, select the result case during which the tendons are stressed. Otherwise, you may choose any later post-
tensioning (PT) losses result case to perform the ultimate strength check based on tendon forces after long-term effects
such as relaxation.

When this tool is used in Section Composer, it is not possible to take into account tendons running through the section.
No LARSA 4D model or analysis is needed.

Ultimate Strength Computation

For each station along each member in the model, the tool performs the following procedure: 1) Find the location of
the neutral axis on the cross-section, and 2) Calculate the flexural moment capacity of the cross-section.

The following assumptions are made:

• Plane sections remain plane during deformation.

• The strain in the tendons and reinforcement, whether in tension or compression, is the same as that in the
surrounding concrete.

• The tensile strength of concrete is ignored unless ultimate tensile strain property is provided.

The tool assumes a location for the neutral axis and marks one side of this axis as compression and the other side
as tension. The tip of the compression side is assumed to have the compressive strain Ecu, as provided by the code.
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Using the strain compatibility, with the assumption of plane sections remaining plane, the compressive force in the
compression block is calculated by integrating over the compression zone (by dividing the zone into 200 fibers and)
using the strain at each fiber. Once the magnitude and the location of the compressive force is determined, the tool
goes through each tendon and reinforcement in the cross section to determine the magnitude and the location of the
tension force. If the tensile and compressive force acting on the cross section are equal then the neutral axis is found,
otherwise the tool will assume another location for the neutral axis and repeat this procedure.

The flexural capacity of the cross-section is the moment that is generated by the lever arm between the compressive
and tensile force acting on the cross section.

Using the tool

There are some common input required by all the supported codes.

Ultimate Strength Check

Ecu
Maximum compressive strain at collapse state in concrete. The default values are: 0.003 for AASHTO LRFD
2006 and 0.0035 for BS5400 and EN1992-1-1:2004. User can have LARSA to iterate over a range of Ecu
values and report the maximum capacity found. The range must be entered in the following format: [from

220



LARSA 4D User’s Manual

value]-[to value]:[# of steps]. For example, '0.0028-0.003:10' would mean that the tool will perform 10
iterations between 0.0028 to 0.003 and report the maximum capacity found.

Resistance Factor
The moment capacity can be reduced with this factor.

Use Simplified Rectangular Stress Block
If checked, the tool uses the simplified stress compression stress block as specified in the selected code instead
of integrating over the acual stress block.

Ignore Tendons/Rebars at Compression Zone
Determines how the tool should handle the tendons/rebars that are found in the compression zone of the cross-
section. If checked they will be ignored.

Edit Stress/Strain Models
User needs to define a stress/strain model for the materials. If not defined, the tool will assume Ramberg-
Osgood model for steel and CEBFIP90 model for conrete materials. For more information Stress/Strain Curve
Models [in ]

Iteration Count
Maximum number of iterations to be used by the tool while finding the neutral axis of the section. In most
cases 20 iterations is sufficient.

Force Tolerance
In order to speed up the process a force tolerance can be provided. Force tolerance is used while checking the
equality of tension and compression force acting on the cross section (locating the neutral axis).

The results can be performed at a particular station of a member. In this case a detailed step by step log of the code
check is created. If the code check is performed on the whole structure, the results can be viewed numerically on a
spreadsheet or graphically on a graphics window.

Spreadsheet Report
Choose this tab to have the code check run on the whole model and retrieve the results as summary
numerically.

Graphical Report
Choose this tab to have the code check run on the whole model and retrieve the results as a graphical view.

Detailed Report
Choose this tab to have the code check run for a particular station along a member and retrieve the detailed
code check results.

For More Information, please refer to the following documentation.

• Sections in LARSA 4D Reference Manual.

• Tendons in LARSA 4D Reference Manual.

• Staged Construction Analysis in LARSA 4D Reference Manual.

• LARSA Section Composer in LARSA Section Composer Manual.

• Reinforcement Bars in LARSA Section Composer Manual.
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Introduction

The Moment-Curvature Analysis Tool is used for the analysis and design of beam and column elements near their
moment capacity. The tool can be used to calculate moment capacity for design and to compute plastic hinge properties
for nonlinear pushover analysis.

This tool can be found on the “Design” menu under “Moment Curvature Analysis” .

The tool uses section and material properties, concrete and steel material models, and information about pre-/post-
tensioning and reinforcement bars to compute a moment-curvature curve which relates the moment that a section caries
to its rotational deformation. These curves can be used to determine moment capacity and can be assigned to Sections
[in LARSA 4D Reference Manual] for use in a LARSA 4D nonlinear pushover analysis.

After a moment-curvature analysis is performed in the tool, the generated moment-curvature curves are added to the
open LARSA 4D project as Spring Property Definitions [in LARSA 4D Reference Manual] and are automatically
assigned as moment-curvature curves to the selected section [see “Sections” in LARSA 4D Reference Manual]. Sections
with moment-curvature curves can be used with Members [in LARSA 4D Reference Manual] whose type is set to
Analytical Hinge. See later sections in this part of the manual for examples of the use of moment-curvature curves
in pushover analysis.

Moment-Curvature Curve

(Note: The previous version of the LARSA 4D moment curvature tool can also be found in Design  → Moment
Curvature Analysis (Legacy) .)

Application Overview

The Moment-Curvature Tool has four windows: the main window, the material editor, the rebar and pre-/post-
tensioning editor, and the analysis results window.
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Main Window

Moment-Curvature Analysis Tool Main Window

The main window of the Moment-Curvature Analysis Tool is used to choose the sections that moment-curvature
analysis will be performed on.

Add a row to the Section Analysis Cases table for each section to perform moment curvature analysis on. Enter either
a member ID or select a section in the open project:

• To include pre-/post-tension Tendons [in LARSA 4D Reference Manual] in the moment-curvature analysis
1) enter a member ID into the table and 2) select a result case from the Result case for tendon forces
drop-down menu located at the bottom window. The tendon location and forces in the selected result case
will be used for the Moment-Curvature Analysis. Result cases with tendon force results occur in Staged
Construction Analysis results for construction steps with Tendon Stressing Activities [see “Tendon Stressing
and Slackening Activities” in LARSA 4D Reference Manual] as well as in result cases generated for steel
relaxation in Time-Dependent Staged Construction Analysis (see Time Effects on Materials [in LARSA 4D
Reference Manual]).

• Since Staged Construction Analysis already considers tendons, when a tendon is present in the section, the
moment-curvature curves are not exported to section properties to be used with inelastic elements. Curves
can be generated and assigned to sections by selecting a result case without tendons, or not specifying a
member ID so that the tendons inside the member will not be considered in moment-curvature analysis.

• The Moment-Curvature Analysis tool can be used by selecting a section by name rather than entering a
member ID and without using Staged Construction Analysis results.

• The section selected, or the section of the member selected, is typically created beforehand in LARSA
Section Composer [in LARSA Section Composer Manual].

After entering a member ID or selecting a section, click the Edit Material  button next to the section to enter its material
model parameters (see the next sections on material models). Then click Edit Rebar  next to the section if the section
contains reinforcement bars or pre-/post-tensioning. This information will be automatically read from the section if
entered in Section Composer and from tendon force results if available, as described above. The rebar editor is shown
below.

Choose a moment direction to analyze (the section Y or Z axis, or both) and an axial force or range of axial forces. If
a moment-curvature analysis is desired for a single axial force value, enter it in the Start of Axial Force Range  cell
and leave the other axial force cells empty. Otherwise, use the Start of Axial Force Range , Axial Force Increment ,
and End of Axial Force Range  cells to specify a range of axial force values. A separate moment-curvature analysis
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is performed for each axial force value in the range. For example, enter -1000, 100, and 0 in the three cells to perform
ten moment-curvature analyses at -1000, -900, -800, ... 0.

The moment-curvature analysis is performed by clicking either the Analyze & View Results  button next to each
section or by clicking Analyze All . After the moment-curvature analysis completes, the generated moment-curvature
curves are added to the open LARSA 4D project as Spring Property Definitions [in LARSA 4D Reference Manual] and
are automatically assigned as moment-curvature curves to the selected section [see “Sections” in LARSA 4D Reference
Manual].

Reinforcement Bars and Pre-/Post-Tensioning

Rebars and tendons can be edited by using this window.

Editing Rebars and Tendons

Edit Rebar/Tendon window can be used to get the information of existing rebars, add new rebars and/or tendons, and see
existing tendon data in case of Member ID is given as input and given member has stressed tendons for selected result
case. For rebars coming from Section Composer and tendons coming from LARSA 4D, the fields cannot be modified.

Tendons that are located within the member whose ID is entered on the main window of the Moment-Curvature
Analysis tool are automatically added to the table if a result case is selected from the Result case for tendon forces
drop-down menu. The locations of the tendons within the cross-section and their forces may vary along the length of
the member but are automatically loaded only from the start of the member. However, if the number of tendons within
the member varies along the member, then the tendon locations and forces are taken from either the member's start or
end depending on which has a greater number of tendons.

To add rebar or pre-/post-tensioning, add a row to the table and enter the following:

• For single-shape sections, there is only one piece listed. For composite sections, select the piece that will
contain additional reinforcement.

• Specify the location of the reinforcement relative to the member reference axes (see Members [in LARSA 4D
Reference Manual]).

• Enter the diameter of the rebar or pre-/post-tensioning.

• For rebar, the effective force is entered as zero. For pre-/post-tensioning, enter the force in the tendon.

• Set its material model parameters.
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Moment-Curvature Analysis Results

The results of the moment-curvature analysis can be viewed in the results window.

Analysis Results Window

A moment-curvature curve is computed for each axial force in the range given in the main window. Select an axial
force to see the curve generated for that force.

The chart can show the full moment-curvature curve for both positive and negative bending, just the positive bending
portion, or just the negative bending portion.

Tables for the numerical moment-curvature values computed by the analysis as well as an equivalent idealized bilinear
curve are shown.

By default, the moments are taken about the element local coordinate system or the member reference axes in Section
Composer. Using the dropdown menu on top of the curve grid, another moment-curvature curve can be displayed
where the moments are about the geometric centroid of the section.

228



LARSA 4D User’s Manual

Concrete Material Models

The concrete material models available in the Section Analysis Tools include the Hognestad, Modified Hognestad with
and without softening, Rectangular Stress Block - ACI, Mander confined and unconfined, Hoshikuma, Popovics, IRS/
IRC, and a user-defined custom material model.

When the material model is not specified by the user, the program default depends on the characteristic strength of
the material assigned to the input section. The Hognestad material model is used for fc < 40 MPa (6 ksi), and the
Hoshikuma material model is used for fc > 40 MPa (6 ksi).

Hognestad Concrete Material Model

Hognestad Concrete Material Model

The input parameters are: modulus of elasticity, characteristic strength, crushing strain, and ultimate tensile strain. The
model is suitable for normal-strength concrete.

εc = 2 * fc / E

εcr = 3 * fc / E
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Modified Hognestad Concrete Material Model

Modified Hognestad Concrete Material Model

The input parameters are: modulus of elasticity, characteristic strength, crushing strain, and ultimate tensile strain.
Differently from original Hognestad concrete model, the post-peak behaviour is represented with a linear behaviour
reaching to 85% of the characteristic strength at the crushing strain.
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Modified Hognestad Concrete Material Model with Softening

Modified Hognestad Concrete Material Model with Softening

The Modified Hognestad Concrete Material Model with Softening extends the Modified Hognestad Model beyond
crushing strain with a smooth decrease in stress-carrying capacity to zero. The slope of the extension of the curve is
controlled by the Softening Coefficient which ranges from zero (no softening) to 2, or higher if needed. The material
model is useful to capture post-peak moment capacity decay.
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Rectangular Stress Block - ACI

Rectangular Stress Block - ACI

The rectangular stress block is a simplified concrete material model where strength is constant across strain values. It
is important to conserve both area and center of the exact stress-strain curve to have reliable results. a1 is the ratio of
the strength of concrete to the characteristic stress. beta1 is the ratio of the strain range. The Rectangular Stress Block
of ACI is suitable to represent unconfined behavior of concrete.

232



LARSA 4D User’s Manual

Mander Unconfined Concrete Material Model

Mander Unconfined Concrete Material Model

Mander’s unconfined concrete material model assumes that characteristic strength is reached at characteristic strain, a
gradual decrease until twice the characteristic strain, and a linear decrease to zero strength at the spalling strain.
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Mander Confined Concrete Material Model

Mander Confined Concrete Material Model

Mander’s confined concrete material model is one of the most popular material models due to its capability of
considering lateral pressure provided by transverse reinforcement, i.e. confinement. The curve is similar to the
unconfined model until confinement starts at the characteristic strain and characteristic strength. As confinement starts,
the strength of the material increases according to the confined strength ratio. After reaching the confined strength, the
material is still capable of undergoing more deformation until the crushing strain.
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IRS/IRC Concrete

IRS/IRC Concrete Material Model

Concrete material model as described in Indian Railway Standards (IRS, 2014), which is suitable for unconfined
concrete.
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Hoshikuma Unconfined Concrete Material Model

Hoshikuma Unconfined Concrete Material Model

Hoshikuma concrete material model is suitable for all ranges of concrete having a compressive strength of up to 80
MPa (11.6 ksi). Especially, for high-strength concrete (fc > 40 MPa (6 ksi)), Hoshikuma and Popovics concrete models
are more accurate than Hognestad and Mander concrete models. For the unconfined model, the post-peak behavior
follows the Smith-Young model showing a smooth softening.

εc = 2 * fc / E
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Hoshikuma Confined Concrete Material Model

Hoshikuma Unconfined Concrete Material Model

The Confined Hoshukima concrete model, allows the user to enter lateral pressures to consider confinement. The
characteristic strain and characteristic strength are enhanced according to Kupfer / Richard Model due to confinement.
In the post-peak region, strength capacity linearly decreases to 20% of the peak strength.
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Popovics Concrete Material Model

Popovics Concrete Material Model

The Popovics model was modified by Collins and Porasz to represent the stress-strain behavior of high-strength
concrete better. The model shows a more rapid post-peak decay as the strength of the concrete increases.
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Custom Concrete Material Model

Custom Concrete Material Model

A custom stress-strain curve can be entered. Strains must be in ascending order.

239



LARSA 4D User’s Manual

240



LARSA 4D User’s Manual

Steel Material Models

The steel material models available in the Section Analysis Tools include bilinear, trilinear, prestressed steel, and a
user-defined custom material model.

Bilinear Steel Material Model

Bilinear Steel Material Model

The bilinear steel material model consists of two parts: the linear elastic region defined by the elastic modulus and the
yielded region between the yield stress and the ultimate strain.
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Trilinear Steel Material Model

Trilinear Steel Material Model

The trilinear steel material model consists of three parts: the linear elastic region, the hardening region between the
yield stress and the hardening end strain, and the yielded region from the end of hardening to the ultimate strain.
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Prestressed Steel Material Model

Prestressed Steel Material Model

Prestressing steel stress-strain curve is defined according to ASTM Standard Specification for Low-Relaxation, Seven-
Wire Steel Strand, which is ASTM A 416.
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IRS/IRC Cold Worked Steel Material Model

IRS/IRC Cold Worked Steel Material Model

Stress-strain relation as defined in Indian Railway Standards-Concrete Bridge Code (2014) for cold worked steel.
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Custom Steel Material Model

Custom Steel Material Model

A custom stress-strain curve can be entered. Strains must be in ascending order.
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Moment-Curvature Analysis Options

Several moment-curvature analysis options can be set in the main window.

Moment Curvature Analysis Tool Main Window

Force Balance Ratio
Force Balance Ratio is the convergence criteria for section analysis. As Force Balance Ratio decreases,
the section analysis equilibrates the internal force and external forces more precisely. However, decreasing
Force Balance Ratio after a certain point may cause convergence issues and longer analysis durations.

Refinement
The number of points on the Moment Curvature curve is determined depending on the selected refinement
option (Low: 24 points, Medium: 48 points, High: 96 points).

Maximum Number of Iterations
The maximum number of iterations that can be executed for the calculation of one point on the diagram.

Export curves to the section for inelastic elements and Export Bilinear Curve
The "Export curves to section for inelastic elements" checkbox can be checked to assign generated
moment-curvature curves to input sections. This way, they can be used with inelastic members such as
Hysteretic Beam or Analytical Hinge elements. If the "Export Bilinear Curve" checkbox is also checked,
idealized curves which are computed according to Caltrans Seismic Design Criteria, are exported to the
section. Bilinearization maintains the conservation of energy by equating the area under the analytical
moment-curvature curve and the area under the idealized bilinear moment-curvature curve.
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Example: RC Column Pushover Analysis

In this example, a pushover analysis is performed on a reinforced concrete column with a circular section following
a moment-curvature analysis.

Example Project:  The example described here can be found in the Design folder of your LARSA 4D Samples
directory (generally My Documents\LARSA Projects\Samples) in the file MC01_RC_Pushover.

The model geometry and associated loading is shown in below figure and the analysis steps are summarized next:

Structural Model

• First, the column section is defined in LARSA Section Composer.

• Then, the structural model is created in LARSA 4D.

• After that, the moment curvature analysis is performed in LARSA C-Suite, and output curves are exported to
Analytical Hinge.

• Finally, a staged construction analysis is performed with a pushover analysis scenario.

Use Section Composer to Create the Section

The section definition and rebar is defined in Section Composer. The complete section definition is shown in the
following figure:
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Section

The section will be defined as a composite section of two circular shapes with the rebar placed at the boundary between
the two shapes. Two shapes are used so that different material models (confined and unconfined) can be assigned later.

Open LARSA Section Composer.

In Section  → Units  choose feet and kips as the length and force units.

The outer circular shape will be added first.

In Shape  → Insert Custom Shapes , find Solid Circle  under Basic Shapes . Set “r” to 2. Name the section
“Cover.” Then insert the shape.
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Inserting Custom Shape for Cover Concrete

Now, the confined region of the section will be modeled by inserting a composite subshape within the “Cover” shape.

Right-click the “Cover” shape. Select Insert Composite Subshape  → Composite Subshape from Custom
Shape .

Again, find Solid Circle  under Basic Shapes . Set the radius to 1.83333. Name the section “Confined Region.”

Next, the rebars will be placed inside the section.

Click the Draw Rebars  icon in the Section Composer toolbar.

The Rebar Tool

Select ASTM-#11 as the rebar type, A706 as the material, 24 as the number of rebars. We will place the rebars
inside the confined region's boundary, therefore, add 0.2267 ft as the cover distance, and 1 as the number of
layers. The spacing between rebars should be selected as Fit Around Shape . Then, without closing the window,
left-click on any edge of the “Cover” shape.
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Draw Rebars

Click Close  in the rebar window.

In Section  → Composite Materials , select “Concrete\Fc_4” as the material for both Cover and Confined
Region, and select it as the reference material.

While computing the transformed section properties of composite sections with different materials assigned to shapes,
LARSA do not consider the presence of rebars unless the Include rebar in transformed section properties  option is
turned on. We will proceed with the default option.

Assigning Material to Section
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Under the Section  menu, Move Section Centroid to Member Center  first, and Calculate Section Properties  to
obtain the torsional constant of the section.

Calculate Properties

Use the Section  menu one more time and choose Rename...  to set the name of the section to “RC Column
Section”.

The section and some of its calculated properties should appear as in the figure below:

Final View of Section Composer Window
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Save the section database.

Create the Structural Model using LARSA 4D

We will create a 30 feet tall simple column structure.

Start a new project in LARSA 4D.

Set the units of the project to feet and kips using Input Data  → Units  → Imperial  → Change Labels .

Project Units

Connect the created section database to the LARSA 4D project by using Input Data  → Connect Databases
→ Connect User Database  and select the previously saved section database file containing the “RC Column
Section”.

Go to the main menu, Input Data  → Geometry  → Joints  spreadsheet.

Add three joints to the spreadsheet using the Add Row  tool from the toolbar and set their coordinates as (0, 0,
0), (0, 0, 4) and (0, 0, 30).

Defining Nodes

Restrain the first joint to be fixed in both displacement and rotation in all directions.
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Defining Nodes

In the Members  spreadsheet, add two members using the Add Row  tool. The first member is between joint 1
and joint 2 and the second member is between joint 2 and joint 3.

Set the type of the bottom element to Analytical Hinge  and the other element to Beam . Both members have
the section that is created at Section Composer and the material set to “Fc_4”.

Defining Members

(When the materials of the composite shapes are already entered in Section Composer, it is not necessary to set the
material of a “Beam” element in LARSA 4D. However, a base material is needed in LARSA 4D for an “Analytical
Hinge” element.)

Moment-Curvature Analysis

A moment-curvature analysis is performed next at nine axial force levels from -1500 to 500 kips for moment in both
the y and z directions.

In the selection of the axial force range, 980 kips vertical load coming from the superstructure to the pier was
considered.

Click Design  → Moment Curvature Analysis  to start the Moment-Curvature Analysis Tool.

In the Section column, choose the “RC Column Section” created earlier.
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Select Section

Now, it is time to assign different stress-strain characteristics to the cover and the confined region of concrete section.

Click the button in the Edit Material  column to open the materials window.

Select the Cover shape, then select the Mander Unconfined  material model, and then enter the material
properties as shown in the figure:

Cover Concrete Material

For the Confined Region shape, select the Mander Confined  material model and enter the following properties:
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Confined Concrete Material

For the reinforcement, listed as Cover#A706 in the shape drop-down box, select Bilinear Steel  and make sure
the properties match with the window shown below:

Reinforcing Steel Material

Click Save Materials  to return main window of the tool.
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Set the followings in the main window of section analysis:

• Moment Direction: Both

• Start of Axial Force Range: -1500

• Axial Force Increment: 250

• End of Axial Force Range: 500

Check the "Export curves to section for inelastic elements" checkbox.

Analysis Cases

Click Analyze and View Results  for this section.

The moment-curvature curves will be computed, and then they will be shown in a new window.

Results of different axial loads and different directions can be seen by selecting desired axial load and direction from
the drop-down menus at the analysis case section of the Analysis Results window. Results of -1000 kips axial load
for the Z and Y directions are given below:
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Moment-Curvature Relation for Moment Direction: Z and Axial Force: -1000 kips

Moment-Curvature Relation for Moment Direction: Y and Axial Force: -1000 kips

The computed curves have been added to the LARSA 4D project as spring curves and automatically assigned to the
RC Column Section by the tool.

Close the moment-curvature analysis tool.
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Go to Input Data  → Properties  → Spring Properties  to see the generated moment-curvature curves. Right-
click a curve and choose Edit Curve  to verify that the curve was exported from the moment-curvature analysis
correctly.

The analytical (smooth) curve is added to the LARSA 4D project by default. If Export Bilinear Curve  is chosen in
the moment-curvature analysis settings, idealized curves based on Caltrans Seismic Design Criteria, will be added to
the LARSA 4D project instead.

Change to the Sections  spreadsheet. Right-click on the section and click Moment(z) Curvature  and
Moment(y) Curvature  to see that the curves are correctly assigned to the section.

Pushover Analysis

Load Cases

Two loads will be applied: 1) a 980-kip vertical load representing a hypothetical bridge superstructure and 2) a 1-kip
horizontal load. The loads will be applied to the joint at the top of the column.

In the Load Cases Explorer , create a new load case and name it “Superstructure”.

Double-click the new load case to open its joint loads spreadsheet.

Apply -980 kips to joint 3 in the Z direction.

Add a second load case named “Transverse”.

Open the load spreadsheet for the Transverse case by double-clicking it. Add a joint load on joint 3 with a
magnitude of 1 kip in the Y direction.

Load Cases

Analysis Scenario

A Pushover Analysis will perform a nonlinear pushover analysis for any load cases whose type is Pushover by
increasing the given load. But this will not include the loading in other static load cases. To include other static loading,
Pushover must be used as an analysis scenario within Staged Construction Analysis.

In the Structure Groups Explorer, add a new group that contains the entire structure.

In the Construction Stage Explorer, add a new construction stage (named Stage 1) and create steps named as
“Construction” and “Pushover.”

In the “Construction” step, add the structure group for the entire structure to construct the structure and add the
“Superstructure” load case to apply to hypothetical dead load from bridge superstructure above the column.

In the “Pushover” step, and add the “Transverse” load case.
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Back in the Construction Stages Explorer, right-click on the “Pushover” step, click Properties , and change its
analysis type to Plastic Pushover.

Construction Stages Explorer

Analysis

The Pushover Analysis will apply the “Transverse” load case to the structure at an increasing factor until a stopping
criteria entered by the user or until a point where structure loses its stability.

Go to Analysis  → Staged Construction Analysis . Then open the Pushover Stopping Criteria  tab.

Set the criteria to when joint “3” reaches “3” feet in translation y.

Pushover Analysis Stopping Criteria

Run the analysis.

Analysis Results

After the analysis completes, return to LARSA 4D.

Open Results  → Graphs .
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Change Data Set  to “Stage 1: Pushover.”

Change X-Axis  to Result Data . Select Joint Displacements  and Translation --Y-- (in)  from drop-down
menus and enter 3 as joint.

For Y-Axis, check Invert . Select Joint Reactions  and Force --Y-- (kips)  from drop-down menus and enter 1
as joint.

Click Update .

The results should appear as in the figure below:

Pushover Curve
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Example: PC Section Moment Curvature
Analysis

This example is the continuation of the Example: RC Column Pushover Analysis (page 249), illustrating the moment-
curvature analysis of a prestressed concrete section.

Example Project:  The example described here can be found in the Design folder of your LARSA 4D Samples
directory (generally My Documents\LARSA Projects\Samples) in the file MC02_PC_Moment Curvature.

The model geometry, section, and nonlinear material model parameters are the same as in the example Example: RC
Column Pushover Analysis (page 249).

Moment-Curvature Analysis With Effective Prestressing Force

In order to carry out a moment-curvature analysis of a prestressed section without having tendon objects in the LARSA
4D structural model, the effective prestressing force of tendons can be added to the section by using the Rebar Editor.

Click Design  → Moment Curvature Analysis  to start the Moment-Curvature Analysis Tool.

Make sure the previously created analysis case remains in the tool. If the project was renamed, use Import
button to take it from the previous LARSA 4D project.

Open the Rebar editor by clicking the button in the Edit Rebar  column in the main window of the Moment-
Curvature Analysis Tool.

Edit Rebar

It will show the existing rebar that were added to the section in the Section Composer.
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Rebars from Section Composer

In the last blank row of the table, add a new row by selecting the Piece as Confined Region.

Additional Rebar/Tendon Entry

The coordinates of the rebar or tendon effective force are entered relative to the member reference axes. In our RC
Column Section, the member reference origin is coincident with the centroid, which is where we will place the tendon
force.
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Set the location of the tendon to (0, 0) and its diameter to 1.5 in.

Click the button in the Edit Material  column to set the material properties of the new tendon.

Select material properties as shown in the figure.

Tendon Material Properties

Click Save Materials .

Enter the effective prestressing force as 400 kips.
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Tendon Properties

Click Save Rebars .

Section Analysis Settings

Keep the existing force range and increment, and uncheck Export curves to section for inelastic elements
checkbox.

Analysis Cases

Given that the Staged Construction Analysis incorporates tendons, if a tendon object or prestressing force is present in
the section, the moment-curvature tool restricts the export of curves to inelastic sections to prevent any potential double
counting in finite element analysis. Nevertheless, for design purposes, the tendon objects can be detected from LARSA
4D staged construction model and moment curvature curves can be generated in the tool considering these tendons.

Click Analyze and View Results  for this section.
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The moment-curvature curves will be computed, and then they will be shown in a new window.

Results of different axial loads and different directions can be seen by selecting desired axial load and direction from
the drop-down menus at the analysis case section of the Analysis Results window. Results of -1000 kips axial loads
for Y and Z directions are given below:

Moment-Curvature Relation for MZ and P = -1000 kips
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Moment-Curvature Relation for MY and P = -1000 kips

Moment Curvature Analysis on Member With Tendon

In order to carry out a moment-curvature analysis on members with tendon objects, the analysis results corresponding
to the tendon stressing activity of staged construction should be available in the model.

Create a Tendon

A new tendon object will be created inside the existing reinforced concrete column.

Make sure all column members are selected through the menu, Selection  → Select Objects  → Select All .

Click Draw  → From Selected Members  → Tendon .

The Tendon Editor window will automatically open, showing the location of rebars and tendons along the member
and inside the section.
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Tendon Editor

Close the Tendon Editor.

Setting Tendon Properties

Before stressing the tendon within a staged construction analysis, its properties need to be entered first.

Set the tendon material properties:

Use Input Data  → Materials  to load A992 into project.

Go to Input Data  → Properties  → Materials  → More Properties .

Change the material properties of A992 as listed below:

• Yield Stress: 300000 lb/in 2

• Steel Fu: 370000 lb/in 2

• Tendon GUTS: 370000 lb/in 2
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Tendon Material

Open Input Data  → Geometry  → Tendons .

Set the properties of the tendon as:

• Material: A992

• Strand Area: 0.2523 in2

• # of Strands: 7

• Jacking Force @ Start = 455 kips

• Anchor Set: 0.375 in

• Wobble Coefficient: 0.0002 per ft

Tendon Properties

Stressing the Tendon

We will delete the pushover analysis step of the previous example and add a tendon stressing step.

Left-click the “Pushover” step in the Construction Stages Explorer to activate it, and use the delete button at the
top of the explorer to delete the step.
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Delete Step

In the Construction Stage Explorer, add a new step under Stage 1 and name it as “Stressing”.

Right-click the Stressing step, choose Tendon Activities  and stress the tendon.

Tendon Activities

Run a Staged Construction Analysis so the short-term forces in the tendons can be extracted for the moment-curvature
analysis. (It is also possible to extract long-term forces in a Time-Dependent Staged Construction Analysis.)

Click Analysis  → Staged Construction Analysis . Then, click Analyze  at the new window.

Moment Curvature Analysis

Start the Moment-Curvature Analysis Tool by clicking Design  → Moment Curvature Analysis .

The tendon forces with short-term losses immediately after stressing will be used in the moment-curvature analysis.

Select the “Stage1: Stressing” result case from the Result case for tendon  drop-down menu.
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Enter a member ID to extract the tendon forces and location within cross-section.

Enter the member ID as 1 and change location to End.

Section Analysis Configuration

Next, select Edit Rebar  to see the tendon data.

At the bottom of the rebar list, tendon data should be seen as following:

Rebar Data with LARSA 4D tendon

Since the result case for tendon stressing step is active, tendon data is automatically pulled from LARSA 4D.

Click the Analyze and View Results  button in the first row of the table.
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Moment-Curvature Relation for MZ and P = -1000 kips (With Tendon)

Moment-Curvature Relation for MY and P = -1000 kips (With Tendon)
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Example: Pushover Analysis with Tendons
Assigned to Members

In this example, a concrete pier is modeled with two circular columns and a cap beam connecting them. Tendons
are stressed in the columns within the LARSA 4D Staged Construction Analysis. The Pushover Analysis results are
presented with and without the effect of tendons.

Example Project:  The example described here can be found in the Design folder of your LARSA 4D Samples
directory (generally My Documents\LARSA Projects\Samples) in the file MC03_PC_Pushover.

The section and nonlinear material model parameters are the same as in the example Example: RC Column Pushover
Analysis (page 249).

This example is the continuation of the Example: PC Section Moment Curvature Analysis (page 263) and the final model
with tendon is going to be used as the base model of the current example.

Model
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Prepare the Structural Model using LARSA 4D

Properties

For the modeling of the pier cap, two new sections will be created using LARSA's section spreadsheet.

Go to Input Data  → Properties  → Sections  → Section Dimensions  and add two new rows as following:

Pier Cap Section Definitions

Select the two rows with the mouse, right-click them, and choose Calculate Properties from Shape Parameters .

Geometry

We will copy the existing prestressed concrete column and add the pier cap connecting the two columns.

Choose Draw  → Generation  from the main menu.

Click the Repeated Copy tool, set the options as shown below and click OK  to copy the existing column with
tendon.

276



LARSA 4D User’s Manual

Generation Tool

Open Input Data  → Geometry  → Tendons .

Rename the two tendons as Right Tendon” and Left Tendon”.

Next, we will create two new joints that will define the end points of the cap beam.

Go to Input Data  → Geometry  menu, and add joints as in the below figure.

Cap Beam End Joints

We will complete the geometry by adding the cap beam elements to the model.

Enter the members seen in the figure in the Members  spreadsheet:
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Defining Members

Note the material and orientation angle set for the elements.

In the Member End Offsets  spreadsheet, set the offsets as follows to raise the pier cap so that the top surface of
the pier column remains flat.

Member End Offsets

Use Graphics  → Complete Rendering  to verify the model so far. Then turn off complete rendering with
Graphics  → Simple Rendering . Verified model should be seen as following:
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Model

Make sure all members are selected through the menu, Selection  → Select Objects  → Select All .

In Construction Stages Explorer, right-click “Group 1” and choose Set group to current selection .

Construction Stages

Right-click the “Stressing” step in the Construction Stages Explorer, select Tendon Activities and stress the
copied tendon.

Tendon Activities

Select the existing construction stage, add a new construction step, and rename it as “Pushover” and add the
“Transverse” load case.
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Right-click on the “Pushover” step, choose Properties , and change its analysis type to Plastic Pushover.

Moment-Curvature Analysis

Before running a pushover analysis within the staged construction, we will use Moment Curvature Tool to assign
nonlinear material properties to Analytical Hinge elements at the bottom of the pier columns.

Since Staged Construction Analysis already considers tendons, when a tendon is present in the section, the moment-
curvature curves are not exported to section properties to be used with inelastic elements. We will generate the curves
without specifying a member ID so that the tendons inside the member will not be considered in moment-curvature
analysis. Then, we will perform the staged construction, which considers the material nonlinearity by default and also
solve tendon forces.

Click Design  → Moment Curvature Analysis  to start the Moment-Curvature Analysis Tool.

Make sure the previously created analysis case remains in the tool. If the project was renamed, use Import
button to take it from the previous LARSA 4D project.

We will maintain the same material properties and cross-section as before, but we need to repeat the analysis for a wider
range of axial loads. The existing curves will be overridden with the same output, while new curves are added to the
project to cover additional axial load levels. This adjustment is necessary due to the cap beam's presence, anticipating
increased loads on the columns.

Set the followings in the main window of section analysis:

• Moment Direction: Both

• Start of Axial Force Range: -5000

• Axial Force Increment: 250

• End of Axial Force Range: 2000

Make sure the Export curves to section for inelastic elements  checkbox is checked.

Analysis Cases

Click Analyze and View Results  for this section.

The moment-curvature curves will be computed, and then they will be shown in a new window.
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The computed curves have been added to the LARSA 4D project as spring curves which have been assigned to the
RC Column Section.

Close the moment-curvature analysis tool.

Run Analysis

The Pushover Analysis will apply the “Transverse” load case to the structure at an increasing factor until a stopping
criteria entered by the user or until a point where structure loses its stability.

Go to Analysis  → Staged Construction Analysis . Then open the Pushover Stopping Criteria  tab.

Set the criteria to when joint “3” reaches “3” feet in translation y.

Pushover Analysis Stopping Criteria

Run the analysis.

Analysis Results

After the analysis completes, return to LARSA 4D.

Open Results  → Graphs .

Change Data Set  to “Stage 1: Pushover.”
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Change X-Axis  to Result Data . Select Joint Displacements  and Translation --Y-- (in)  from drop-down
menus and enter joint 3 for right column or joint 6 for left column.

For Y-Axis, check Invert . Select Joint Reactions  and Force --Y-- (kips)  from drop-down menus and enter
joint 1 for right column or joint 4 for left column.

Click Update .

The results for the left and right column should appear as in the figure below:

Pushover Analysis With Tendons

Pushover Curve With Tendons

In Construction Stages Explore, left-click “Stressing” step to activate it, Delete  the step and repeat the analysis
without tendons.

Updated results should appear as in the figure below:
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Pushover Analysis Without Tendons

Pushover Curve Without Tendons
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Pushover Validation with Analytical Hinge

This section presents a validation of the pushover analysis using hand calculations.

Example Project:  The example described here can be found in the Design folder of your
LARSA 4D Samples directory (generally My Documents\LARSA Projects\Samples) in the file
MC04_RC_PushoverValidationBilinearCurve.

The example in Example: RC Column Pushover Analysis (page 249) will be used for performing a validation with hand
calculations.

However, to match the methodology used in the hand calculations, an equivalent bilinear curve will be used in the
LARSA 4D analysis. To store the bilinear curve rather than the analytical curve in the open LARSA 4D project, use
the Export Bilinear Curve  option:

Moment Curvature Analysis Window

As shown in the earlier example, the moment-curvature analysis has the following result:

285



LARSA 4D User’s Manual

Moment Curvature Analysis Result in Z-Direction and under -1000 kips Axial Load

Using the equivalent bilinear curve rather than the analytical curve in the pushover analysis results in the following,
similar pushover curve:

Pushover Curve

Hand Calculation

Results can be validated by a simple hand calculation by comparing two critical points on the curve: the yielding point
and the ultimate point of the pushover curve. The model to be used for hand calculation is given below:
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Analytical Model

Yielding Point

The first part of the pushover curve is linear elastic up to 145.4 kips. Thus, a simple structural analysis with the stiffness
method can be used to obtain a displacement at the yielding point.

Although the same section is used for both members, flexural rigidities differ between elements since the upper element
is a linear elastic beam element and the bottom one is an analytical hinge element. Flexural rigidity of the section for
the linear elastic beam can be directly calculated by using the moment of inertia of the section (12.44 ft4) and the elastic
modulus of the material (for the Fc_4 material, 519,120 kips/ft2), which can be easily found in Section Composer and
LARSA 4D. As a result, flexural rigidity (EIbeam) can be calculated as 6,457,852.8 kips-ft2.

The flexural rigidity of the analytical hinge element (EIhinge) should be calculated by using a different procedure since
the stiffness of the analytical hinge is calculated by using the moment-curvature relation of the section under a certain
axial loading. Flexural rigidity can be obtained from the idealized moment-curvature curve at axial force -1,000 kips
by dividing yielding moment (4,384 kips-ft) by curvature (0.0013 rad/ft), which can be read off the computed moment-
curvature curve shown above. (The section is symmetric so the moment-curvature curve is the same in both the y and
z axes.) As a result, EIhinge is calculated as 3,372,308 kips-ft2.

Since flexural rigidies and member lengths are known, stiffness matrices can be assembled with the following
formulation:

Stiffness Matrix Formulation for Frame Elements

Element stiffness matrices are calculated as:
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Stiffness Matrix of Analytical Hinge

Stiffness Matrix of Linear Elastic Frame

Stiffness matrix of the member can be assembled as following:

Stiffness Matrix of Member

If 145.4 kips of load is applied to tip, force vector becomes:
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Force Vector

Analysis results show that tip displacement is 3.2 inches at 145.4 kips, which is yielding point.
Ultimate Point

Since bottom of the member has reached the plastic capacity, no additional loads can be carried however system can
undergo further deformations. Further deformations can be calculated by calculating the moment of the area of the
curvatures along member with respect to tip of the member.

Plastic Deformations

Yield curvature is 0.0013 rad/ft and ultimate curvature is 0.017 rad/ft under -1,000 kips axial load. By calculating the
area and taking areas moment with respect to tip, plastic tip deformation yields 26 inches.

Comparison

At the previous parts, yield and ultimate points of pushover curves are calculated by using LARSA 4D and by hand
calculation. By drawing the pushover curve data from both sources, following graph is obtained:
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Pushover Curve Comparison
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Introduction

The Biaxial Interaction Analysis Tool uses section and material properties, concrete and steel material models, and
information about pre-/post-tensioning and reinforcement bars to compute a P-My-Mz surface of a section. The three-
dimensional capacity surface of a section can be visualized and be used to check whether demands on a member fall
in the capacity surface.

This tool can be found on the “Design” menu under “Biaxial Interaction Analysis” .

Biaxial Interaction Surface

Application Overview

The Biaxial Interaction Tool has four windows: the main window, the material editor, the rebar and pre-/post-tensioning
editor, and the analysis results window.
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Main Window

Biaxial Interaction Analysis Tool Main Window

The main window of the Biaxial Interaction Analysis Tool is used to choose the sections that biaxial interaction analysis
will be performed on.

Add a row to the Section Analysis Cases table for each section to perform biaxial interaction analysis on. Enter either
a member ID or select a section in the open project:

• The Member ID and Location is used to get the Tendon [see “Tendons” in LARSA 4D Reference Manual]
objects from the selected result case for tendon forces and add them within the section's Rebars list with their
effective force after losses.

• For generating a biaxial capacity surface without considering tendons or using Staged Construction Analysis
results, only the Section can be specified and the Member ID or Location inputs can be skipped.

• The section selected, or the section of the member selected, is typically created beforehand in LARSA
Section Composer [in LARSA Section Composer Manual].

If a member ID is entered, select the Location (either start or end) on the member. Section properties and tendon
locations and forces will be set according to the selected Location. If the member has a stressed tendon, ensure a result
case for tendon forces is selected that has tendon results [see “Tendon Results” in LARSA 4D Reference Manual] for
the member.

Click the Edit Material  button next to the section to enter its material model parameters (see the next sections on
material models). Then click Edit Rebar  next to the section if the section contains reinforcement bars or pre-/post-
tensioning. This information will be automatically read from the section if entered in Section Composer and from
tendon force results if available, as described above.

The biaxial interaction analysis is performed by clicking either the Analyze & View Results  button next to each section
or by clicking Analyze All . After the biaxial interaction analysis completes using Analyze All , Analyze & View
Results  should be clicked to open the Analysis Results Window for a selected case.

Reinforcement Bars and Pre-/Post-Tensioning

Rebars and tendons can be editted by using this window.
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Editing Rebars and Tendons

Edit Rebar/Tendon window can be used to get the information of existing rebars, add new rebars and/or tendons and
see existing tendon data in case of Member ID is given as an input and given member has stressed tendons for selected
result case. For rebars coming from Section Composer and tendons coming from LARSA 4D, the fields cannot be
modified.

Tendons that are located within the member whose ID is entered on the main window of the Biaxial Interaction Analysis
tool are automatically added to the table if a result case with tendon results is selected in the LARSA 4D Analysis
Results Explorer before starting the Biaxial Interaction Analysis Tool (see above).

To add rebar or pre-/post-tensioning, add a row to the table and enter the following:

• For single-shape sections, there is only one piece listed. For composite sections, select the piece that will
contain additional reinforcement.

• Specify the location of the reinforcement relative to the member reference axes (see Members [in LARSA 4D
Reference Manual]).

• Enter the diameter of the rebar or pre-/post-tensioning.

• For rebar, the effective force is entered as zero. For pre-/post-tensioning, enter the force in the tendon.

• Set its material model parameters.

Biaxial Interaction Analysis Results

Results of the biaxial interaction analysis can be viewed in the results window.
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Analysis Results Window

The computed P-My-Mz points can be factored by entering inputs by entering related inputs using the Capacity
Surface  tab in the leftmost panel.

The computed P-My-Mz points are visualized as a three-dimensional capacity surface in the middle panel.

A My-Mz curve at any axial load is visualized in the middle panel. Axial load can be set from either axial force input
or axial force slider.

A P-M curve at any angle through the three-dimensional surface is visualized in the rightmost panel. An angle of 0
degrees displays a P-Mz curve, and an angle of 90 degrees displays a P-My curve. The angle can be set from either
moment direction field or moment direction slider.

If a member ID is entered in the Main Window and analysis results are available, an analysis result case can be selected
from a drop-down menu from which the demand on the member will be determined. In that case, a demand-capacity
ratio is calculated and displayed using the capacity of the section and demand on the member. The demand point is
also shown on both the P-M and My-Mz visualizations. If the demand point falls on the plane of each visualization
(depending on the angle and axial load chosen), its color will be either green (pass) or red (fail) depending on whether
the demand point is within capacity surface. If the demand point does not fall on the plane of the visualization, it is
projected onto the plane and its color will be gray.

Yield Surface

A yield surface can be created from the computed P-My-Mz points using the Yield Surface  tab in the leftmost panel.
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Yield Surface

The created yield surface is assigned to the selected section as a yield surface definition. The entered factors for the
yield surface are used to factor the biaxial interaction analysis points before creating the yield surface.
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Biaxial Interaction Analysis Options

Several biaxial interaction analysis options can be set in the main window.

Biaxial Interaction Analysis Tool Main Window

Refinement
Refinement determines the number of P-My-Mz points computed on the biaxial interaction surface.
Higher refinement increases the smoothness of the three-dimensional surface but increases the duration of
the analysis.

Maximum Number of Iterations
Maximum number of iterations that can be executed for the calculation of one point on the diagram.

Force Balance Ratio
Force Balance Ratio is convergence criteria for section analysis. As Force Balance Ratio decreases, the
section analysis equilibrates the internal force and external forces more precisely. However, decreasing
Force Balance Ratio after a certain point may cause convergence issues and longer analysis durations.
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Concrete Material Models

Concrete material models and the user interface to manipulate them for the Biaxial Interaction Analysis Tool is the
same as the Moment-Curvature Analysis Tool. See Concrete Material Models (page 229).
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Steel Material Models

Steel material models and the user interface to manipulate them for the Biaxial Interaction Analysis Tool is the same
as the Moment-Curvature Analysis Tool. See Steel Material Models (page 241).
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Biaxial Interaction Analysis Results
Options

Factoring the Biaxial Interaction Analysis Results

Two options can be used to factor the biaxial interaction analysis results using the Biaxial Interaction Analysis Results
Form.

Biaxial Interaction Analysis Results

User Defined - Factors

User defined factors are applied to the results
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Maximum Tension Factor

It is possible to cut the capacity surface at a specified limit called the Maximum Tension Factor. The
Maximum Tension Factor is given as a factor between 0 and 1 and is a ratio of ultimate compression capacity.
For example, a Maximum Tension Factor of 0.2 removes the capacity surface beyond 80% of ultimate
tension.

Maximum Compression Factor

It is also possible to cut the capacity surface at a specified limit called the Maximum Compression Factor.
The Maximum Compression Factor is given as a factor between 0 and 1 and is a ratio of ultimate compression
capacity. For example, a Maximum Compression Factor of 0.7 removes the capacity surface beyond 30%
of ultimate compression.

ϕ Factor for Axial Force

A multiplication factor that applies to axial force

ϕ Factor for Moment

A multiplication factor that applies to both My and Mz

AASHTO LRFD (7th - 9th editions)

AASHTO LRFD factors are applied to the results

Rebar Yield Strength

The rebar yield strength option is used to decide the compression and tension strain limits for the
reinforcement. See Table C5.7.2.1.-1 for 7th edition, Table C5.6.2.1-1 for 8thedition and 9th editions.
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Variation of Φ with Net Tensile Strain εt for Nonprestressed
Reinforcement and for Prestressing Steel (Figure C5.5.4.2.1-1 7th edition)

Tension Strain Limit

Tension-controlled strain limit in the extreme tension steel

Compression Strain Limit

Compression-controlled strain limit in the extreme tension steel

ϕ Factor for Compression

The factor corresponds to the compression-controlled strain limit in the extreme tension steel

ϕ Factor for Tension

The factor corresponds to the tension-controlled strain limit in the extreme tension steel

Yield Surface

It is possible to create a yield surface using the computed P-My-Mz points.
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Yield surface

Refinement

The data point count in Capacity Surface is depending on the Refinement selected pre-analysis in the Main
Window. The data point count of Yield Surface is decided depending on both the selected refinement and
the data point count of the Capacity Surface. Selecting one of the high, medium and low options will result
in different data point count depending on the refinement of the Capacity Surface.

The biaxial interaction analysis results can be factored before creating the yield surface by using the factoring options
explained above.

When the Export yield surface ot section for inelastic elements  option is selected before clicking on the Create Yield
Surface  button the created yield surface is assigned to the selected section to be used in determining the behavior of
inelastic hysteretic members.
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Example: RC Column Bent with Cyclic
Load

In this example, a reinforced concrete structure with circular columns connected by a beam is analyzed under cyclic
loading conditions. The nonlinear response of the system is simulated using both moment curvature and yield surface
definitions assigned to the nonlinear elements. To capture the nonlinear behavior, a nonlinear time history analysis is
conducted, comparing the responses of both approaches under cyclic loads.

Example Project:  The example described here can be found in the Design folder of your LARSA 4D Samples
directory (generally My Documents\LARSA Projects\Samples) in the file BI02_RC_ColumnBent.

The model geometry is the same as in the moment-curvature analysis example Example: Pushover Analysis with
Tendons Assigned to Members (page 275), but in this case there are no tendons in the columns. The column section and
nonlinear material model parameters are the same as in the moment-curvature analysis example Example: RC Column
Pushover Analysis (page 249).

Structural Model
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Prepare the Model

Geometry

In this example, displacement loads are applied to the top of the columns as horizontal loads. For this reason, unlike
the model geometry in the referenced example, the top joints of the columns are restrained in the loading direction.

Fix the top joints of the columns in the loading direction (Translation y).

Defining Supports

Other model features are the same as the referenced example.

Cyclic Displacement Load

Two loads will be applied to the top joint of each column: 1) a 980-kip vertical load (static) representing a hypothetical
bridge superstructure and 2) a cyclic displacement load in the horizontal direction.

Before defining load cases, displacement time history curve will be created.

Click Input Data  → Edit Databases .

Click New Database  at the top left of the page and select New Time History Curves Database .

Click +  and enter the displacement history as shown.

Displacement Time History Database

Note that Y-Axis is set to Displacement .
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Click Graph  to see the time history load graphically.

Displacement Time History Graph

Change the name of the curve to “Displacement_History”.

Click Save Database  and save the file. Then close the Database Editor.

More information for adding database can be found in The Database Editor (page 159).

Click Input Data  → Connect Databases  → Connect User Database  and select the new time history database.

Load Cases

In the load cases explorer, two load cases called “Superstructure” and “Transverse” are created:

Load Cases
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Double-click the "Superstructure" load case and add a -980 kips load to joints 3 and 6 (the top joints of the
columns) in the Global Z direction.

Vertical Joint Loads

The transverse load case will have a time history load involving cyclic displacement in the Global Y direction.

Right-click the “Transverse” load case and click Properties . Change Type  to Time History. Then click OK .

Properties of Transverse Load Case

Open the load spreadsheet for the "Transverse" load case by double-clicking it.

Click the Time History  tab in the spreadsheet.

Add the “Displacement_History” load for the same joints in the translation Y direction.

Transverse Loads
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Analysis Scenario

Nonlinear Time History Analysis will be performed. To include the loading in the static load case Superstructure, the
time history analysis will be run as an analysis scenario within Staged Construction Analysis.

For the analysis scenario definition, follow the steps in Example: RC Column Pushover Analysis (page 249).

Construction Stages

The only difference is the analysis type of the step in which the Transverse load is applied. Here, it is Nonlinear Time
History Analysis instead of Pushover Analysis.

In the Construction Stages Explorer, right-click the “Time History” step and click Properties . Change the
analysis type to Nonlinear Time History.

Define Analysis Type

Cyclic Loading with Moment Curvature Analysis

Moment-Curvature Analysis

First, a moment-curvature analysis is performed for axial force from -5000 to 2000 kips and for moment in both the
y and z directions.

Go to Design  → C-Suite  → Moment Curvature Analysis  to start the Moment Curvature Analysis Tool.

Set the analysis parameters as shown.
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Moment Curvature Analysis Window

The nonlinear material model parameters are the same as in the moment-curvature analysis example Example: RC
Column Pushover Analysis (page 249).

Click Analyze and View Results  for this section after setting the material properties.

The moment-curvature curves will be computed, and they will be shown in a new window. The computed curves have
been exported to the LARSA 4D project as spring curves which have been assigned to RC Column Section.

Nonlinear Time History Analysis

Go to Analysis  → Staged Construction Analysis . Set Solution Convergence  parameters:

Solution Convergence

Open Time History Options  and set the analysis options:
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Time History Options

Run the analysis.

Analysis Results

After the analysis is complete, return to LARSA 4D.

Open Results  → Graphs .

Change Data Set  to “Stage 1: Time History.”

Change X-Axis  to Result Data . Select Joint Displacements  and Translation --Y-- (ft)  from drop-down
menus and enter 3 as joint.

For Y-Axis, check Invert . Select Joint Reactions  and Force --Y-- (kips)  from drop-down menus and enter 1
as joint.

Click Update .

The results should appear as in the figure below:
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Force Displacement Curve

Cyclic Loading with Yield Surface

Next, the same structure will be solved by using the yield surface definition (instead of moment-curvature curves) for
the nonlinear elements. Therefore, biaxial interaction analysis will be performed, and the yield surface will be assigned
to the nonlinear elements.

Removing Moment-Curvature Properties

Before starting, the moment-curvature curves are deleted from the model.

Right click on RC Column Section and click Moment(y) Curvature .
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Remove Moment Curvature Curves from Section

Delete all the moment-curvature curve assignments.

Repeat the same for Moment(z) Curvature .

Moment-curvature curves should also be deleted from spring properties.

Go to Input Data  → Properties  → Spring Properties  and delete all the moment-curvature curves, and then
close the spreadsheet.

Remove Moment Curvature Curves from Spring Properties

Set Post-Yield Stiffness

There will be another change in the material properties to set the post-yield stiffness to be similar to the moment-
curvature curves. The post-yield portion of the moment-curvature curve for an axial load of -1000 is nearly horizontal:
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Moment Curvature Curve for -1000 kips Axial Load

To simulate similar behavior in the analysis with the yield surface definition, we set a small value for the post-yield
stiffness ratio.

In Properties  → Materials  → More Properties , set the post-yield to initial slope ratio to 0.006.

Material Properties Update

Biaxial Interaction Analysis

Click Design  → C-Suite  → Biaxial Interaction Analysis  to start the Biaxial Interaction Analysis Tool.

In the Section column, choose RC Column Section.

Set the analysis parameters as shown:
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Biaxial Interaction Analysis Window

Assign the nonlinear material model parameters to the cover concrete and confined concrete shapes and the
reinforcement steel of the section. The material properties are the same as in the prior Moment Curvature
analysis.

Click Analysis and View Results .

Biaxial Interaction Analysis Results Window

In this example, AASHTO LRFD 9th Edition parameters will be used instead of User Defined Factors. According to
the Rebar Yield Strength parameter, other factors are automatically filled by the tool. Only the maximum compression
factor can be set by the user.

Change the Design Code  to AASHTO LRFD (7th – 9th edition) from the drop-down menu.
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Capacity Surface

Click Yield Surface  and change Design Code  to AASHTO LRFD (7th – 9th edition).

Select Refinement as High .

Turn on Export yield surface to section for inelastic elements  to assign the yield surface to the inelastic
elements in the next step.

Click Create Yield Surface . Now the yield surface has been created and exported to the section.

Yield Surface

Close the Biaxial Interaction Analysis Tool. Go to Input Data  → Properties  → Sections  to see the generated
yield surface.

Right click RC Column Section and choose Edit Yield Surface  to see that the generated yield surface has been
assigned to the section. Then close the spreadsheet.

320



LARSA 4D User’s Manual

Yield Surface Data

Nonlinear Time History Analysis

Nonlinear Time History Analysis within Staged Construction Analysis will be run again.

Run the analysis using the same procedure as before.

Analysis Results

After the analysis is complete, return to LARSA 4D.

Open Results  → Graphs  and enter the same inputs as in the previous analysis.

The results should appear as in the figure below:

Force Displacement Curve
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Comparison

The following figure shows the force-displacement relations of the left and right columns due to cyclic loading using
1) moment-curvature analysis and 2) a yield surface.

Both approaches find similar load capacities. However, since hysteretic behavior cannot be defined in the moment-
curvature approach, the separation of the loading and unloading paths can only be observed in the time history analysis
using the yield surface approach.

Force Displacement
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Example: Three Bay Frame Column
Sections Biaxial Interaction Analysis

In this example a Staged Construction Analysis is performed on a three bay and one storey structure with tendons. After
the analysis, biaxial interaction analysis will be performed on sections of members to investigate Biaxial Interaction
Analysis Tool.

Example Project:  The example described here can be found in the Design folder of your LARSA 4D Samples
directory (generally My Documents\LARSA Projects\Samples) in the file BI01_ThreeBayFrame.

Use Section Composer to Create the Section

The section is defined in Section Composer. The complete section definition is shown in the following figure:

Section

The section will be defined as a composite section with a circular shape and rebars placed with a clear cover.
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Open LARSA Section Composer.

In Section  → Units  choose feet and kips as the length and force units.

In Section  → Rename  rename the section as "CircularSection".

The circular shape will be added first.

In Shape  → Insert Custom Shapes , find Solid Circle  under Basic Shapes .

Set “r” to 2 and name the section as “Cover”. Then insert the shape by clicking Add .

Inserting Custom Shape Cover Concrete

Click the Draw Rebars  icon in the Section Composer toolbar.

Rebar Tool Icon

Select ASTM-#11 as the rebar type, A706 as the material, 24 as number of rebars, 0.2 ft as the cover distance,
and 1 as the number of layers. The spacing between rebars should be selected as Fit Around Shape . Then,
without closing the window, click on the edge between points 7 and 8.
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Rebar Tool

The rebar will be placed in the section.

Click Close  in the rebar window.

Next, the confined region of the section will be modeled by inserting a composite subshape within the “Cover” shape.

Right-click the “Cover” shape. Select Insert Composite Subshape  → Composite Subshape from Custom
Shape .

Again, find Solid Circle  under Basic Shapes . Set the radius to 1.83333. Name the section “Confined Region.”

In Section  → Composite Materials , select “Concrete\Fc_4” as the material for both Cover and Confined
Region, and select it as the reference material.
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Assigning Material to Section

Move the centroid of the section to be at the member reference line using Section  → Move Section Centroid
to Member Center .

Calculate torsional constant by clicking Section  → Calculate Section Properties .

The section and some of its calculated properties should appear as in the figure below:
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Final View of Section Composer Window

Save the section database from File  → Save Database  with name sections.lpsx.

Create the Structural Model using LARSA 4D

We will create a simple 2D frame structure with three bays (20 ft width, each) and one storey (15 ft height). The
columns at the edges of the frame will include prestressing tendons.

Start a new project in LARSA 4D.

Set the units of the project to feet and kips using Input Data  → Units  → Imperial  → Change Labels .

Add universal restraints by using Input Data  → Universal Restraints  to restrain translation in Y direction and
rotations in X and Z directions.
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Universal Restraints

Properties

Connect the created section database to the LARSA 4D project by using Input Data  → Connect Databases  →
Connect User Database  and select the saved section file, which is sections.lpsx.

Let's create a new rectangular section to be used with members that will represent beams.

Go to Input Data  → Properties  and switch to Sections  tab.

Parametric section that has just been created should be available in the spreadsheet. A new rectangular section will
be added.

In the Sections  tab, switch to Section Dimensions  from Properties . Add a new row. Name of the section will
be RectangularSection. Change shape to Rectangle from Unspecified. Set both depth and width to 12 inches.
After setting dimensions, switch back to Properties  tab. Right-click the row of the RectangularSection and
click Calculate Properties .

Sections

Next, we will add a material for the tendon and set its Guaranteed Ultimate Tensile Strength (GUTS) property.

Use Input Data  → Materials  to load A992 into project.
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Including A992

Go to Input Data  → Properties  → Materials  → More Properties .

Set GUTS property of A992 to 256000 lb/in2.

Setting Tendons GUTS

Geometry

Add joints in the Input Data  → Geometry  → Joints  spreadsheet. Coordinates and support conditions should
be as follows:

329



LARSA 4D User’s Manual

Joints

In the Members  spreadsheet create seven members. Four members will be vertical members representing
columns and three members will be horizontal members representing beams. The joint connectivy and sections
of members are as follows:

Members

After defining members, tendons can be defined to the outer columns.

In the graphics window, unselect everyting from Selection  → Unselect Objects  → Unselect All . Then select
member 1, which is the leftmost column.

Click Draw  → From Selected Member  → Tendon . The tendon editor will be opened which shows the drawn
tendon.
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Switch to Tendons  tab from Geometry Point  tab to rename tendon. Rename tendon as LeftTendon.

Tendon Editor

Close the tendon editor.

Once again, unselect all selected objects and then select member 4, the rightmost column.

Click Draw  → From Selected Member  → Tendon . Tendon editor will be opened which shows the drawn
tendon.

Switch to Tendons  tab from Geometry Point  tab to rename tendon. Rename tendon as RightTendon.
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Tendon Editor

Close the tendon editor.

The next step is setting the properties of the tendons.

Go to Input Data  → Geometry  → Tendons .

For both tendons do the following instructions:

• Change Material to A992

• Change the Strand Area to 0.2523 in2

• Change the # of Strands to 7

• Change the Jacking Force @ Start to 400 kips

• Change the Anchor Set to 0.35 in

• Change the Wobble Coefficient to 0.0002 per ft

Tendon Spreadsheet
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Before running an analysis, it is important to break up long member elements into small pieces. Displacements are
computed only at the locations of joints in the model, so it is necessary to put joints at intermediate locations on each
span or column. We will use the Break Members tool to break the existing member into smaller pieces.

Go to Modify  → Break Members .

Enter 5 for the number of segments and then click OK .

The resulting geometry will be as follows:

Structure Geometry

Load Cases

Two load cases will be defined. First of two will represent a gravitiy load and the second one will represent a lateral load.

In the Load Cases Explorer, add a new load case. Rename new load case to “Vertical”.

Double-click on the new load case.

In the Joint Loads  spreadsheet, add -1000 kips loads in the Z direction to joints 6 and 7.

Vertical Joint Loads
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Back in the Load Cases Explorer , add a new load case. Rename new load case to “Horizontal”.

Double-click on the new load case. In the Joint Loads  spreadsheet, add a 1500 kips load in the X direction to
joint 5.

Horizontal Joint Load

Close the spreadsheet.

Stages Construction Analysis

The structure will be built in four steps. In the first step, the elements will be constructed. Tendons will be prestressed
in the second step. In the third step, self-weight (gravity) load will be applied. The last step will be the one where
lateral load will be applied. A single structure group will be used that includes all of the elements in the structure.

Select all member elements in the model.

Open the Structure Groups Explorer. Add a new group and name it Structure.

Open the Construction Stages Explorer and add a new stage.

Change name of the step 1 to “Construction”.

Drag the “Structure” from Structure Groups Explorer and drop it on to the “Construction” step in Construction
Stages Exlorer.

Add a new step to Stage 1 in the Construction Stages Explorer. Rename it to “Prestressing”.

Right-click the “Prestressing” step, choose to add Tendon Activities, and stress the tendons as follows:

Stressing Tendons
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Add two new steps to the stage and name them as “Gravity” and “Lateral”.

Drag the “Vertical” and “Horizontal” loads from the Load Cases Explorer, then drop them on to the “Gravity”
and “Lateral” construction steps respectively.

The final view of the construction sequence should be as follows:

Construction Stages

Go to Analysis  → Staged Construction Analysis , and click the Analyze  button.
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Staged Construction Analysis Window

Biaxial Interaction Analysis Tool

Staged Construction Analysis should be completed successfully. Now, the biaxial interaction surfaces of the section
can be investigated and the demand-capacity ratio can be calculated.

Go to Design  → Biaxial Interaction Analysis  to open the Biaxial Interaction Analysis tool.

Select "Stage 1: Prestressing" result case for the Result case for tendon forces .

For generating a biaxial capacity surface without considering tendons, only the Section can be specified and the
Member ID or Location inputs can be skipped. On the other hand, the Member ID and Location should be specified
to get the tendon objects from the active staged construction analysis result case, list them within the section's Rebars
and select their material model.
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Main Window without Analysis Cases

Two analysis cases will be examined. The first analysis case will be an outer column with the tendon, and the second
analysis case will be an inner column without tendons.

In the blank row, type 8 into the Member ID column. Member 8 is the second segment from the bottom of the
leftmost column.

Active result case is Prestressing, where tendon inside Member 8 is active. It can be verified by clicking Edit Rebar
button for the analysis case and checking the presence of the tendon.

Tendon location and force for the section of member 8

As expected, tendon information is available at the very bottom of the rebar list.
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Click the button in the Edit Material  column and make sure the Prestressing Steel material model is selected
for the tendon.

Tendon Material Model

Click Save Materials  and close the rebars window by clicking Save Rebars. .

In the new blank row, type 3 into the Member ID column. Member 3 is the right-hand inner column.

Entering a member ID will automatically get the section that is related with the member at the specified location. The
locations of two cases can be left as Start.

Main Window with Analysis Cases
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Same section at different analysis cases can have different rebars, in addition to rebars coming from Section Composer
which always exist for the same section at different analysis cases. This flexibility is essential since a section can be
used with different members and some of those members can have tendons. However, materials of a section are same
among different analysis cases for practical purposes. Thus, changing material properties of a section in an analysis
case result in changing material properties of same section in different analysis cases. As a result, there is no effort
needed for updating materials of same section in different analysis cases.

Now, it is time to assign different material properties to cover concrete and confined region of the section.

Click the button in the Edit Material  column to open the materials window.

Select the Cover shape, then select the Mander Unconfined  material model, and then enter the material
properties as shown in the figure:

Cover Concrete Material

For the Confined Region shape, select the Mander Confined  material model and enter the following properties:
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Confined Concrete Material

For the reinforcement, listed as Cover#A706 in the shape drop-down box, select Bilinear Steel  and enter the
following properties:

Reinforcing Steel Material

Click Save Materials  to return main window of the tool.
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After material models and rebars are checked, analysis settings should be set.

Force-Balance Ratio is a convergence criteria for iterations of section analysis routines. Maximum Number of Iterations
sets an upper-bound for number of iterations for calculation of each point of biaxial interaction surface. Finally,
Refinement adjusts the number of points for biaxial interaction surface.

Keep the default settings and click Analyze All  to analyze both cases.

Progress Form

After analyses are complete, results can be checked.

Click Analyze and View Results  next to the first analysis case to see the results of the section with the tendon.

Change the Demand Point by choosing the Prestressing result case from the drop-down menu at the top of the
middle panel.

Biaxial Result of Section with Tendon, Prestressing Load Case

The moment demand for the Lateral load case will be higher.
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Switch to the Stage 1: Lateral result case.

The demand values will be taken from the Lateral result case. However, note that tendon forces will still be taken from
the Prestress result case because it was the active result case when the tool was opened.

Biaxial Result of Section with Tendon, Lateral Load Case

Since demand increased dramatically, the demand-capacity ratio exceeds 1 and the section fails. Thus, the demand
point is now shown in red.

Close the results window by clicking Close .

Click the Analyze and View Results  button for the second analysis case.

Choose the Prestressing result case to extract the demand values from that case using the drop-down box at the
top left.

Biaxial Result of Section without Tendon, Prestressing Load Case
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The moment demand for the Lateral load case will be higher.

Switch to the Stage 1: Lateral result case.

Biaxial Result of Section without Tendon, Lateral Load Case
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Moment Curvature Analysis (Legacy
Tool)

This page documents the legacy moment curvature analysis tool. See Moment Curvature Analysis (page 223) for
documentation for the current tool. The Moment Curvature Analysis tool allows users to perform moment curvature
analysis on cross-sections, capable of taking prestressing/post tensioning and reinforcements into account. Currently,
the tool has support for the following codes: AASHTO LRFD 2006, BS5400, and EN 1992-1-1:2004.

This tool can be used both in LARSA 4D as well as in LARSA Section Composer. In LARSA 4D it can be found in
the Tools  menu and in Section Composer it can be found in the Analysis  menu as Moment Curvature Analysis .

The moment curvature analysis takes into account the placement of reinforcement bars within the section and, if run
from LARSA 4D, post-tensioning tendons running through the section and either their short-term or long-term forces.

Preparing the Model

If the cross-section is composed of multiple materials, then it must be defined using Section Composer [see “LARSA
Section Composer” in LARSA Section Composer Manual] (see Composite Material Sections [in LARSA Section
Composer Manual]). Reinforcements must be defined on the sections prior to running this tool. For sections created in
Section Composer, the location of rebars is set there (see Reinforcement Bars [in LARSA Section Composer Manual]).
Otherwise, reinforcements can be defined within LARSA 4D: right-click a section in the sections spreadsheet ( Input
Data  → Properties  → Sections ) and click Rebars .

When using this tool in LARSA 4D, a model must be created and run with Staged Construction Analysis [in LARSA
4D Reference Manual]. This will generally consist of at least one construction step assembling the structural elements
and a second construction step stressing any post-tensioning tendons [see “Tendons” in LARSA 4D Reference Manual].
The analysis must be performed before running this tool and a result case must be selected in the Analysis Results
Explorer (page 99) at the time point of interest for the moment curvature analysis. If long-term material time effects are
not of interest, select the result case during which the tendons are stressed. Otherwise, you may choose any later post-
tensioning (PT) losses result case to perform the moment curvature analysis based on tendon forces after long-term
effects such as relaxation.

When this tool is used in Section Composer, it is not possible to take into account tendons running through the section.
No LARSA 4D model or analysis is needed.

How Results Are Used

The Moment curvature Analysis tool computes a moment-curvature graph for many values of axial force. Each
generated graph is stored as a moment curvature type spring property [see “Spring Property Definitions” in LARSA
4D Reference Manual] (see Input Data  → Properties  → Spring Properties ) and automatically assigned to the
corresponding section [see “Sections” in LARSA 4D Reference Manual]. You can right click on a section in the sections
spreadsheet ( Input Data  → Properties  → Sections ) and click Moment Curvature  to see the curve assignments.
These sections can then be assigned to member elements [see “Members” in LARSA 4D Reference Manual] with type
set to hysteretic for nonlinear inelastic analysis.
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Computation

For each section selected under moment curvature settings, the tool finds the location of the neutral axis on the section
for each axial force specified.

The following assumptions are made:

• Plane sections remain plane during deformation.

• The strain in the tendons and reinforcement, whether in tension or compression, is the same as that in the
surrounding concrete.

The step by step procedure employed by the tool is described as follows:

• For each selected section under moment curvature settings, start applying axial force on the section based on
the start/end axial force and increment specified.

• At each axial force increment, apply a sequence of strain values (let's call it ecu, starting from 0.0001 to
0.004 with an increment of 0.0001) at the tip of the compression side of the section.

• At each application of strain to the tip of the section, go into an iterative procedure to find the location of the
neutral axis.

• The iterative procedure of locating the neutral axis works as follows: The tool assumes a location for
the neutral axis and marks one side of this axis as compression and the other side as tension. The tip of
the compression side is assumed to have the applied strain ecu. Using the strain compatibility, with the
assumption of plane sections remaining plane, the compressive force in the compression block is calculated
by integrating over the compression zone (by splitting the zone into 200 fibers) using the strain at each fiber.
Once the magnitude and the location of the compressive force is determined, the tool goes through a similar
procedure for the tension zone, this time including each tendon and reinforcement in the cross section to
determine the magnitude and the location of the tension force. If the tensile and compressive force acting on
the cross section are equal then the neutral axis is found, otherwise the tool will assume another location for
the neutral axis and repeat this procedure.

• The moment capacity of the cross-section is the moment that is generated by the lever arm between the
compressive and tensile force acting on the cross section.

• The curvature is the strain applied to the tip of the compression zone divided by the distance of the tip of the
compressio zone to the neutral axis.

• For each assumed strain, we find a point (moment, curvature) on the moment curvature curve. The tool will
generate a different curve for each axial force.

Using the Tool

There are some common input required by all the supported codes.
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Moment Curvature Analysis

Resistance Factor
The moment capacity can be reduced with this factor.

Use Simplified Rectangular Stress Block
If checked, the tool uses the simplified stress compression stress block as specified in the selected code instead
of integrating over the acual stress block.

Ignore Tendons/Rebars at Compression Zone
Determines how the tool should handle the tendons/rebars that are found in the compression zone of the cross-
section. If checked they will be ignored.

Edit Stress/Strain Models
User needs to define a stress/strain model for the materials. If not defined, the tool will assume Ramberg-
Osgood model for steel and CEBFIP90 model for conrete materials. For more information Stress/Strain Curve
Models [in ]

Start/End Axial Force
The tool creates a moment curvature curve for a set of axial force values. The tool starts from the 'Start Axial
Force' and loop with the increment specified up to 'End Axial Force'.
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Iteration Count
Maximum number of iterations to be used by the tool while finding the neutral axis of the section. In most
cases 20 iterations is sufficient.

Force Tolerance
In order to speed up the process a force tolerance can be provided. Force tolerance is used while checking the
equality of tension and compression force acting on the cross section (locating the neutral axis).

At the end of the analysis a report window pops up displaying the moment curvature curves and the numerical details
of the analysis.

For More Information, please refer to the following documentation.

• Sections in LARSA 4D Reference Manual.

• Tendons in LARSA 4D Reference Manual.

• Staged Construction Analysis in LARSA 4D Reference Manual.

• LARSA Section Composer in LARSA Section Composer Manual.

• Reinforcement Bars in LARSA Section Composer Manual.
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Guide to AASHTO LRFD Section 3.6:
Live Loads

Live load analysis is usually performed using LARSA 4D’s influence line or surface analysis. The influence line
method is appropriate for bridges modeled as girders (without a deck modeled with shell elements). Vehicles take
straight or curved paths along a series of beams. The influence surface method is appropriate for bridges with decks
modeled with shell elements. For more information on influence analysis, see Influence Line & Surface Analysis [in
LARSA 4D Reference Manual]. For steel I-girder, box girder, and tub girder bridges, the Steel Bridge Module [in
LARSA 4D Manual for the Steel Bridge Module] can be used to set up some of this information automatically.

For step-by-step instructions, please also see the bridge training manuals [see “Training Manuals and Tutorials” in ].
This page is intended as a reference.

Each article within AASHTO LRFD Section 3.6 Live Loads is listed below with notes on how it is to be incorporated
into LARSA 4D models by the user.

3.6.1 Gravity Loads: LL and PL - Overview

3.6.1.1 Vehicular Live Load

3.6.1.1.1 Number of Design Lanes

Steel Bridge Module

The standard design lane width of 12 feet will be used. The number of design lanes will be computed
automatically by fitting the maximum number of design lanes within the width of the roadway surface.

Influence Lines
When there are multiple design lanes in an influence line model, a separate influence line result case must
be created by the user for each design lane. The transverse offset field of the influence line result case
(shown in the figure below) can be used to create design lanes at locations other than the location of the
defined lane [see “Lanes” in LARSA 4D Reference Manual]. Thus, the user is responsible for determining
the number of and placement of each design lane. The rest of this section assumes the user has set up the
correct number of design lanes.

Influence Surfaces

The user is responsible for entering the design lane width (usually 12 feet) but the number of design lanes
will be computed automatically during influence analysis by fitting the maximum number of design lanes
within the width of the roadway surface. The input field for the design lane width is in the General Options
tab. It is shown in the figure below.
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General Influence Analysis Options

3.6.1.1.2 Multiple Presence of Live Load

Steel Bridge Module

Multiple presence factors will be accounted for automatically in the vehicular loading case. Pedestrian
loading will not count toward the number of loaded lanes.

Influence Lines

When using influence lines, multiple presence factors cannot be handled by LARSA 4D automatically.
Rather, when the results of separate influence lines for each design lane are combined into linear result
combinations, appropriate load factors can be used. However, in entering the load factors no opportunity is
given to vary the load factor by the number of lanes which contribute to the extreme effect. Thus, full use
of multiple presence factors will involve creating a) a linear result combination for each lane individually,
applying a factor of 1.2, b) a linear result combination for each pair of lanes with a factor of 1.0 to each lane,
c) a linear combination for each group of three lanes with a factor of 0.85, etc.

Influence Surfaces

During influence surface analysis, LARSA 4D will determine the most extreme placement of design lanes.
Multiple presence factors can be specified by clicking the Edit  button for Multiple Presence Factors. They
will be applied when determining the number of design lanes to include on the roadway surface. In the
multiple presence factors window, enter as rows (1, 1.20), (2, 1.00), (3, 0.85), (4, 0.65) as shown in the figure.
If more than four lanes are loaded, the last factor (0.65) will be used.
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Multiple Presence Factors for Influence Surfaces

Multiple presence factors are, if entered by the user or set by the Steel Bridge Module, in effect regardless of whether
the user intends to obtain results for limit states or other conditions where multiple presence factors are not used. In
these cases, multiple presence factors must be removed.

3.6.1.2 Design Vehicular Live Load

3.6.1.2.1 General

The code specifies that loads should be applied within 10 feet transversely within a lane. This is specified as vehicle
margins and UDL width, as explained in the notes for article 3.6.1.3.1.

3.6.1.2.2 Design Truck

The design truck is preconfigured in the moving load database named “AASHTO Vehicle Patterns.dml” which is
included with LARSA 4D. The vehicle pattern includes a variable rear axle spacing which in influence line & surface
analysis is used to produce the most extreme effect. The dynamic load allowance is not included in the vehicle pattern.
It must be set in the Factor field of the influence options.

Steel Bridge Module & Influence Surfaces
The vehicle pattern named “HL-93/HS20-44 2D Design Truck” is used. This is a truck pattern with point
loads specified for each wheel, and as such has the correct width to control the appropriate transverse
location of the vehicle within a design lane. The distance between the wheel centerline and the design lane
edge is specified as the Design Lane Vehicle Margin, explained below in the notes for article 3.6.1.3.1.

Influence Lines
The vehicle pattern named “HL-93/HS20-44 Design Truck” is used. This is a truck pattern with point
loads specified for each axle, rather than each wheel.

The configuration of the vehicle load patterns is discussed further below.
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3.6.1.2.3 Design Tandem

The design tandem is preconfigured in the same moving load database as the design truck, named “AASHTO Vehicle
Patterns.dml” which is included with LARSA 4D. The dynamic load allowance is not included in the vehicle pattern.
It must be set in the Factor field of the influence options.

Steel Bridge Module & Influence Surfaces
The vehicle pattern named “HL-93 Design Tandem 2D” is used. This is a load pattern with point loads
specified for each wheel, and as such has the correct width to control the appropriate transverse location of
the vehicle within a design lane.

Influence Lines
The vehicle pattern named “HL-93 Design Tandem” is used. This is a truck pattern with point loads
specified for each axle, rather than each wheel.

The configuration of the vehicle load patterns is discussed further below.

3.6.1.2.4 Lane Load

The design lane load (“UDL”) is included by specifying the magnitude of the lane load (0.64 kip/ft) in the influence
options. The lane load is only applied at locations where it contributes to the extreme effect (regardless of the extreme
effects option).

Steel Bridge Module
The magnitude and transverse width of the lane load will be set automatically.

Influence Lines/Surfaces

The magnitude (0.64 kip/ft) and for influence surfaces transverse width (10 ft) of the UDL must be entered
by the user. These options are located on the Uniform/Patch Loading  tab and are named Load Magnitude
and UDL Width. The Simple loading mode is used, which creates patch loading.

Lane Load Options

3.6.1.2.5 Tire Contact Area

Tire contact area is treated as a point load at the center of the contact area.
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3.6.1.2.6 Distribution of Wheel Loads Through Earth Fill

There are no options for this article.

3.6.1.3 Application of Design Vehicular Live Load

3.6.1.3.1 General

There are three load conditions specified in this article: design tandem + lane load, design truck + lane load, and two
design trucks + lane load both factored to 90%.

Starting with LARSA 4D 7.6 it is possible to combine these three conditions into a single influence result case as three
design lane alternatives. In other words, for each design lane on the bridge, one of the three loading conditions is chosen.

General Options

The following options are set on the General Options  tab:

Influence Coefficients
This option chooses the set of analyzed influence coefficients to use, meaning the roadway surface and the
direction of loading.

Design Lane Width
Usually 12 feet. As noted in the notes for 3.6.1.1.1, this is entered by the user and other values may be
required as the code specifies.

Multiple Presence Factors (influence surface analysis only)
See the notes for 3.6.1.1.2. The code calls for the values (1, 1.20), (2, 1.00), (3, 0.85), (4, 0.65). Because
an influence line loads a single design lane, multiple presence factors are not applicable for influence lines.

Transverse Offset (influence line analysis only)
This is the offset of the design lane from the position of the lane definition. The direction of the offset
depends on several factors including the orientation of the members making up the girder. Be sure that the
sign is correct on this field by inspecting the results.

Uniform/Patch Loading Settings

The following options are set on the Uniform/Patch Loading  tab:

Load Magnitude
0.64 kip/ft

UDL Width Per Design Lane (influence surface analysis only)
10 feet.

Default Values

The following options should be kept at their default values:

Load For Extreme Force Effects
Yes (default).
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Overturning Effect Factors
See the notes for article 3.6.3, overturning effect.

Longitudinal Factors
None.

Coefficients Are Signless
No (default).

Vehicular Loading

For vehicular loading, create three Lane Types by clicking Add Lane Type  three times. Each lane type represents a
loading condition. Each lane type should be configured as follows:

Lane Type 1
Add a single vehicle of type “HL-93/HS20-44 2D Design Truck” for influence surfaces, “HL-93/HS20-44
Design Truck” for influence lines. Factor: 1.33.

Lane Type 2
Add a single vehicle of type “HL-93 Design Tandem 2D” for influence surfaces, “HL-93 Design Tandem”
for influence lines. Factor: 1.33.

Lane Type 3
Add two vehicles of type “HL-93/HS20-44 2D Design Truck” for influence surfaces, “HL-93/HS20-44
Design Truck” for influence lines. Factor: 1.197 (1.33 times 0.9). UDL Factor: 0.9.

Some common parameters apply to all three conditions:

Design Lane Vehicle Margin
2 ft, in general. This is the distance between the wheel centerline and the design lane edge.

Min. Back-to-Front Spacing
50 feet.

Max Lanes
No Limit

Permit Loading in Influence Surfaces

Permit vehicular loading, which limits the permit vehicular load pattern to appearing on at most a certain number
of design lanes and at certain locations, can be included in influence analysis. This also applies to special loading
conditions such as light rail.

To add a permit vehicle, click the Add Lane Type  button and add the permit vehicle in this additional lane type. Set
the Max Lanes field to the maximum number of lanes that may apply the permit vehicle, usually 1 or 2.

If the permit vehicle lane is restricted to certain transverse locations, specify the Lane Transverse Constraints. Enter the
minimum location of the start/negative edge of the permit vehicle lane measured from the start/negative transverse side
of the surface, and/or the maximum location of the end/positive edge of the permit vehicle lane from the end/positive
transverse side of the surface. This applies to influence surfaces only and is available starting in LARSA 4D 7.7.
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3.6.1.3.2 Loading for Optional Live Load Deflection Evaluation

If this section is invoked, an influence analysis should be set up with the options described below in two additional
result cases. They are not set up automatically by the Steel Bridge Module.

The options as described in the notes above for article 3.6.1.3.1 apply here, with the following exceptions:

The design tandem and two truck loading configurations do not apply. They should be removed.

The design truck case should be revised to use a vehicle factor of 0.3325 (1.33 dynamic load allowance times 0.25
factor).

A new loading configuration should be created similar to the design truck configuration but with a 1.33 vehicle load
factor and a 0.0 UDL load factor.

Articles 3.6.1.3.3-3.6.1.7

3.6.1.3.3 Design Loads for Decks, Deck Systems, and the Top Slabs of Box Culverts

If load conditions are desired for this article which are different from those described above, the user will need to
revise the influence options as needed.

3.6.1.3.4 Deck Overhang Load

The optional provision of using a uniform load is not used.

Horizontal loads for vehicle collision are not included.

3.6.1.4 Fatigue Load

For the consideration of fatigue load, the user will need to revise the influence options accordingly. The dynamic
load allowance will need to be revised according to article 3.6.2. See the notes for article 3.6.1.3.1. This is handled
automatically by the Steel Bridge Module by creating an additional influence surface and live load case for fatigue.
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LL Fatigue Case

3.6.1.5 Rail Transit Load

This article is not taken into account specifically by LARSA 4D. Any required loading can be modeled using LARSA
4D’s many features.

3.6.1.6 Pedestrian Loads

Steel Bridge Module
Pedestrian loading will be created automatically on the sidewalks as shell uniform pressure loading and
will be combined with the vehicular live load using a linear result combination.

Without the Steel Bridge Module
Pedestrian loading must be modeled by the user as static loads. As pressure loads on shell elements, they
will have a magnitude of .075 kip/ft^2. They can be combined with results from influence analysis using
linear result combinations. They may be alternatively modeled as a lane type within the influence result
case, in which case they will be considered for multiple presence factors.

3.6.1.7 Loads on Railings

This article is not taken into account specifically by LARSA 4D. Any required loading can be modeled using LARSA
4D’s many features.

3.6.2 Dynamic Load Allowance: IM

The dynamic load allowance has been mentioned previously (see the notes for article 3.6.1.3.1 and 3.6.1.4). It is
generally applied as an influence analysis vehicle factor.
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3.6.3 Centrifugal Forces: CE

Centrifugal forces can be modeled independently or together with the associated vehicle loading in the vertical
direction. In other words, the influence coefficients and result cases for live load vertical and centrifugal force effects
can be separated for the extreme results or can be combined to report their concurrent effect.

In both cases, the lane [see “Lanes” in LARSA 4D Reference Manual] should be set up with an offset that places the
lane/surface geometry 6 feet above the roadway, resulting in an overturning moment in addition to the radial force as
required by the design code. Typically this would mean changing the Z Reference of lane definition to Reference Line
and specifying an offset equal to the distance from the shell element centroid to 6 feet above the roadway surface. This
will not affect the vertical load if the offset is in the same local direction as the load, and the same lane/surface geometry
can typically be used for vertical, centrifugal, and braking force cases. (The overturning effect can alternatively be
taken into account by specifying overturning effect factors in the General Options  tab instead of offsetting the lane
6 feet above the roadway surface. Both methods must not be used together. See Influence Analysis Overview and
Options [in LARSA 4D Reference Manual].)

LL Centrifugal Case Only

When modeling the centrifugal force individually, the vehicular loading cases are defined exactly in parallel to the
vertical loading cases given in article 3.6.1.3.1 (and discussed above) except for the following:

• A separate set of influence coefficients must be generated with loading in the transverse direction, and the
corresponding influence surface must be selected in the influence line/surface result case options.

• Instead of the vehicle impact factor, the results should be scaled by the centrifugal force factor C=fv2/gR

Influence Coefficients for Centrifugal Force Only

If the direction of the influence load [see “Influence Loads” in LARSA 4D Reference Manual] is "Centrifugal", the
C Factor is computed and applied automatically. If the direction is "local +/-y" or "Lane +Y", the sign of C Factor
to be applied can be determined by inspecting the direction of loading for the influence coefficients. Although the
load direction is often shell local +y, what is important is which transverse direction it is relative to the bridge layout.
If the shells are oriented with their local x-axis forward and their local z-axis up, their local y-axis will match the
bridge layout’s +transverse direction following the right hand rule. A centrifugal load in this direction corresponds to a
clockwise turn (i.e. a negative rotation about the elevation axis following the right hand rule). If the bridge is turning in
this direction and the influence load is as described, then use a positive sign for C. If the bridge is turning in a counter-
clockwise (or positive rotation) direction and the influence load is as described, then use a negative sign for C.

If the bridge has a single radius of curvature, then C can be entered into either the Vehicle Factor or Overall Factor field.
If the bridge has several turns, multiple factors can be entered into the Longitudinal Factors spreadsheet in the influence
line/surface result case options. Each curve should have two rows. The first row gives the starting station number (from
the start of the lane) of the curve and the C value at the start of the curve. The second row gives the ending station
number of the curve and the C value at the end of the curve (usually the same as at the start). It is possible, although
usually not necessary, to specify different C values at the start and end of a segment if the curvature is non-circular.
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Steel Bridge Module

The Steel Bridge module automatically offsets the lane/surface definition 6ft above the roadway and analyzes the
centrifugal and vertical force effects of vehicular loading simultaneously:

• A single set of influence coefficients is generated for vertical and centrifugal directions. The influence load
[see “Influence Loads” in LARSA 4D Reference Manual] in the Centrifugal direction is factored by the ratio
of the f factor to the impact factor (f = 1 for fatigue and 4/3 for other load combinations).

• A single influence-based result case is created with the same settings and factors as those given in article
3.6.1.3.1 and discussed above.

Influence Coefficients - Vehicular

Combined Cases

3.6.4 Braking Force: BR

For braking forces, additional vehicular loading conditions must be created in a manner similar to the design truck
and design tandem cases described in the notes for article 3.6.1.3.1. The primary difference is that in order to model
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braking force, a separate set of influence coefficients must be generated with loading in the lane/surface longitudinal
direction and these coefficients must be selected in the influence case.

The Steel Bridge Module will create the influence cases described below automatically. Otherwise, the user must set
them up manually.

The braking force is to be taken in whichever longitudinal direction yields the most extreme effect. On a multiple-lane
bridge, for instance, the most extreme effect may be caused by vehicles moving in different directions on each lane.

Because of the assumption of linearity in an influence analysis, separate influence coefficients do not necessarily need
to be generated for forward (+) and reverse vehicle (-) motion. The assumption of linearity says that the effect of a
vehicle traveling left to right will be the inverse (negative) of the effect of the vehicle traveling right to left.

The braking force loading cases are created as follows:

Lane Definition

The code calls for the load to be placed 6 feet above the roadway surface, resulting in a moment in addition
to the longitudinal force. The lane [see “Lanes” in LARSA 4D Reference Manual] should be set up with an
offset that places the lane geometry itself at the location where the braking force should be applied. Typically
this would mean changing the Z Reference to Reference Line and specifying an offset equal to the distance
from the shell element centroid to 6 feet above the roadway surface. This will not affect the vertical load
if the offset is in the same local direction as the load, and the same lane/surface geometry can typically be
used for vertical, centrifugal, and braking force cases.

Influence Coefficients

A separate set of influence coefficients must be generated with loading in the lane/surface longitudinal
direction. Besides the creation of a new load case to generate braking coefficients, these coefficients must
be selected in the influence line/surface result case options instead of the vertical coefficients.

Influence Coefficients for Braking

Multiple Directions of Traffic

The influence coefficients can be treated as unsigned so that each vehicle (in fact, each wheel) is considered
to be acting in whichever longitudinal direction has the greater effect. In this case, the influence results will
show the same value (but the opposite sign) for the minimums and maximums. Use the Coefficients are
Signless  option on the General Options  tab.

Single Known Direction of Traffic

On a bridge with a single direction of traffic, the influence coefficients should be generated or factored
according to the direction of vehicle traffic, and the Coefficients are Signless  option should be off.
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Vehicular Loading Options

The braking force condition should be set up in a similar manner as in the notes for section 3.6.1.3.1 above. In particular,
the design lane width, multiple presence factors, transverse offset, UDL magnitude, and UDL width should be set the
same way. The design lane types should be set as follows:

Lane Type 1
Add a single vehicle of type “HL-93/HS20-44 2D Design Truck” for influence surfaces, “HL-93/HS20-44
Design Truck” for influence lines, with Factor: 0.25. UDL Factor: 0.

Lane Type 2
Add a single vehicle of type “HL-93 Design Tandem 2D” for influence surfaces, “HL-93 Design Tandem”
for influence lines, with Factor: 0.25. UDL Factor: 0

Lane Type 3
Vehicle same as Lane Type 1, with Factor: 0.05. UDL Factor: 0.05.

Lane Type 4
Vehicle same as Lane Type 2 with Factor: 0.05. UDL Factor: 0.05.

LL Braking Case

3.6.5 Vehicle Collision Force: CT

This article is not taken into account specifically by LARSA 4D. Any required loading can be modeled using LARSA
4D’s many features.

For More Information, please refer to the following documentation.

• Influence Line & Surface Analysis in LARSA 4D Reference Manual.
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• Lanes in LARSA 4D Reference Manual.
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Guide to Indian Roads Congress (IRC)
Live Load

The design requirements for live load in the Indian Roads Congress (IRC) design code can be entered into LARSA 4D.

To place vehicular loadings to the critical positions along many possibilities considering different spacing requirements
of different vehicles, a single influence-based result case can be generated. The influence algorithm creates envelopes
by considering all options entered in the influence-based result case and finds the critical load positions. The setup
presented below applies to all roadway widths greater than 5.3 m according to IRC requirements.

For a detailed explanation of the options of Influence-Based Result Cases, please see Influence Analysis Overview
and Options [in LARSA 4D Reference Manual]

Creating an Influence-based Result Case

The first step is connecting the vehicle database for IRC vehicles.

Go Input Data  → Connect Databases...  → Connect Standard Database . From the directory, “C:\Program
Files (x86)\Larsa 2000\Data” , select the vehicle database, “IRC Load Patterns.dml” .

Open an empty influence-based result case in Results  → Influence Line/Surface Case .

Influence-based result case has been developed to have special options for design codes.

For the IRC application, select the Mode  of the result case as “IRC” .

General Options
Select the related influence coefficients group in the General Options  tab.

In IRC:6-2017 Article 204.1.3 it is required that all the axles of a unit of vehicles shall be considered as acting
simultaneously in a position causing maximum stresses. To comply with this requirement uncheck the Load for
Extreme Force Effects  and check the Complete Patterns Only  checkboxes in the General Options  tab.

According to the IRC:6-2017 Article 205, there should be a reduction in the longitudinal effect on bridges having more
than two traffic lanes due to the low probability that all lanes will be subjected to the characteristic loads simultaneously.
Multiple Presence Factors  can be used to comply with this requirement.

The given congestion factor by the code can be entered as Overall Factor  to the result case in the General Options  tab.

Vehicular Loading Options
Switch to the Vehicular Loading  tab to create lane types.

Per IRC when the roadway width is greater than 5.3 m, both Class A vehicles and Class 70R vehicles can be placed on
the roadway simultaneously. These vehicles have different spacing requirements for positioning on the defined surface.
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This example will continue by showing the simultaneous placement of the “Class A” vehicle and the “Class 70R
Wheeled” vehicle on the surface. In the example setup, the “Class 70R Wheeled” vehicle can be replaced with the
“Class 70R Tracked” vehicle, the “Class AA Wheeled” vehicle, or the “Class AA Tracked” vehicle by entering
requirements special for each vehicle. Instead of replacing, these vehicles can be added to the described influence-
based result case as a new lane type with their requirements to consider the case where different lanes are loaded with
vehicles from different classes, tracked vehicles, or wheeled vehicles simultaneously.

The reference loading for the example influence-based result case according to IRC:6-2017 can be seen in the figure
below.

Reference Loading Per IRC:6 - 2017

Class A Train Vehicle Options
Click on Add Lane Type  to create a lane. Then select "IRC Class A Train" from the Vehicle Load Pattern  list.

For this lane type the given code-based values for the “Class A” vehicle should be entered for the related options.

Enter Vehicle Width  as 2.3 m, Vehicle Surface Side Margin  as 0.15 m, and Vehicle Spacing  as 1.2 m.

Depending on the roadway length, the number of required vehicles that should be placed on a single lane longitudinally
can vary. The project-specific vehicle number to be placed on a single lane can be entered for the Max Vehicles  option.
If more than one vehicle should be placed on a single lane longitudinally, Min. Back-to-Front Spacing  should be
specified as given in the code, which is 18.5 m for the “Class A” vehicle per IRC.
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Lane Type Definition for Class A vehicle

Class 70R Wheeled Vehicle Options
To create the second lane type click on Add Lane Type  again. Select “IRC Class 70R Wheeled” from the
Vehicle Load Pattern  list.

Similar to the lane type for the “Class A” vehicle, for the “Class 70R Wheeled” vehicle's lane type, the given code-
based values should be entered for the related options.

Enter Vehicle Width  as 2.79 m, Vehicle Surface Side Margin  as 1.2 m, and Vehicle Spacing  as 1.2 m.

If more than one vehicle should be placed on a single lane longitudinally, the required number should be entered into
the Max Vehicles  option, and Min. Back-to-Front Spacing  should be specified as given in the code, which is 30 m
for the “Class 70R Wheeled” vehicle per IRC.

Unlike “Class A” vehicles, the lane width for Class 70R vehicles is required to be different for interior and exterior
lanes according to IRC:6-2017.

Enter 7.25 m for Lane Width for Exterior Lanes , and enter 7.0 m for Lane Width for Interior Lanes .
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Lane Type Definition for Class 70R Wheeled vehicle

The given impact factor by the code for each different vehicle can be entered as Vehicle Factor  to the lane types
in the Vehicular Loading  tab.

For More Information, please refer to the following documentation.

• Influence Line & Surface Analysis in LARSA 4D Reference Manual.

• Lanes in LARSA 4D Reference Manual.
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General Model Optimization -
Automated Iterative Shape Finding

The General Model Optimization tool solves for the appropriate model input configuration such that the model results
satisfy certain conditions. For instance, the tool can find the cable prestress value to apply to cables such that specified
joint deformations are zero, thus achieving a certain desired output geometry.

It is common in the planning of bridge structures to design according to the final deformed geometry of the model.
Architectural designs specify how the structure should look after construction is finished, leaving the engineer
responsible for determining how to begin a structure so that the desired geometry is achieved after construction is
complete. For instance, while desired final cable geometry may be known, the interaction between the cable's tension
and the loading and stiffness of the rest of the structure make it difficult to determine what initial prestress values to
choose for the cables.

Several manual procedures are available to the engineer to make informed guesses about the proper initial geometry
and cable stressing necessary to achieve the desired final result. However, computer algorithms can more quickly and
accurately solve this problem, especially when many variables are involved. LARSA 4D's General Model Optimization
tool is provided to solve this problem.

The General Model Optimization tool's job is to modify aspects of the model input conditions, such as joint geometry
or member prestress, so that the model output or results satisfy certain criteria. The tool makes iterative changes to the
model input until the output conditions are satisfied. Output conditions can be checked at any result case. This means
that when used with Staged Construction Analysis the tool can find the input conditions that yield the desired output
after many construction activities have been performed.

General Model Optimization
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Overview of Using General Model Optimization

In order to use this tool, a model must be analyzed once. The model will not have the desired output geometry yet,
but the final geometry should be at least roughly close to what is desired. The tool will use the model as it is as its
first guess for solving the form finding problem.

The user then starts the tool from the Tools menu under Geometry Control. The name of the tool is General Model
Optimization.

The user must then choose which aspect of model input conditions the tool will vary in order to satisfy the output
conditions. This is called the model parameter to optimize. Currently only cable pretension values can be iteratively
optimized by the tool.

The user then chooses the output criteria that must be satisfied by the tool. This is called the model target. Currently
the only option for model targets is to achieve zero displacement at one or more joints. A zero displacement target is
useful when the user has entered as the input joint coordinates the coordinates that are desired in the final structure.
Therefore zero displacements occur just when the loading brings the structure back to its desired form.

The result case to evaluate the model target in is also chosen. This can be any result case. For a static analysis, the
result case represents the loading conditions the model is to be subjected to. For a Staged Construction Analysis, the
result case represents the point in time when the model target is to be evaluated. The result case could be at any point
during the construction sequence.

A maximum number of iteration steps and a stopping tolerance can be set by the user before beginning the optimization
process. During optimization, the tool will iteratively modify model parameter, each time running a complete analysis
(using the analysis options set for the last analysis run). It will evaluate the results after each analysis and will stop
when the model target is achieved. If it is not achieved, the model input conditions are intelligently modified and the
process continues.

Types of Optimization Problems

Through the choices the user may make in selecting the model parameter and target, the user will be choosing between
several distinct types of optimization problems. Some optimization problems are faster to solve than others, so it is
important to understand the mathematical problem being solved.

Univariate versus Multivariate

The optimization problem may be univariate or multivariate, depending on the choice of the model parameter
to vary. A univariate optimization problem means the model parameter is a single variable. If the optimization
tool is varying a single prestress value (though it may be applied to one or more cable elements), the problem
is univariate. On the other hand, if the model parameter consists of more than one cable, each of which may
have a different prestress value, then the problem is multivariate because the tool is searching for more than
one model input value. Univariate problems are significantly faster to solve than multivariate problems.

Univariate Problems

For a univariate optimization problem, the model target must also be a single variable. An example of a
single-variable model target is the displacement of a single joint. Another example of a single-variable model
target is the average joint displacement of a group of joints. While such a model target involves more than
one displacement value, only a single number, the avarege, is evaluated by the stopping criteria. Univariate
problems run a single analysis at each iteration.
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Multivariate Problems

Multivariate problems should have a multiple-variable model target. An example of a multiple-variable
model target is the displacements at multiple joints. Further, it is recommended that the number of variables
in the model parameter be the same as the number of variables in the model target. If the model parameter
consists of n cable prestress values, the model target should be the displacements at n joints, usually the
joints at the bases of the same cables. Multivariate problems run up to n analyses for each iteration, making
this problem considerably slower to solve than the univariate problem, especially when an analysis run takes
a minute or more to complete.

Zero-Finding versus Minimization

The optimization problem may also be a zero-finding problem or a minimization problem. This depends
on the model target chosen. A zero-finding problem is one in which the model target is desired to be zero
but, depending on the model input, could potentially be either positive or negative. Joint displacements in
a particular direction create zero-finding problems because displacements can take on positive or negative
values. On the other hand, it is possible to select as the model target zero joint displacement using the
magnitude of the translation in all three directions (i.e. minimizing sqrt(dx2+dy2+dz2)). This is a minimization
problem because the magnitude of displacement cannot be negative, and it may not even be possible to
achieve zero displacement in all three directions simultaneously. Zero-finding problems are faster to solve
than minimization problems.

Zero-Finding Problems

Zero-Finding problems can be either univariate or multivariate. Univariate zero-finding problems are the
fastest optimization problem to solve.

Minimization Problems

Minimization problems must currently be univariate.

The Model Parameter to Optimize

Cable prestress force (see Members [in LARSA 4D Reference Manual]) is currently the only model parameter option.
The user is asked to choose a structure group (page 93) containing cable member elements whose prestress force values
will be modified during the optimization process. Both the univariate and the multivariate options are available for
cable prestress.

Univariate Cable Prestress Problem

In the univariate problem, a single prestress force value is altered during the iterative process. This prestress
value may be assigned to one or more actual cables. Assuming that all of the cables involved in the model
optimization have the same prestress is a useful simplification in order to use the faster univariate method.

The structure group chosen by the user should contain the cable elements. It may also be a structure group
folder consisting of groups containing the cable elements.

Multivariate Cable Prestress Problem

In the multivariate problem, many prestress force values are altered during the iterative process. This allows
different cables to have different prestress values, each being solved for independently, but simultaneously.
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The structure group chosen by the user must be a structure group folder. In the folder, there must be a separate
group for each physical cable in the model whose prestress is to be varied. Each group in the folder represents
a different prestress variable being varied.

A multi-variable model target must also be chosen to use the multivariate procedure. The model target should
have the same number of variables as the number of structure groups in the chosen folder.

The Model Target

Achieving zero joint displacement [see “Joint Displacements” in LARSA 4D Reference Manual] is currently the only
model target option. The displacements considered may be of a single or of multiple joints, and in a particular direction,
or the magnitude of the translation.

No Deformation at a Single Joint - In One Direction

Choose "No deformation at a single joint", enter the ID of a joint, and choose a direction of deformation
(tx, ty, tz, rx, ry, rz). The model target is achieved when the displacement of the chosen joint in the chosen
direction is zero. This is a single-variable model target and so can be used in univariate problems only. It is
a signed model target and so creates a zero-finding problem.

No Deformation at a Single Joint - In All Directions

Choose "No deformation at a single joint", enter the ID of a joint, and choose the direction "All". The
model target is achieved when the magnitude of translational displacement of the chosen joint is zero (i.e.
sqrt(dx2+dy2+dz2) = 0). This is a single-variable model target and so can be used in univariate problems only.
It is a positive-valued model target and so creates a minimization problem.

No Deformation at Multiple Joints - In One Direction

Choose "No Deformation at joints in a structure group", select a structure group (page 93) containing the joints
whose displacements are desired to be zero, and choose a direction of deformation (tx, ty, tz, rx, ry, rz).

When used with a univariate model parameter, this is a single-variable model target. The model target is
roughly the mean of the magnitudes of the displacements of the joints in the chosen structure group, in the
direction chosen. The model target is achieved when this mean is zero. Since magnitudes are positive-valued
only, and so the mean is as well, this creates a minimization problem. (The actual model target is the square-
root of the mean of the squares of the displacement values, so called a root-mean-squared or R.M.S. value.)

When used with a multivariate model parameter, this is a multivariable model target. The number of variables
in the target is the number of joints. The model target is achieved when each of the displacements of the
joints in the structure group, in the chosen direction, is zero. This is a signed model target and so creates
a zero-finding problem

No Deformation at Multiple Joints - In All Directions

Choose "No Deformation at joints in a structure group", select a structure group (page 93) containing the
joints whose displacements are desired to be zero, and choose the direction "All". Below, the magnitude of
translational displacement means sqrt(dx2+dy2+dz2)

When used with a univariate model parameter, this is a single-variable model target. The model target is
roughly the mean of the magnitudes of the translational displacements of the joints in the chosen structure
group. The model target is achieved when this mean is zero. Since magnitudes are positive-valued only, and
so the mean is as well, this creates a minimization problem. (The actual model target is the square-root of
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the mean of the squares of the magnitudes of translational displacement, so called a root-mean-squared or
R.M.S. value.)

When used with a multivariate model parameter, this is a multivariable model target. The number of variables
in the target is six times the number of joints, since there are six directions of displacement for each joint. The
model target is achieved when each of the six displacements of the joints in the structure group is zero. Since
each direction of displacement can have positive and negative values, this creates a zero-finding problem

Example 1

This and the next section will walk through two examples of using the General Model Optimization tool.

In this first example, a joint is suspended from two steel .5 inch cables. A 1000 kip downward force is applied to the
cable. The joint is modeled at its desired final position. The goal is to determine the necessary prestress force to apply
to the cable elements so that the joint has zero displacement.

Example Project:  The example described here can be found in the Shape Finding folder of your LARSA 4D
Samples directory (generally My Documents\LARSA Projects\Samples) in the file GMO1.

An initial guess of 0.1 kips is set as the prestress force on the cable elements. Setting some prestress force is necessary
in order to run an analysis, as without any prestress force the internal joints on the cable elements may not be in tension,
causing instability.

In this example, we make the assumption that the two cables must have the same prestress force. Here the assumption
is sensible as the model is symmetric. The assumption allows us to run a univariate model optimization, which will be
faster than if we allow the two cables to have different prestress values.

A structure group (page 93) is created containing all of the cable elements in the model.
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Example 1: Two cables suspend a load.

After running a nonlinear static analysis and verifying that a 0.1 kip prestress force is not enough to prevent
displacement of the joint, the General Model Optimization tool is started.

On the left side of the window, the model parameter is chosen as Cable Prestress Force. The structure group containing
the cable elements as selected, indicating the prestress force values in those elements are to be varied.

On the right side, for the model target, No deformation at a single joint is chosen, and the ID of the suspended joint
is entered. For direction, we have the option of choosing either All or TZ, because we know that there are only z-
displacements in the model. Choosing TZ will start a zero-finding problem, which will be faster than the minimization
problem started with the direction All. (See above for an explanation.)

In the Evaluate target in this result case field, the name of the result case corresponding to the static load is chosen.
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Example 1: General Model Optimization Options

After clicking Start, the tool wil begin to modify the prestress force values and run analyses until the joint displacement
reaches zero. Status messages are shown after each step. In this example, with the direction TZ chosen, four iterations
were needed. The final prestress force value is 70.71 kips, and the z-displacement is made to be exactly zero.

Had the All direction been chosen and the minimization procedure been used instead, sixteen analysis runs, instead
of four, would have been required to find the solution.

Example 2

This second example involves a simple cable stay model with three stays. The deck is supported at the pier and is under
a uniform load. The deck is modeled at its desired final position. Without any prestress force in the cables, the deck will
deform. The goal is to determine the necessary prestress force in each cable so that the deck remains flat, with as close
to zero displacements as possible at the joints along the deck. A different prestress force may be needed in each cable.

Example Project:  The example described here can be found in the Shape Finding folder of your LARSA 4D
Samples directory (generally My Documents\LARSA Projects\Samples) in the file GMO2.

An initial guess of 100 kips is set as the prestress force on the cable elements. In a multivariate problem as this will
be, it is very important to choose initial values for the model parameters as close as possible to the expected solution.

In this example, we do not make the assumption that the stays have the same prestress force. We are then forced to use
the multivariate zero-finding procedure, which is much slower than the univariate procedure.

A structure group folder (page 93) is created named "Stays". Into this folder, separate groups are added for each of the
stays. Each group contains the cable elements that make up a single stay.

Because there are three cables, there are three model parameter variables. In a multivariate problem, there should be the
same number of model target variables. So three joints are chosen whose displacements are to be zeroed-out: the three
joints at the bases of the cables. A structure group named "Base Joints" is created containing just those three joints.
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Example 3: A cable-stayed model

After running a nonlinear static analysis and verifying that the prestress force set is not correct to prevent displacement
of the deck, the General Model Optimization tool is started.

On the left side of the window, the model parameter is chosen as Cable Prestress Force. The structure group folder
containing the groups for the cables is selected, indicating the prestress force values in those cables are to be varied
independently.

On the right side, for the model target, No deformation at joints in a structure group is chosen, and the group Base
Joints is selected. For direction, TZ is chosen. We should not choose the All direction because this would create six
model target variables for each joint, but exactly three model target variables are desired.

In the Evaluate target in this result case field, the name of the result case corresponding to the static load is chosen.

After clicking Start, the tool wil begin to modify the prestress force values and run analyses until the joint displacement
reaches zero. Progress messages are shown after each step. After 10 iterations involving roughly 20 analysis runs, the
procedure stopped. The prestress values were set to 220.7, 220.4, and 202.0 kips for the three cables. The displacements
were .02, .06, and -.07 inches at the three joints. This was the best solution that could be found.
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Steel Design

The Steel Design tool performs code checks and design for a variety of codes.

All Steel Design commands are on the Design  menu.

Preparing Input

Steel Design will only code check or design members that have been marks as to be code checked or designed. To
mark members for Steel Design, open the Design  and click Add Selected Members . This tool will mark all selected
members to be analyzed for steel design.

Each member to be code checked or designed needs to be given design parameters, such as unbraced length and K
factors. Steel Design parameters can be edited by choosing Design Parameters  from the menu.

Steel Design Parameters
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Options

Code/Database

Other options need to be set before running a code check or design.
Select Options  from the menu.

Section Code and Database
Choose a design code and section database that will be used in the code check.

Use Structure Groups in Design
Turn on/off the option to use structure groups during the code check / design. The use of structure groups to
code check or design a group of members together is explained below.

Design Failing Members Only
Steel Design will first investigate the members and design only the ones that are failing.

Neglectable Forces
All forces that are below the specified values here will be ignored during the code check/design.

Pass/Fail Ratio
Code check and design uses this ratio to identify the failing members.

Import External Design Code
Users can write their own design codes as plugins to be used directly from LARSA. If you have a user-written
design plugin, click Import External Design Code to load the design plugin. For more information, refer to
Creating a Steel Design Code [in ].
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Using Structure Groups and Spans

All members that are in the same structure group (page 93) will be designed with the same section.

All members that are in the same span [see “Spans” in LARSA 4D Reference Manual] will be code checked/designed
as one member. The code will use the length of the span instead of the length of the individual members during both
code check and design. Steel Design will choose one section for the whole span. The results can be viewed for each
member separately.

If a member is both in a structure group and a span, assignment to a structure group is ignored.

You can turn these options off from the Steel Design Plugin Options dialog box.

Code Check

Before the code check make sure the model has been analyzed.

In the Design  menu choose Code Check .

From this window you can select Load Combinations [in LARSA 4D Reference Manual] to be code checked.

Run Code Check

To select a load combination to be code checked, double-click the load combination or click it once and then click the
Add button. It will be added to the list on the right, which shows which combinations will be code checked.

Once you add the load combination, you can edit or remove it from the spreadsheet. To remove a load combination,
select the combination and click Remove.

After you select the load combinations, run the code check by clicking the Code Check button.
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When the program finishes the code check, you can see the results. Open the Design  menu and select Results :
Summary , Results : Axial/Bending , or Results : Graphics .

Result Spreadsheet

Design

To perform a design, follow the same steps through Code Check. Then, choose Design  from the Design  menu.

Run Steel Design

To select a load combination to be designed, double-click the load combination or click it once and then click the Add
button. It will be added to the list on the right, which shows which combinations will be code checked.
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Once you add the load combination, you can edit or remove it from the spreadsheet. To remove a load combination,
select the combination and click Remove.

Click Design to perform the design.

Then check the results following the same steps as in Code Check.

Design Results Spreadsheet

Graphics

You can view the graph of the ratio for each steel design result case by using Results:Graphics  under Design  menu,
which will activate the steel design result graphics view. Steel design result graphics view graphs the ratio along the
members when the rendering mode is off. If the rendering mode is on, steel design graphics view will draw passing
members in yellow and the failing ones in red. The label for each member can be modified at the Graphics tab of Steel
Design Plugin Options dialog box.

AISC-LRFD2000 Design/Code Check

This chapter describes the details of the structural steel design and stress check formulas that are used by LARSA 4D
Steel Design when the user slects the AISC-LRFD2000 design code. The notations that are used in the formulas are
listed end of this chapter.

The code check/design is based on user specified load case/combinations.

The evaluation of the axial force, biaxial moment and bending moment capacity ratios at a station along the length
of the member. Actual member sectional forces/moments components are calculated by LARSA 4D analysis engine.
Then the capacity ratios are evaluated at each station under the influence of all load cases/combinations that are selected
by user to perform a code check/design. The combined capacity ratio greater then 1.0 indicates exceeding a limit state.
The member is mark as failing member.
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AISC-LRFD2000 Design/Code Check Units

• Kip for the force units

• Inch for the length unit
The inputs can be in any unit format such as English, SI and MKS metric units.

Limiting Slenderness Ratios

The ratio of the effective length of a column to the radius of gyration of the column, both with respect to the same
axis of bending.

For the members in which the design is based on compression, the slenderness ratio KL/r preferably should not exceed
200. For members in which the design is based on tension, the slenderness ratio l/r preferably should not exceed
300.(AISC-LRFD 2000 Design Manual)

Classification of Sections

AISC classifies cross-sectional shapes as compact, noncompact and slender, depending on the value of the width-
thickness ratios.(AISC-LRFD Specification Table B5.1)

The nominal strengths for axial compression and flexure are dependent on the classification of the section.

Limiting Width-Thickness Ratio for Compression Members

Limiting Width-Thickness Ratio for Flexure Members

Tension Capacity

In order to design tension members, it is important to analyze how the member would fail under both yielding and
fracture. These are the limit states for tension members. The limit state that produces the smallest design strength is
considered the controlling limit state.

• Yielding Limit State
The limit state of yielding must be considered in tension members to prevent failure from deformation. To
prevent excessive deformation, initiated by yielding, the load on the gross section must be small enough that
the stress on the gross section is less than the yield stress

• Repture Limit State
The limit state of fracture must be considered in tension members to prevent failure from breaking. To prevent
fracture, the sstress on the net section must be less than the tensile strength Fu.

The resistance factor is smaller for fracture than it was for yielding because failure in fracture is more sudden
and serious than in yielding.
Here the design strength of the tension members is φtPn where:
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Fracture

• Ae = effective net area, in.2

• Fu = specified minimum tensile stress, ksi

It is also important that for tension members l/r not exceed 300. If it exceed this limit value, the member fails exceeding
limiting slenderness ratio. (AISC-LRFD Specification Section B7)

Compression Capacity

• Design Compressive Strength for Flexural Buckling

• Design Compressive Stength for Flexural-Torsional Buckling

Calculation of Nominal Strengths
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AISC-LRFD Steel Design Code

This chapter describes the details of the structural steel design and stress check formulas that are used by LARSA 4D
Steel Design when the user selects the AISC-LRFD2000 design code. The notations that are used in the formulas are
listed at the end of this chapter.

AISC-LRFD2000 Design/Code Check

The code check/design is based on user specified load case/combinations.

The evaluation of the axial force, biaxial moment and bending moment capacity ratios at a station along the length
of the member. Actual member sectional forces/moments components are calculated by LARSA 4D analysis engine.
Then the capacity ratios are evaluated at each station under the influence of all load cases/combinations that are selected
by user to perform a code check/design. The combined capacity ratio greater then 1.0 indicates exceeding a limit state.
The member is mark as failing member.

AISC-LRFD2000 Design/Code Check Units

AISC-LRFD 2000 bases on

• Kip for the force units

• Inch for the length unit
The inputs can be in any unit format such as English, SI and MKS metric units.

Limiting Slenderness Ratios

The ratio of the effective length of a column to the radius of gyration of the column, both with respect to the same
axis of bending.

For the members in which the design is based on compression, the slenderness ratio KL/r preferably should not exceed
200. For members in which the design is based on tension, the slenderness ratio l/r preferably should not exceed
300.(AISC-LRFD 2000 Design Manual)

Classification of Sections

AISC classifies cross-sectional shapes as compact, noncompact and slender, depending on the value of the width-
thickness ratios.(AISC-LRFD Specification Table B5.1)

The nominal strengths for axial compression and flexure are dependent on the classification of the section.

The width thickness ratio for HSS round and rectangular section shall be determined according to AISC-LRFD
Specification for Hollow Structural Sections

The width thickness ratio for single angle section shall be determined according to AISC-LRFD Specification for
Single-Angle Members
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Tension Capacity

In order to design tension members, it is important to analyze how the member would fail under both yielding and
fracture. These are the limit states for tension members. The limit state that produces the smallest design strength is
considered the controlling limit state.

• Yielding Limit State

The limit state of yielding must be considered in tension members to prevent failure from deformation. To
prevent excessive deformation, initiated by yielding, the load on the gross section must be small enough that
the stress on the gross section is less than the yield stress

• Repture Limit State

The limit state of fracture must be considered in tension members to prevent failure from breaking. To prevent
fracture, the stress on the net section must be less than the tensile strength Fu.

The resistance factor is smaller for fracture than it was for yielding because failure in fracture is more sudden
and serious than in yielding.

Here the design strength of the tension members is φtPn where:

Fracture

• Ae = effective net area, in^2

• Fu = specified minimum tensile stress, ksi

It is also important that for tension members l/r not exceed 300. If it exceed this limit value, the member fails exceeding
limiting slenderness ratio. (AISC-LRFD Specification Section B7)

Compression Capacity
• Design Compressive Strength for Flexural Buckling

• Design Compressive Stength for Flexural-Torsional Buckling

Column slenderness ratio

For double-angle and tee-shaped members whose elements do not meet the requirements of Section B5.1, see
Appendix B5.3 to determine Fcry for use in Equation E3-1. (AISC-LRFD Specification Section E3)

The design strength for compression single angle members is calculated according to AISC-LRFD Specifications
Manual for Single Angle Members. The design strength shall be φcPn:
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where

• φc = 0.90

• Pn=Ag*Fcr

Fcr shall be determined as follows:

Design Compressive Strength for Flexural Buckling

• Fy = specified minimum yield sress of steel

• Q = reduction factor for local buckling

Q reduction factor for local buckling shall be determined as follows:
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Fcr critical stress for single angle

• b = full width of longest angle leg

• t = thickness of angle

The design strength for flexural buckling of compression HSS round and rectangular members is calculated according
to AISC-LRFD Specification Manual Section for Hollow Structural Sections.

The design strength for flexural buckling of compression HSS round and rectangular members is φcPn:

Design strength for HSS round and rectangular members

Fcr shall be determined as follows:
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Critical stress for HSS round and rectangular members

Q shall be determined as follows:

Q buckling reduction factor for HSS round and rectangular members
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where the effective area is equal to the summation of the effective areas of the sides using

Design for Flexure

This section applies to compact and non-compact prismatic members subject to flexure and shear. The nominal flexural
strenght Mn is the lowest value obtained according to the 6 limit states of:

• Yielding

• Web Local Buckling

• Flange Local Buckling

• Design Flexural Strength for HSS round and rectangular members.

• Design Flexural Strength for Single Angle members.

• Shear Capacity

• Serviceability
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Pier Column Code Check Tool
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Introduction

LARSA 4D Pier Code Check Tool is a product available to expand LARSA 4D’s design capabilities. The tool enables
detailed design code checks on Material Properties, Reinforcement Limits, Shear Capacity, Transverse Reinforcement
Requirements, Longitudinal Reinforcement Limits, and Control of Cracking of Pier Columns. The tool is designed
to bring multiple considerations under a single roof. Users can conduct detailed code check for various design codes,
and biaxial interaction analysis to determine the ultimate biaxial capacity of pier columns containing pre- and-post
tensioning tendons and reinforcements.

The tool generates comprehensive reports which aggregates the overall pass-fail status of each code check station
together with detailed computations. Visual reports for the three-dimensional capacity surface of pier sections are
also presented, enabling quick confirmation to ensure demands on pier-columns fall within the capacity surface of
the member.

Pier Column Code Check Tool currently supports code checks for:

• Pier columns per AASHTO LRFD Bridge Design Specifications 7th, 8th and 9th Editions (page 401)

• Pier columns per Indian Roads Congress (IRC) Code of Practice for Concrete Road Bridges, 2020 (First
Revision) (page 417)

This tool can be found on the “Design” menu under “Pier Column Code Check Tool” .

Preparing the Model for Code Check

Before starting the Code Check Tool:

• Create separate structure groups in LARSA 4D for each pier participating in the Code Check procedure,
where each structure group contains the members of a single column. Note that, a different group should
be created for each continous segment of the pier. For example, for a Y-shaped pier, three structure groups
should be created.

• Use the Sections spreadsheet of LARSA 4D or Section Composer to enter rebar information into pier
sections. This information is used in the biaxial interaction analysis to calculate ultimate capacity.

• Run a Linear/Nonlinear Static or Staged Construction Analysis of the model before launching the tool.

• Use Linear Result Combinations and Extreme Effect Groups to create any code-based factored design load
combinations.
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Application Overview

Figure 1: Main Window

When the Pier Code Check Tool is opened, the tool's main window is presented where the desired Code Check Cases
are defined. Each row entered in this spreadsheet creates a new Code Check Case. Each Case comprises its associated
properties that can be modified for specific considerations. The Pier Group is used for selecting a pier's previously
created structure group. Starting and Ending stations together with the Station Count information, Pier Section and
Material, a group of result cases called a Design Loads group, and a Code Check Parameters group are other properties
of a code check case which are explained in detail below.

Code check parameters that are available in the LARSA 4D model are extracted from the model. Users are expected to
enter only a few parameters manually within the scope of the selected design code, such as transverse reinforcement
properties and seismic zone. The design code is selected from the drop-down list located at the top right of the tool.

Creating Code Check Cases

Each row entered in the Code Check Cases spreadsheet creates a new case. Users are able to create multiple Code Check
Cases by modifying associated properties explained below and evaluate all cases at once by a single code check run.

The Pier Group  column is used to select the structure group containing the pier elements for which the code check
procedure will consider. The dropdown menu in this section contains the structure groups previously created in the
LARSA model, which contains the associated chain of column members.

The Starting Station  and Ending Station  are entered to define the portion of the column that is subjected to code
check. The Station Count  column used to define the number of code check stations within the defined range. Users can
rapidly perform code checks for multiple section cuts through the column’s length by interpreting a single code check
case. The tool will generate separate detailed reports for each station. While Starting Station  refers to the starting
joint, the Ending Station  indicates the end joint of the column member chain by taking their position on global Z
as a reference.
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Figure 2: Starting/Ending Station and Station Count

Options displayed under the drop-down list of the Section  column are fetched directly from the LARSA model ( Input
Data  → Properties  → Sections ). The Use Assigned Sections option quickly enables performing code check with
the section assigned to the Pier structure Group during the analysis by finding the member located at the entered code
check station and extracting the corresponding section and material properties. The tool also allows users to conduct
checks with sections not assigned to the members of the column during the analysis. Therefore, the same pier group
can be checked with different sections and/or different reinforcement arrangements without leaving the code check
tool or repeating the analysis by simply changing the Section  selection.

Code check can be performed using any section, with or without holes and various reinforcement patterns. The tool
directly supports some of the widely used column sections: the sections available under the “Columns” category in
the LARSA 4D sections database and several basic shapes, shown in the figure below. For these sections, the section
parameters are automatically pulled from the associated LARSA model. For other sections, the user must enter shear
width, depth, and some other parameters manually depending on the selected design code.

Figure 3: Column Sections in LARSA 4D Library

The Design Loads  column organizes the result cases required for code check. Clicking the New Group option opens
the Design Loads Group window. The result cases can be added by double-clicking on the result case or using the Add
button. A separate design check is performed and reported for each result case specified under the design load group.
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The checkboxes Check for Strength Limit State  and Check For Service Limit State  adjust the limit-state checks that
will be run for the selected result cases. When using result cases that require enveloping, such as influence-based live
load result cases and extreme effect groups, also choose an Envelope Column that will be used for extracting results.

The result case selected for Result case for tendon forces  will be used to extract parameters related with tendons to
use in the code check procedures. In addition, the location and force in the tendon will be extracted from the selected
result case to use in the biaxial interaction analysis.

Figure 4: Design Loads Group Form

Using the Edit Design Load Groups  button, previously created design load groups can be modified. The button takes
you to a new window, where you can make desired changes to all the created Design Load Groups.
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Figure 5: Edit Design Loads Group Form

The Materials  button is enabled once the Pier Group, Station, and Design Loads Groups are selected for a Code Check
Case, where you can then continue to choose material models. Various material models are available that can be used in
Section Analysis, including the Hognestad model with and without softening, Rectangular Block – ACI, and Mander
confined and unconfined. You can also define a custom material stress-strain curve using the stress-strain curve points
spreadsheet. See Concrete Material Models (page 229) for details.

The Code Check Parameters  column introduces the design code parameters. These parameters can be entered by
selecting the New Group option that creates a new parameter group. Users are expected to enter only a few parameters
manually within the scope of the chosen design code, such as transverse reinforcement properties and seismic zone. the
code check parameters available in the structural model are automatically pulled by the Pier Code Check Tool. Here,
the tool also gives users the freedom to override any parameter without rerunning the analysis. While entering the
parameters, their descriptions are displayed at the bottom. After creating a Code Check Parameters Group, the name
and parameter values of the previously created groups can be edited by using the Edit Code Check Parameter  button.
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Figure 6: User Input Parameters Spreadsheet

Using The View Parameters button , you can review all the code check inputs together. In the Parameters window, the
code check parameters are grouped in terms of the Code Check Cases, Stations, and Results Cases.

Figure 7: Viewing the Code Check Parameters

The Include in Code Check  option allows for excluding code check cases from the report by unchecking this option.
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All information entered for code check cases will be saved with the open LARSA 4D project so that it will be restored
the next time the Pier Code Check Tool is opened for the same project. In addition, the tool can save code check inputs
to a file so that they can be imported into another project by using the Export Cases  and Import Cases  buttons.

Running Code Check

Click Perform Code Check  to perform code check. After the code check is performed, including biaxial interaction
analysis, the tool’s Code Check Report (page 399) is automatically displayed, providing an efficient and precise
inspection of results.

The previously generated code check reports can be accessed using the View Existing Reports  button.
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Code Check Report

The code check report has three pages and can be saved as PDF files by using the Save Report PDF  button located at the
bottom left corner. It starts with the Summary Page which presents the overall pass-fail status of the code check cases.

Figure 1: Code Check Report Summary Page

The detailed computations for each procedure are reported on the Code Check Results Page, including its description,
inputs, corresponding equations, and articles from the design code. They are all accessed by clicking the Code Check
Results  button within the navigator.
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Figure 2: Code Check Report Code Check Page

Under the Biaxial Interaction Results Page, you can review the computed ultimate capacity surfaces of the
corresponding section. In this section of the report, interaction diagrams present the visualization of the three-
dimensional capacity of the pier section with and without the Phi (Φ) factor. Therefore, you can check whether the
demand, shown with a green dot, on a pier column falls within the capacity surface of the section.

Figure 3: Code Check Report Biaxial Interaction Results Page
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Pier columns per AASHTO LRFD Bridge
Design Specifications 7th, 8th and 9th
Editions

In this section, the code check procedures for a column per AASHTO LRFD Bridge Specifications 8th edition is briefly
explained.

The tool enables detailed design code-checks on:

• Material Properties

• Reinforcement Limits

• Shear Capacity (for Seismic Zone 1)

• Transverse Reinforcement Requirements (for both spiral and tie types)

• Longitudinal Reinforcement Limits (for Seismic Zone 2, 3 and 4)

• Control of Cracking

The ultimate biaxial capacity of pier column is determined by performing Biaxial Interaction Analysis. Demand/
Capacity ratio is reported with and without Φ factor.

Code check parameters are defined next. The equation and article numbers are given per the 8th Edition and may change
for different versions of the design code.

Required Input Parameters

Required input parameters are as follows:

• trReinfType: Type of transverse reinforcement (Options: Tie, Spiral) (Articles 5.6.4.6 & 5.10.4)

• fyv: The yield strength of transverse reinforcement (Equation 5.6.4.6-1)

• Abar,sml,tr: Single transverse reinforcement bar area (Articles 5.10.4.2 & 5.10.4.3)

• s: Spacing of transverse reinforcement (Articles 5.10.4.2 & 5.10.4.3)

• AvdirX: Area of transverse reinforcement within distance s along the longitudinal axis of the bridge (Articles
5.8.3.3 & 5.8.3.4)

• AvdirY: Area of transverse reinforcement within distance s along the transverse axis of the bridge (Articles
5.8.3.3 & 5.8.3.4)

• α: The angle of inclination of transverse reinforcement to member longitudinal axis (Equation 5.7.3.3-4)

• seismicZone: The seismic zone where the structure is located. Zone 1 is divided into two parts, 1a for SD1 <
0.10 and 1b for the 0.10 <= SD1 <= 0.15 (Options: 1a, 1b, 1, 2, 3, 4) (Article 5.11)

• ag: The maximum aggregate size (Equation 5.7.3.4.2-5)

• exposureConditionClass: Exposure Condition Class (Class 1 or Class 2) (Article 5.7.3.4)

Users are able to perform code checks on all kinds of Standard/Custom sections in LARSA 4D Sections Library,
and the user-defined custom sections with or without cut-outs and various reinforcement patterns. The tool directly
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supports some of the widely used column sections: the sections available under the “Columns” category in the LARSA
4D sections database and several basic shapes, shown in the Figure 3. Column Sections in LARSA 4D Library in the
Pier Code Check Tool Manual Introduction part. For these sections, the section parameters are automatically pulled
from the associated LARSA model and the user only needs to enter the abovementioned parameters to perform code
check. Apart from these, for all other sections to be preferred, the user needs to enter two additional parameters shear
width and depth manually, in addition to the ones given above.

• hdirX: Overall depth of the cross section along longitudinal axis (Article 5.7.2.8)

• hdirY: Overall depth of the cross section along transverse axis (Article 5.7.2.8)

• bv,dirX: Shear width of the cross-section along transverse axis of the bridge (Article 5.7.2.8)

• bv,dirY: Shear width of the cross-section along longitudinal axis of the bridge (Article 5.7.2.8)

Parameters Extracted from the LARSA 4D Model

The member, located at the code check station, is found by searching the member in the selected structure group at the
entered station. After member is found the properties of section and material are extracted. If a parametric section with
prismatic variation is assigned to the member, the parametric position is set at the location of the code check station,
and the section at that location is used to extract parameters.

The parameters that are extracted from LARSA 4D model are as follows:

Material Properties

Properties of pier material, rebar material and tendon material are needed to run code check procedures for concrete
pier.

Material of each pier element is taken from Input Data  → Geometry  → Members  spreadsheet except that member
has a section created using Section Composer. In that case, material of concrete is taken as the reference material of
the section. After material of pier is determined, corresponding material properties are extracted from Input Data  →
Properties  → Materials  spreadsheet.

• wc: Unit Weight of concrete (Article 5.4.2.4)

• fc: Specified concrete compressive strength of member (Article 5.4.2.1)

• Ec: Modulus of elasticity of concrete (Article 5.4.2.4)

Rebars are taken from Rebars spreadsheet which can be reached through right-clicking the section in Sections
spreadsheet. Material properties of rebars are extracted from the material assigned to the rebars defined within the
section.

• fy: Specified yield strength of the longitudinal reinforcement (Article 5.4.3.1)

• Es: Modulus of elasticity of steel (Article 5.4.3.2)

Material properties of tendons are extracted from the tendons defined within the member if a result case with tendon
results is selected before starting the Pier Design Code Check Tool.

• fpu: Specified tensile strength of the prestressing steel (Articles 5.10.11.3 & 5.10.11.4.1a)

• Ep: Modulus of elasticity of prestressing steel (Article 5.4.4.2)
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Sectional Properties and Geometric Parameters

Pier column sections shall be checked in both directions. The directions are called as longitudinal and transverse axes
of the bridge. If a bridge path coordinate system is defined in the model, the parameters are extracted from the section
in compliance with the stated directions. However, if the bridge path coordinate system is not defined, the longitudinal
axis is assumed to be along the Member Local Y direction, and the transverse axis is assumed to be along Member
Local Z direction.

• hdirX: Overall depth of the cross section along longitudinal axis (Article 5.7.2.8)

• hdirY: Overall depth of the cross section along transverse axis (Article 5.7.2.8)

These parameters are taken from the Section Properties spreadsheet that can be reached from Input Data  → Properties
→ Sections . For parametric sections, parameters can be seen and edited by using Section Composer. For the basic
shapes shown below, section parameters are taken as follows:

Figure 1: hdirX and hdirY Parameters for Different Sections

In general, it can be said that hdirX is taken as depth and hdirY is taken as width of the sections. This assumption allows
user to model and check pier alone. The aim is to be sure that pier column section is checked for both directions as
mentioned above.

• ccdirX: Clear cover along longitudinal axis of bridge

• ccdirY: Clear cover along longitudinal axis of bridge

ccdirX and ccdirY parameters are calculated internally using the sectional dimensions and defined rebar locations.

• Ag: Gross area of the cross-section

• Ac,dirX: Area of concrete in flexural tension side where flexural tension side is taken as the half-depth of the
cross section along bridge longitudinal axis (Equation 5.7.3.4.2-4)

• Ac,dirY: Area of concrete in flexural tension side where flexural tension side is taken as the half-depth of the
cross section along bridge transverse axis (Equation 5.7.3.4.2-4)
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• bv,dirX: Shear width of the cross-section along transverse axis of the bridge (Article 5.7.2.8)

• bv,dirY: Shear width of the cross-section along longitudinal axis of the bridge (Article 5.7.2.8)

Shear width parameter for different sections is calculated as follows:

Figure 2: Shear Width for Different Sections

As it can be seen on Figure1, for "Rectangle", "Ellipse", "Blade Column" and "Solid Circle" bv,dirX is taken as equal to
hdirY and bv,dirY is taken as equal to hdirX. For "Trapezoid", while bv,dirY taken as hdirX like the other shapes mentioned
earlier, bv,dirX is taken as mean value of top and bottom width. For "I Shape" bv,dirX is taken as web thickness and bv,dirY
is taken as summation of top and bottom flange thickness.

• distanceFromBottom: Distance of the station from the bottom of the column (Article 5.11.4.1.5)

• length: Total Length of the column. Assumed that column length is measured from the bottom of the cap to
the top of the foundation (Article 5.11.4.1.3)

Following parameters are calculated using Section Analysis Results. First a Moment Curvature Analysis is run for the
section assigned to the member located at the code check station in both directions. While computing Mn, the axial
load effects are ignored referring Article 5.8.2.9. Then, the value of the following parameters are computed using the
computed ultimate moment capacity and location of neutral axis in the direction of consideration.
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Figure 3: Illustration of parameters bv and dv AASHTO, 2017, AASHTO LRFD Bridge Design Specifications, 8th Edition

• ds,dirX: The distance from extreme compression fiber to the centroid of the tensile reinforcement along
longitudinal axis (Article 5.6.3.2.2)

• ds,dirY: The distance from extreme compression fiber to the centroid of the tensile reinforcement along
transverse axis (Article 5.6.3.2.2)

• dv,initial,dirX: The effective shear depth for along longitudinal axis obtained from Section Analysis (Articles
5.8.2.8 & 5.7.2.9)

• dv,initial,dirY: The effective shear depth for along transverse axis obtained from Section Analysis (Articles
5.8.2.8 & 5.7.2.9)

dv,initial,dirX and dv,initial,dirY are stated as dv in Figure3. Since dv will be taken as of minimum of 0.9de and 0.72h, the
initial value of shear depth is calculated as the distance between outermost compression fiber and the centroid of tensile
reinforcement (including prestressing tendons and longitudinal steel rebars) located at the flexural tenion side of the
section.

• Aps,tension,dirX: Area of prestressing steel in tension (Equation 5.7.3.4.2-4)

• Aps,tension,dirY: Area of prestressing steel in tension side (Equation 5.7.3.4.2-4)

• As,tension,dirX: Area of longitudinal steel in flexural tension side (Equation 5.7.3.4.2-4)

• As,tension,dirX: Area of longitudinal steel in flexural tension side (Equation 5.7.3.4.2-4)

The total reinforcement and prestressing steel area located under the neutral axis location are calculated.

Longitudinal Reinforcement and Prestressing Steel

Rebars can be defined using Section Composer for parametric sections. Besides that, users can create rebar definitions
by using the Rebars spreadsheet for sections defined in LARSA 4D. To define rebars inside the main LARSA
environment, rebar database should be connected first and then by using the Rebars spreadsheet which can be opened
by right clicking the section row under the Properties  tab and selecting Rebars .

• As: Total area of the longitudinal reinforcement

• #Rebars: The number of longitudinal rebars in the section (Article 5.6.4.2)

• rebarArrangement: Arrangement of longitudinal rebars in the section (Options: Rectangular, Circular)
(Article 5.6.4.2)

• Abar,sml,long: The minimum value of the longitudinal rebar area in the section (Articles 5.10.4.2 & 5.10.4.3)
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The following parameters are calculated considering the outer layer of the rebars within the section, since pier sections
generally have well distributed longitudinal reinforcement rather than concentrated longitudinal reinforcement.

• Acr,dirX: Minimum area of reinforcing bars in one layer of crack spacing reinforcement (skin reinforcement)
along longitudinal axis of the bridge (Equation 5.7.3.4.2-7)

• Acr,dirY: Minimum area of reinforcing bars in one layer of crack spacing reinforcement (skin reinforcement)
along transverse axis of the bridge (Equation 5.7.3.4.2-7)

• scr,dirX: Spacing of the skin reinforcement (vertical or horizontal) along longitudinal axis of the bridge
(Equation 5.7.3.4.2-7)

• scr,dirY: Spacing of the skin reinforcement (vertical or horizontal) along transverse axis of the bridge
(Equation 5.7.3.4.2-7)

Figure 4: Representation of Acr and scr parameters AASHTO, 2017, AASHTO LRFD Bridge Design Specifications, 8th Edition

In the figure Acr parameter is stated as As and scr parameter is stated as sx.

• isPrestressed: The condition whether the column is presetressed or not (Article 5.8.2)

• Aps: Total area of the prestressing steel

• Aps,draped,dirX: Total area of draped strands in longitudinal direction (Equations 5.7.3.3-1 & 5.7.3.3-2)

• Aps,draped,dirX: Total area of draped strands in longitudinal direction (Equations 5.7.3.3-1 & 5.7.3.3-2)

• ωdirX: Angle of draped strands along longitudinal axis of bridge (Equations 5.7.3.3-1 & 5.7.3.3-2)

• ωdirY: Angle of draped strands along transverse axis of bridge (Equations 5.7.3.3-1 & 5.7.3.3-2)

• fpe: Effective stress in prestressing steel (Equation 5.7.4.2-2)
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Parameters related to the tendons are calculated if the selected result case has tendon results for the member at
the corresponding station. Otherwise, isPrestressed parameter will be returned as false and the other quantity type
parameters will be set as 0.

Loading

Load Combinations for strength limit state should be defined in the main LARSA 4D environment. After the analysis
is completed, factored load combinations can be created by using the Linear Combination/Extreme Effect Groups
option under Results  menu. Then, desired result cases for the code check can be selected inside the Pier Code Check
Tool. The strength limit states should be selected in accordance with the selected design code.

• NStrI: Maximum factored axial force for the controlling strength limit state (+ for tension, - for compression)
(Equation 5.7.3.4.2-4)

• MStrI,dirX: Maximum factored moment for the controlling strength limit state (Equation 5.7.3.4.2-4)

• MStrI,dirY: Maximum factored moment for the controlling strength limit state (Equation 5.7.3.4.2-4)

• VStrI,dirX: Maximum factored shear force for the controlling strength limit state (Equation 5.7.3.4.2-4)

• VStrI,dirY: Maximum factored shear force for the controlling strength limit state (Equation 5.7.3.4.2-4)

Code Check Procedure Details

Material Properties

Normal Weight Concrete

Specific concrete with strengths below 2.4 ksi should not be used in structural applications. In addition to that, design
concrete strengths above 10.0 ksi for normal weight concrete shall be used only when allowed by specific articles or
when physical tests are made to establish the relationships between the concrete strength and other properties.
f'c ≥ 2.4 ksi (Article 5.4.2.1)

f'c ≤ 10 ksi unless specific articles or physical tests allow

Normal weight concrete with specified compressive strengths up to 15.0 ksi may be used for the assumptions of these
sections.
f'c ≤ 15 ksi (Articles 5.6.4.4 & 5.6.4.5)

Reinforcing Steel

The nominal yield strength shall be the minimum as specified for the grade of steel selected, except that yield strengths
in excess of 75.0 ksi shall not be used for design. Furthermore, bars with yield strengths less than 60.0 ksi shall be
used only with the approval of the owner.
fy ≤ 75 ksi (Article 5.4.3.1)

Reinforcing steel with specified minimum yield strengths of less than or equal to 100 ksi may be used for all elements
and connections in Seismic Zone 1.
fy ≤ 100 ksi for Seismic Zone 1 (Article 5.4.3.3)

The modulus of elasticity of steel reinforcing shall be assumed as 29,000 ksi.
Es = 29000 ksi (Article 5.4.3.2)
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Limits for Reinforcement

Maximum area of prestressed and nonprestressed longitudinal reinforcement for noncomposite compression
components for Seismic Zone 1 shall be such that:
As/Ag + (Apsfpu)/(Agfy) ≤ 0.08 for Seismic Zone 1 (Equation 5.6.4.2-1)

Maximum area of prestressed and nonprestressed longitudinal reinforcement for noncomposite compression
components for Seismic Zone 2 shall be such that:
As/Ag + (Apsfpu)/(Agfy) ≤ 0.06 for Seismic Zone 2 (Articles 5.11.3.1 & 5.11.4.1.1)

Maximum area of prestressed and nonprestressed longitudinal reinforcement for noncomposite compression
components for Seismic Zone 3 and 4 shall be such that:
As/Ag + (Apsfpu)/(Agfy) ≤ 0.04 for Seismic Zone 3 and 4 (Articles 5.11.3.1 & 5.11.4.1.1)

Minimum area of prestressed and nonprestressed longitudinal reinforcement for noncomposite compression
components with respect to Seismic Zons shall be such that:
As/Ag + (Apsfpu)/(Agfy) ≥ 0.015 for Seismic Zone 1 (Article 5.6.4.2)

As/Ag + (Apsfpu)/(Agfy) ≥ 0.01 for Seismic Zone 2, 3 and 4 (Article 5.6.4.2)

Minimum area of prestressed and nonprestressed longitudinal reinforcement for noncomposite compression
components shall be such that:
As/Ag + (Apsfpu)/(Agfy) ≥ 0.135(f'c/fy) (Equation 5.6.4.2-3)

Minimum number of longitudinal reinforcing bars in the body of a column shall be 6 in a circular arrangement and 4
in a rectangular arrangement referring article 5.6.4.2. In addition to that, the minimum size of bar shall be No. 5.

Maximum area of prestressed longitudinal reinforcement for noncomposite compression components shall be such
that:
(Apsfpe)/(Agf'c) ≤ 0.30 (equation 5.6.4.2-2)

Shear Capacity for Seismic Zone 1

Minimum transverse reinforcement area, Av, shall be determined as:

Av ≥ 0.0316λ√(f'c)bvs / fy (Article 5.7.2.5)

where;

bv is the width of web adjusted for the presence of ducts

s is the spacing of transverse reinforcement

λ is the concrete density modification factor as specified in article 5.4.2.8

Concrete density modification factor, λ, shall be determined as:
λ = 4.7fct / √(f'c) ≤ 1.0 (Article 5.4.2.8)

where;

fct is the specified splitting tensile strength of lightweight concrete

It should be noted that where normalweight concrete is used, λ shall be taken as 1.0.

Average factored shear stress on the concrete, νu, shall be determined as:

νu = |Vu-ΦvVp| / (Φvbvdv) (Equation 5.7.2.8-1)
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where;

Φv is the resistance factor for shear specified in article 5.5.4.2

bv is the effective web width taken as the minimum web width, measured parallel to the neutral axis, between the resultants of
the tensile and compressive forces due to flexure, or for circular sections, the diameter of the section, modified for the presence
of ducts where applicable

dv is the effective shear depth taken as the distance, measured perpendicular to the neutral axis, between the resultants of the
tensile and compressive forces due to flexure

Effective shear depth taken as the distance measured perpendicular to the neutral axis, between the resultants of the
tensile and compressive forces due to flexure, dv, shall not be taken less than the greater of 0.9de or 0.72h referring
article 5.7.2.8.
dv ≥ MAX(0.9de , 0.72h)

where;

de is the distance from extreme compression fiber to the centroid of the tensile force in tensile reinforcement

h is the overall depth of the cross section

Distance from extreme compression fiber to the centroid of the tensile force in tensile reinforcement, de, shall be
determined as:
de = (Apsfpsdp + Asfyds) / (Apsfps + Asfy) (Equation 5.7.2.8-2)

where;

As is the total area of the longitudinal reinforcement

Aps is the total area of the prestressed longitudinal reinforcement

fy is the specified yield strength of the nonprestressed longitudinal reinforcement

fps is the average stress in prestressing steel at time for which the nominal resistance of the member is required

ds is the distance from extreme compression fiber to the centroid of the nonprestressed tensile reinforcement

dp is the distance from extreme compression fiber to the centroid of the prestressing tendons

Angle of inclination of diagonal compressive stresses, θ, shall be determined as:
θ = 29 + 3500εs (Equation 5.7.3.4.2-3)

where;

εs is the tensile strain in cracked concrete in direction of tension tie; net longitudinal tensile strain in the section at the centroid of
the tension reinforcement

The factor indicating ability of diagonally cracked concrete to transmit tension and shear, β, shall be determined as:
For sections containing at least the minimum amount of transverse reinforcement → β = 4.8 / (1 + 750εs) (Equations 5.7.3.4.2-1 &
5.7.3.4.2-2)

For sections do not contain at least the minimum amount of transverse reinforcement → β = [4.8 / (1 + 750εs)] x [51 / (39 + sxe)]

where;

εs is the tensile strain in cracked concrete in direction of tension tie; net longitudinal tensile strain in the section at the centroid of
the tension reinforcement

sxe is the equivalent of crack spacing parameter sx which allows for influence of aggregate size

Crack spacing parameter which allows for influence of aggregate size, sxe, shall be determined as:

sxe = 1.38sx / (ag + 0.63) ≤ 80 (in) (Equation 5.7.3.4.2-7)

where;
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ag is the maximum aggregate size in inches

sx can be taken as the minimum distance between two consecutive body reinforcements for columns

Tensile strain in cracked concrete in direction of tension tie, net longitudinal tensile strain in the section at the centroid
of the tension reinforcement, εs, shall be determined as:

εs = (|Mu|/dv + 0.5Nu + |Vu-Vp| - Apsfpo) / (EsAs + EpAps) (Equation 5.7.3.4.2-4)

where;

dv is the effective shear depth taken as the distance measured perpendicular to the neutral axis, between the resultants of the
tensile and compressive forces due to flexure

Ac is the area of concrete on the flexural tension side of the member as shown in Figure 2 above

Aps is the area of prestressing steel on the flexural tension side of the member as shown in Figure 2 above

As is the area of nonprestressed steel on the flexural tension side of the member at the section under consideration as shown
in Figure 2 above. In calculating As for use in this equation, bars which are terminated at a distance less than their development
length from the section under consideration shall be ignored

fpo is a parameter taken as modulus of elasticity of prestressing tendons multiplied by the lockedin difference in strain between
the prestressing tendons and the surrounding concrete. For the usual levels of prestressing, a value of 0.7fpu will be appropriate
for both pretensioned and posttensioned members

Mu is factored moment

Nu is factored axial force, taken as positive if tensile and negative if compressive

Vu is factored shear force

Vp is effective prestressing force, positive if resisting the applied shear

Referring article 5.7.3.4.2, if the value of εs calculated from the equation above is negative, the value should be
recalculated with the denominator replaced by (EsAs + EpAps + EcAct). In addition to that, εs should not be taken as
less than –0.40 × 10–3:

εs = (|Mu|/dv + 0.5Nu + |Vu-Vp| - Apsfpo) / (EsAs + EpAps + EcAct) ≥ –0.40 × 10–3

if (|Mu|/dv + 0.5Nu + |Vu-Vp| - Apsfpo) / (EsAs + EpAps) < 0

Transverse reinforcement shall be provided Except for slabs, footings, and culverts where:
Vu > 0.5(Vc - Vp)Φ (Equation 5.7.2.3-1)

where;

Vu is factored shear force

Vc is nominal shear resistance of the concrete

Vp is component of prestressing force in direction of the shear force

Nominal shear resistance, Vn, shall be determined as the lesser of:

Vn = Vc + Vs + Vp (Equations 5.7.3.3-1 & 5.7.3.3-2)

Vn = 0.25f'cbvdv + Vp

where;

Vc is the nominal shear resistance provided by tensile stresses in the concrete

Vs is the shear resistance provided by shear reinforcement

Vp is the component in the direction of the applied shear of the effective prestressing force; positive if resisting the applied shear

bv is the width of the cross section
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dv is the effective shear depth

Nominal shear resistance provided by tensile stresses in the concrete, Vc, shall be determined as:

Vc = 0.0316βλ√(f'c)bvdv (Equation 5.7.3.3-3)

where;

λ is the concrete density modification factor

β is the factor indicating ability of diagonally cracked concrete to transmit tension and shear

bv is the width of the cross section

dv is the effective shear depth

Shear resistance provided by shear reinforcement, Vs, shall be determined as:

Vs = Avfydv(cotθ + cotα)sinα / s (Equation 5.7.3.3-4)

where;

Av is the area of shear reinforcement within a distance s

dv is the effective shear depth

s is the spacing of transverse reinforcement measured in a direction parallel to the longitudinal reinforcement

α is the angle of inclination of transverse reinforcement to longitudinal axis

θ is the angle of inclination of diagonal compressive stresses

Required shear resistance to be provided by shear reinforcement shall be determined as:
Vs,required = Vu/Φv - Vc - Vp (Article 5.7.3.3)

Required area of transverse reinforcement within distance s, by using this required shear resistance value, shall be
determined as:
Av,required = Vs,required s / (fydv(cotΘ + cotα)sinα) (Equation 5.7.3.3-4)

∴ Therefore, if Av ≥ Av,required, OK.

Factored shear resistance, Vr, shall be taken as:

Vr = ΦVn

(Equation 5.7.2.1-1)
where;

Vn is the nominal shear resistance specified in article 5.7.3.3

∴ Therefore, if Vr ≥ Vu, OK.

Tensile capacity of the longitudinal reinforcement on the flexural tension side of the member shall be proportioned
to satisfy:
Apsfps + Asfy ≥ |Mu|/(dvΦf) + 0.5Nu/Φc + (|Vu/Φv - Vp| - 0.5Vs)cotθ (Equation 5.7.3.5-1)

where;

Vs is the shear resistance provided by the transverse reinforcement at the section under investigation as given by equation
5.7.3.34

Φf, Φv and Φc are resistance factors taken from article 5.5.4.2 as appropriate for moment, shear and axial resistance

θ is the angle of inclination of diagonal compressive stresses used in determining the nominal shear resistance of the section
under investigation as determined by article 5.7.3.4
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Mu, Vu and Nu are factored moment, shear and axial load respectively

Longitudinal reinforcement on the flexural tension side of the member, at the inside edge of the bearing area of simple
end supports to the section of critical shear, shall satisfy:
Apsfps + Asfy ≥ (Vu/Φv - Vp - 0.5Vs)cotθ (Equation 5.7.3.5-2)

It should be noted that equations above (5.7.3.5-1 and 5.7.3.5--2) shall be taken to apply to sections not subjected
to torsion.

Transverse Reinforcement - Tie Type for Seismic Zone 1

Yield strength of transverse reinforcement and the specified compressive strength of concrete shall satisfy the following
requirements:
f'c ≤ 15 ksi (Article 5.6.4.6)

fy ≤ 100 ksi for Seismic Zone 1

Bar Diameters

Referring article 5.10.4.3, in tied compression members, all longitudinal bars or bundles shall be enclosed by lateral
ties that shall be equivalent to:

No. 3 bars (0.11 in2) for No. 10 (1.27 in2) or smaller longitudinal bars

No. 4 bars (0.20 in2) for No. 11 (1.56 in2) or larger bars

Spacing

Spacing of ties along the longitudinal axis of the compression member shall not exceed the least dimension of the
compression member or 12.0 in.
s ≤ min(bv, h, 12) (Article 5.10.4.3)

where;

bv is the width of cross section and h is the overall depth of the cross section

Transverse Reinforcement - Spiral Type for Seismic Zone 1

Yield strength of transverse reinforcement and the specified compressive strength of concrete shall satisfy the following
requirements:
f'c ≤ 15 ksi (Article 5.6.4.6)

fy ≤ 100 ksi for Seismic Zone 1

(Article 5.6.4.6)

Ratio of spiral reinforcement to total volume of concrete core, measured out-to-out of spirals, shall satisfy:
ρs = As/Ag ≥ 0.45(Ag/Ac-1)f'c/fyh (Equation 5.6.4.6-1)

where;

Ag is the gross area of concrete section

Ac is the area of core measured to the outside diameter of the spiral

f'c is the specified strength of concrete at 28 days, unless another age is specified

fyh is the specified minimum yield strength of spiral reinforcement ≤ 100 ksi
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Bar Diameters

Spiral reinforcement for compression members other than piles shall consist of one or more evenly spaced continuous
spirals of either deformed or plain bar or wire with a minimum diameter of 0.375 in referring article 5.10.4.2. The
reinforcement shall be arranged so that all primary longitudinal reinforcement is contained on the inside of, and in
contact with, the spirals.
Φsingle transverse bar ≥ 0.375 (in)

∴ Therefore, the transverse reinforcement bar diameter shall be determined as:
Φsingle transverse bar = √(4Asingle transverse bar/π)

Spacing

The center--to-center spacing shall not exceed 6 times the diameter of the longitudinal bars or 6.0 in.
s ≤ min(6Φlongitudinal bar, 6) (Article 5.10.4.2)

Clear Spacing

Clear spacing between the bars of the spiral shall not be less than either 1.0 in. or 1.33 times the maximum size of
the aggregate.
s - Φtransverse bar ≥ max(1.33ag, 1) (Article 5.10.4.2)

where;

ag is the maximum aggregate size (in)

Transverse Reinforcement - Confinement for Seismic Zone 1

For bridges in Seismic Zone 1 where the response acceleration coefficient, SD1, specified in article 3.10.4.2, is less than
0.10, no consideration of seismic forces shall be required for the design of structural components, except that the design
of the connection of the superstructure to the substructure shall be as specified in article 3.10.9.2. (Article 5.11.2)

For bridges in Seismic Zone 1 where the response acceleration coefficient, SD1, is greater than or equal to 0.10 but
less than or equal to 0.15, no consideration of seismic forces shall be required for the design of structural components,
except that:

♦ The design of the connection of the superstructure to the substructure shall be as specified in article 3.10.9.2

♦ The transverse reinforcement requirements at the top and bottom of a column shall be as specified in articles 5.11.4.1.4
and 5.11.4.1.5.

For Spirals

For a circular column, the volumetric ratio of spiral or seismic hoop reinforcement, ρs, shall satisfy either:

ρs ≥ 0.45(Ag/Ac-1)f'c/fyh OR ρs ≥ 0.12f'c/fy (Article 5.11.4.1.4)

where;

Ag is the gross area of concrete section

Ac is the area of core measured to the outside diameter of the spiral

f'c is the specified strength of concrete at 28 days, unless another age is specified

fyh is the specified minimum yield strength of spiral reinforcement ≤ 100 ksi
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It should be noted that the spiral volume ratio shall be determined as:

ρs = As√(s2 + πhc) / (Ags)

where;

As is the total area of the longitudinal reinforcement

Ag is the gross area of the cross section

s is the spacing

hc is the core dimension of tied column in the direction under consideration

For Ties

For a rectangular column, the total gross sectional area, Ash, of rectangular hoop reinforcement shall satisfy either:

Ash ≥ 0.30shcf'c(Ag/Ac-1)/fy OR Ash ≥ 0.12shcf'c/fy (Equations 5.11.4.1.4-2 & 5.11.4.1.4-3)

where;

Ash is the total crosssectional area of tie reinforcement, including supplementary crossties having a vertical spacing of s and
crossing a section having a core dimension of hc

Ag is the gross area of column

Ac is the area of column core

s is the vertical spacing of hoops, not exceeding 4.0 in

hc is the core dimension of tied column in the direction under consideration

Confinement Region Length

Referring article 5.11.4.1.3, the end region shall be assumed to extend from the soffit of girders or cap beams at the
top of columns or from the top of foundations at the bottom of columns, a distance taken as the greater of:

♦ The maximum cross--sectional dimension of the column

♦ One--sixth of the clear height of the column

♦ 18 in.

Spacing for Confinement

Transverse reinforcement for confinement shall be spaced not to exceed one--quarter of the minimum member
dimension or 4.0 in center-to-center.
sconfinement zone ≤ 0.25hsmaller AND s ≤ 4 (in) (Article 5.11.4.1.5)

Longitudinal Reinforcement for Seismic Zone 2, 3 and 4

Limit to the minimum value of longitudinal reinforcement ratio for Seismic Zone 2, 3 and 4 is 0.01.
As/Ag + (Apsfpu)/(Agfy) ≥ 0.01 for Seismic Zone 2, 3 and 4 (Articles 5.11.3 & 5.11.4)

Maximum area of prestressed and nonprestressed longitudinal reinforcement for noncomposite compression
components for Seismic Zone 2 shall be such that:
As/Ag + (Apsfpu)/(Agfy) ≤ 0.06 for Seismic Zone 2 (Articles 5.11.3 & 5.11.4.1.1)

Maximum area of prestressed and nonprestressed longitudinal reinforcement for noncomposite compression
components for Seismic Zone 3 and 4 shall be such that:
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As/Ag + (Apsfpu)/(Agfy) ≤ 0.04 for Seismic Zone 3 and 4 (Articles 5.11.4 & 5.11.4.1.1)

Maximum area of prestressed longitudinal reinforcement for noncomposite compression components shall be such
that:
(Apsfpe)/(Agf'c) ≤ 0.30

(Equation 5.6.4.2-2)

Control of Cracking

The required amount of distribution reinforcement and spacing of the distribution reinforcement is checked in this
step. In according to Article 5.6.7 this step shall be applied for all concrete components in which tension in the cross-
section exceeds 80 percent of the modulus of rupture.

Modulus of Rupture

Modulus of rupture, for normal-weight concrete with specified compressive strengths up to 15.0 ksi may be taken as
following:
fr = 0.24 √f'c (Article 5.4.2.6)

As mentioned above to check applicability of this step, tension in the cross-section shall be computed and compared
with the modulus of rupture.
ftension = MserI/S

Check if:
ftension ≥ fr

If the above equation is true, the spacing of nonprestressed reinforcement should be checked as follows:
s ≤ 700ɣe/βs fss - 2dc Eq(5.6.7-1), the limit for allowable spacing of nonprestressed reinforcement in the layer closest to the
tension face

where
βs = 1 + dc/0.7(h-dc) Eq(5.6.7-2), ratio of flexural strain at the extreme tension face o the strain at the centroid of the
reinforcement layer nearest the tension face

dc = cc_pri+ Φpri/2, thickness of concrete cover measured from extreme tension fiber to center of the flexural reinforceemnt
located closest thereto

ɣe = 0.75 for Class 2 exposure condition

h = ddeck

fss = MserI/(Asjds)≤ 0.60fy, calculated tensile tensile in nonprestressed primary reinforcement at the service limit state 1

j = 1-k/3, intermediate variable to determine tensile stress in mild steel reinforcement by using method of transformed section

k = √((ρn)2 + 2xρn)-ρn where ρ=As/(dsxb)

n = Es/Ec
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Pier columns per Indian Roads Congress
(IRC) Code of Practice for Concrete Road
Bridges, 2020 (First Revision)

In this section, the code check procedures for a column per Indian Roads Congress (IRC) Code of Practice for Concrete
Road Bridges, 2020 (First Revision) will be explained briefly.

The tool enables detailed design code-checks on:

• Material properties

• Reinforcement limits

• Shear capacity

• Transverse reinforcement requirements (for both types spiral and tie)

• Longitudinal reinforcement limits

The ultimate biaxial capacity of a pier column is determined by performing biaxial interaction analysis. The demand
capacity ratio is reported with and without Φ factors.

Code check parameters are defined next.

Required Input Parameters

Required input parameters are as follows:

• trReinfType: Type of transverse reinforcement (Options: Tie, Spiral)

• fyvk: Characteristic strength of web reinforcement to resist shear

• sT: Spacing of shear reinforcement

• AvdirX: Area of transverse reinforcement within distance s along the longitudinal axis of the bridge

• AvdirY: Area of transverse reinforcement within distance s along the transverse axis of the bridge

• α: Angle between the longitudinal reinforcement and the shear reinforcement

• Θ: TODO

• φtr: Diameter of the spiral or hoop

• Type of Steel: Type of steel reinforcement where options are Mild Steel and High Strength Deformed Steel.

• SteelGrades: Steel grades of high strength deformed steel where options are Fe415, Fe415D, Fe415S, Fe500,
Fe500D, Fe500S, Fe550, Fe550D and Fe600

• seismicZone: The seismic zone where the structure is located.

Users are able to perform code checks on all kinds of Standard/Custom sections in LARSA 4D Sections Library,
and the user-defined custom sections with or without cut-outs and various reinforcement patterns. The tool directly
supports some of the widely used column sections: the sections available under the “Columns” category in the LARSA
4D sections database and several basic shapes, shown in the Figure 3. Column Sections in LARSA 4D Library in the
Pier Code Check Tool Manual Introduction part. For these sections, the section parameters are automatically pulled
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from the associated LARSA model and the user only needs to enter the abovementioned parameters to perform code
check. Apart from these, for all other sections to be preferred, the user needs to enter two additional parameters shear
width and depth manually, in addition to the ones given above.

• hdirX: Overall depth of the cross section along longitudinal axis (Article 5.7.2.8)

• hdirY: Overall depth of the cross section along transverse axis (Article 5.7.2.8)

• bv,dirX: Shear width of the cross-section along transverse axis of the bridge (Article 5.7.2.8)

• bv,dirY: Shear width of the cross-section along longitudinal axis of the bridge (Article 5.7.2.8)

Parameters Extracted from the LARSA 4D Model

The member, located at the code check station, is found by searching the member in the selected structure group at the
entered station. After member is found the properties of section and material are extracted. If a parametric section with
prismatic variation is assigned to the member, the parametric position is set at the location of the code check station,
and the section at that location is used to extract parameters.

The parameters that are extracted from LARSA 4D model are as follows:

Material Properties

Properties of the pier material, rebar material and tendon material are used and must be present in the model.

The material of each pier element is taken from the Input Data  → Geometry  → Members  spreadsheet, or if the
member has a section created using Section Composer, the material of concrete is taken as the reference material of
the section. The material properties are taken from the Input Data  → Properties  → Materials  spreadsheet.

• fck: Characteristic compressive cube strength of concrete at 28 days

Rebars are taken from Rebars spreadsheet which can be reached through right-clicking the section in Sections
spreadsheet. Material properties of rebars are taken from the material assigned to the rebars defined within the section.

• fyk: Characteristic yield strength of reinforcement

• fu: Tensile strength of reinforcement

Sectional Properties and Geometric Parameters

Pier column sections shall be checked in both directions. The directions are called as longitudinal and transverse axes
of the bridge. If a bridge path coordinate system is defined in the model, the parameters are extracted from the section
in compliance with the stated directions. However, if the bridge path coordinate system is not defined, the longitudinal
axis is assumed to be along the Member Local Y direction, and the transverse axis is assumed to be along Member
Local Z direction.

• ddirX: Depth of the section along the longitudinal axis of the bridge

• ddirY: Depth of the section along the transverse axis of the bridge

These parameters are taken from the Section Properties spreadsheet that can be reached from Input Data  → Properties
→ Sections . For parametric sections, parameters can be seen and edited by using Section Composer.

In general it can be said that ddirX is taken as depth and ddirY is taken as width of the sections. This assumption allows
user to model and check pier alone. The aim is to be sure that pier column section is checked for both directions as
mentioned above.
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• clearCover: Calculated internally using the sectional dimensions and defined rebar locations.

• Ag: Cross-sectional area of concrete

• bw,dirX: Minimum breadth of the section over the depth along the longitudinal axis of the bridge (Figure 10.2)

• bw,dirY: Minimum breadth of the section over the depth along the transverse axis of the bridge (Figure 10.2)

The following parameters are calculated using Section Analysis Results. First a Moment Curvature Analysis is run
for the section assigned to the member located at the code check station in both directions. While computing Mn the
axial load effects are ignored referring Article 5.8.2.9. Then, the value of following parameters are computed using
the computed ultimate moment capacity and the location of the neutral axis in the direction of consideration.

• zdirX: Lever arm along the longitudial axis of the bridge

• zdirY: Lever arm along the transverse axis of the bridge

Longitudinal Reinforcement and Prestressing Steel

Rebars can be defined using Section Composer for parametric sections. Besides that, users can create rebar definitions
by using the Rebars spreadsheet for sections defined in LARSA 4D. To define rebars inside the main LARSA
environment, rebar database should be connected first and then by using the Rebars spreadsheet which can be opened
by right clicking the section row under the Properties  tab and selecting Rebars .

• As: Total area of the longitudinal reinforcement

• #Rebars: The number of longitudinal rebars in the section

• rebarArrangement: Arrangement of longitudinal rebars in the section (Options: Rectangular, Circular)

• φbar,max,long: Diameter of the longitudinal reinforcement with maximum area

• φbar,sml,long: Diameter of smallest longitudinal bar

Parameters related with tendons are calculated if the selected result case has tendon results for the member at the code
check station, otherwise the isPrestressed parameter will be set to false and other related parameters will be set to 0.

• isPrestressed: The condition whether the column is presetressed or not

Loading

Load Combinations for strength limit state should be defined in the main LARSA 4D environment. After the analysis
is completed, factored load combinations can be created by using the Linear Combination/Extreme Effect Groups
option under Results  menu. Then, desired result cases for the code check can be selected inside the Pier Code Check
Tool. The strength limit states should be selected in accordance with the selected design code.

• NStrI: Maximum factored axial force for the controlling strength limit state (+ for tension, - for compression)

• VStrI,dirX: Maximum factored shear force for the controlling strength limit state

• VStrI,dirY: Maximum factored shear force for the controlling strength limit state

Code Check Procedure Details

Material Properties

Compressive strength of concrete
fck ≥ 15 MPa
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Reinforcing Steel

Reinforcement shall consist of hot rolled, thermo-mechanical or heat-treated rods, de-coiled rods or cold worked steel
of various grades given in Table 6.1.

Figure 1: Grades of Reinforcing Steel

The yield strength and tensile strength limits for any type and grade of steel are checked using Table 18.1, given by
the following figure.
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Figure 2: Strength limits for reinforcing steel

Shear Capacity (Clause 10.3)

The design shear strength of the non-prestressed member without shear reinforcement is given by:

VRd.c = [0.12K(80ρ1 * fck)0.311 + 0.15σcp]bwd (Eq. 10.1)

where;

K = 1 + √(200/d) ≤ 2.0 (Eq.10.2)

ρ1 = Asl / (bwd) ≤ 0.02 (Figure 10.5)

fck: Characteristic compressive cube strength of concrete at 28 days

σcp: Concrete compressive stress at the centroidal axis due to axial loading or prestressing = NEd / Ac < 0.2fcd(MPa)

bw: Width of cross-section

d: Effective depth of a cross-section

The design shear strength is subject to minimum of:
νmin + 0.15σcp)bwd

where;

νmin = 0.031K3/2fck
1/2
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Figure 3: Definition of Asl in Expression ρ1

The prestressed single span members without design shear reinforcement the shear resistance is calculated as follows:

VRd.c = I * bwc / s * √((fctd)2 ± k1σcpfctd) (Eq. 10.4)

where;

I: Second moment of area of concrete section

bwc: Width of the cross-section at the centroidal axis, allowing for the presence of ducts as per Eq.10.14 or 10.15, as applicable.

s: Spacing of shear reinforcement

fctd: Design value of concrete tensile strength (fctk / γm)

k1: lx/lpt2 ≤ 1.0 for pre-tensioned tendons, for other types of prestressing is 1.0

where;

lx: is the distance of section considered from the starting point of the transmission length (Eq.15.9 & Eq. 15.10, Section 15)

lpt2: is the upper bound value of the transmission length of the prestressing element = 1.2 lpt (Eq.15.9 & Eq. 15.10, Section 15)

∴ Therefore, if VRd.c ≥ VEd for a member without transverse reinforcement, OK.

For members with vertical shear reinforcement, the shear resistance is taken as the minimum value calculated by
following equations:
VRd.s = Asw / s * zfywdcotθ (Eq. 10.7)

VRd.s = αcw * bcw * z * ν1 * fcd / (cotθ + tanθ) (Eq 10.8)

where;

Asw: the cross-sectional area of the shear reinforcement
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s: the spacing of the stirrups

z: lever arm can be taken as 0.9d for RCC section and to be calculated for PSC section.

fywd: the design strength of web reinforcement to resist shear (and torsion) = fyk / γm while the value of fyk is limited to 500 MPa

ν1 = ν: a strength reduction factor for concrete cracked in shear = 0.6[1 - fck / 310] (Eq. 10.6)

αcw: a coefficient taking account of the state of the stress in the compression chord

αcw = 1 for σcp = 0

αcw = 1 + σcp / fcd for 0 < σcp ≤ 0.25fcd

αcw = 1.25 for 0.25fcd ≤ σcp < 0.5fcd

αcw = 2.5(1 - σcp/fcd) for 0.5fcd < σcp < 1.0fcd

The required design shear resistance will be for a member with shear reinforcement:
VRd = VRd.c + VRd.s

∴ Therefore, if VRd ≥ VEd for a member with transverse reinforcement, OK.

Maximum effective cross-sectional area of the shear reinforcement is calculated as:
Asw,max * fywd / (bw * s) = αcw * ν1 * fcd / (sin(α)(1 + COT(θ)))(Eq. 10.13)

The ratio of the shear reinforcement is limited by the following value:
ρmin=0.072√(fck) / fyk

∴ Therefore, if ρ ≥ ρmin, OK.

Longitudinal Reinforcement Requirements (Clause 12.2.2)

Minimum area and maximum of reinforcement requirements are checked in order to prevent a brittle failure and wide
cracks per Clause 16.2.2. In addition, the dimensional restrictions for pier are checked per Clause 16.2.1.

The clauses in Section 16 deal with columns of any cross-sectional shape for which the larger dimension of solid
concrete section is not greater than 4 times the smaller dimension of the concrete section

Minimum Reinforcement Requirements:
As ≥ 0.15 * Ag (Clause 16.2.2-1)

where;

As: Area of longitudinal reinforcement

Ag: Cross-sectional area of concrete

Amin = MAX(0.10 * NED / fyd, 0.002 * Ac) (Clause 16.2.2-3)

where;

Amin: The minimum cross-secitonal area of total longitudinal reinforcement

NED: The design axial compression force

Ac: The gross cross-sectional area of concrete

Bar Diameter and Spacing:
φmin ≥ 12 mm (Clause 16.2.2-2)

s ≤ 200 mm (Clause 16.2.2-2)
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where;

φmin: Minimum bar diameter

s: Spacing of longitudinal reinforcement

Amax = 0.04 * Ac outside of the lap section (Clause 16.2.2-4)

Amax = 0.08 * Ac at lap section (Clause 16.2.2-4)

where;

Amax: The maximum cross-secitonal area of total longitudinal reinforcement

Ac: The gross cross-sectional area of concrete

Minimum Number of Longitudinal Reinforcement:
Number of rebars ≥ 6 for columns of circular cross-section (Clause 16.2.2-5)

Number of rebars ≥ Number of edges for columns having a regular polygon cross-section (Clause 16.2.2-5)

Transverse Reinforcement Requirements (Clause 12.2.3)

The clauses in Section 16 deal with columns of any cross-sectional shape for which the larger dimension of solid
concrete section is not greater than 4 times the smaller dimension of the concrete section

Bar Diameters
φmin = MAX(8 mm, 1 /4 * φlong,bar,max) (Clause 16.2.3-2)

where;

φlong,bar,max: The maximum diameter of the longitudinal bar

Spacing
smax = MIN(12 * φlong,bar,min, d, bw, 200.0)

Confinement For Seismic Zone III, IV, V (Clause 17.2.1)

Within the potential plastic hinge regions, ductile behaviour of the compression zone of concrete shall be ensured by
providing confinement of concrete.

Confinement is implemented through rectangular hoops and/or cross-ties or through circular hoops or spirals.

The required quantity of confining reinforcement expressed as ratio ωwd is calculated as per Eq. 17.2 and shall satisfy
the requirements of Clause 17.2.1.2
ωwd = ρw * fyd / fcd

where;

In rectangular sections:

The volumetric ratio of transverse reinforcement defined as:
ρw = Asw / (SL * b) (Eq. 17.3)

where;

Asw: The area of the stirrups and ties in one direction of confinement

SL: The spacing of hoops or ties in the longitudinal direction
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b: The dimension of the concrete core perpendicular to the direction of the confinement under consideration, measured to the
outside of the perimeter hoop.

In circular sections:

Volumetric ratio ρw of the hoops/spiral reinforcement relative to the concrete core is given by Eq. 17.4

ρw = 4 * Asp / (Dsp * SL) (Eq. 17.4)

where;

Asp: The area of the spiral or hoop bar

SL: The spacing of these bars

Dsp: is the diameter of the spiral or hoop

Minimum Confining Reinforcement:

The minimum reinforcement condition shall be satisfied in both directions.
ωwd = MAX(ωω,req, 0.12) (Eq 17.5)

ωwd,req = 0.37 * Ac / ACC νk + 0.13 fyd / fcd(ρL - 0.01) (Eq. 17.6)

where;

Ac: The area of the gross concrete section

ACC: The confined (core) concrete area of the section within the outside dia of hoop

νk: Normalised axial force (Clause 17.2.1.1)

ρL: The reinforcement ratio of the longitudinal reinforcement

For circular sections, the minimum confining reinforcement provided by hoops/spiral is determined as the higher of
two values given in Eq. 17.7:
ωwd,c ≥ MAX(1.4* ωreq, 0.18) (Eq 17.7)

Spacing for Confinement:

The spacing of hoops or ties in the longitudinal direction, SL shall satisfy both of the following conditions:
sL ≤ 5 * φlong,bar,min

sL ≤ 1 / 5 * bw,core,min

where;

bw,core,min: The smallest dimension of confined concrete core for both circular and rectangular sections measured
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